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ToolBox
ToolBox by Greenbriar Studio is a 3D modeling and animation system with special features to make 
the creation of Poser content and Game System levels and animated models easy. This is in addition 
to its original goal to produce finished animations with sound.

Poser model: Alexis by Angielyn
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Release Notes - 2.1

This release supports the changes made in our renderer - GRRen 1.1.

GRRen now supports true displacement mapping and new ray tracing features for adding reflection, 
refraction and ray traced shadows.

The Material Info panel now has switches to select Displacement mapping in addition to bump map-
ping. It also has a switch for Ray Traced Reflections. This is settable on a material by material basis, 
so you can add this feature when needed, but only use ray tracing for the surfaces you need, to save 
speed. There is also a reflection percentage field that determines how much the reflection replaces the 
objects normal color.

There is also a new Ray Refraction switch and Refraction Index field. Note - a surface must be trans-
parent to use refraction, Transparency must be .98 or less. Refraction is also on a surface by surface 
basis to keep ray tracing costs as low as possible.

See the GRRen section for a full description of the new ray tracing features.

The Render Options panel has been majorly redone to keep up with GRRen, adding settings for Shad-
ing Rate, Ray tracing depth and more.

Also, the two Ray Traced shadow options now work with GRRen as well as the other Rendeman com-
patible renderers.
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Release Notes - 2.0

With this release, we are finally releasing ToolBox IV Dynamic, with the addition of dynamic systems, 
gravity and wind along with dynamic Hair, Cloth and Particle system. 

The other main focus for ToolBox IV has been additions designed to create a movie maker in a box. The 
addition of sound that plays back synced to the animation, and many features to allow using the OpenGL 
display system to create movies at almost realtime, which can then be played back inside ToolBox for 
viewing your animation real time (for scenes too big to play real time in the ToolBox editor). Shadows, 
antialiasing and depth of field allow you to create useable animated movies at almost real time.

And for the first time, our own Renderman (Renderman copyright Pixar) compatible renderer!

GRRen, the Greenbriar Poly Renderer is a renderer, that in its first version, supports all the features 
that we use from a Renderman renderer, with the additions of built in Cell Shading, auto transparent 
shadows and a GUI to make setting up a small render farm quick and easy. We couldn’t afford to buy 
a render farm so we built our own. Unlike other Renderman type renderers, it is being optimized for 
Polygon models.

So you can now select from GRRen, Pixar’s PRMan or the 3Delight renderer as output options.
A demo of GRRen also now comes with out ToolBox Demo.

New Features for ToolBox IV Dynamic
- Dynamic Hair and Cloth
- Sound Import and Playback
- Animated Camera Switching - switch cameras for multiple shots in the same animted sequence
- OpenGl Render to File - renders to tiff file set and Quicktime command file just like main renderers, 
just much faster. Can be played back in Quicktime or in ToolBox.
- OpenGL Render to File playback in ToolBox - for instant viewing of your animations
- Particle system for creating explosions, smoke fire, snowflakes, etc

And to Make OpenGL renders in ToolBox IV useable as actual animated movies-
- Reat time shadows - selectable on all lights
- Anti aliasing
- Camera Depth of field
- Non display of lights, cameras, nulls, bones and optionally the floor grid when in OpenGL render 
mode

New Features for Animating Versions (II and up)
- Visual animation key display - Allows for easy moving, deleting and editing of all animation keys
- Export to Poser Face format also now supports export of lip sync type files - head and eye movements 
and head morph animation - to make it easier to edit lip sync animations.
- Morph JCM - Joint Controlled Morphs moves morphs based on the movement of bones. Creates auto 
morphing
- New Render output formats - Tiff with Alpha, JPG and OpenEXR High Dynamic Range Image
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New Features for All Versions

- Scene Import - to add the contents of a previously saved scene into the current scene
- Improved Object export and save to include all textures and materials
- Display of current scene on main window title bar
- Animated display style - For making objects become visible or invisible during an animation se-
quence
- Mesh Panel creation - New built in rectangular object with definable size and divisions in all three 
dimensions
- Show Normals - on Scene Settings you can now turn on the display of normals to check for normal 
issues.
- Rotating Textures - You can indicate that an image is part of a numbered image set and have these 
play back as a texture on an object. So any animation frames you generate can be used as animated 
textures,
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Release Notes - 1.016
There are lots of new additions with this release, the largest being the addition of the dynamic systems, 
gravity and wind along with dynamic Hair and Cloth. And the addition of sound.

ToolBox Dynamic - This new version includes everything in Pro, plus our new dynamic forces, hair 
and cloth systems and sound import, playback and export. More to come!

- Hair (Dynamic) - is designed to be a long hair system, where most systems are really only useable 
for fur. You want floor length hair on your mermaid? We can do it. The hair works wih Renderman’s 
special hair facility for handling large volumns of hair with self shadowing.

- Cloth (Dynamic) - is unusual in that it is designed to work with existing models, rather than requiring 
you to make special new ones. It allows you to make any portion of an existing model dynamic, while 
the rest remains a normal model. And yes, this means that you can have a conformed boned Poser 
model  where part of the object (like a tight bodice) is controlled by the conformed skeleoton, and part 
is free moving dynamic cloth.

Both cloth and hair can be captured as vertex animation to allow fine frame by frame editing and faster 
and repeatable playback. This is on an object by object basis.

- Forces (Dynamic) - Gravity and wind with direction and turbulence are available as part of the dy-
namic hair and cloth system.

- Sound (Dynamic) - Many changes to the animation system, including the ability to load a sound 
track and play it back with your animation to allow visual syncing with speech or music tracks. The 
Quicktime output now also automatically includes the sound track as well. So now you can create and 
export movies with sound directly from ToolBox!

- B3D (Pro) Import and export for the Blitz Basic B3D format

- Look At (All) - Look at ability for the main view. Will look at the center of a selected object, or a 
selected point, if there is one, to make moving around your models while editing easier.

- Camera Look At (Pro) - The Camera also has a Look At option so it will track a moving object dur-
ing an animation run.

- Auto Normalization Off (Poser / Pro)-  turns off the auto normalization of weights so you can see the 
weights as a game engine will to look for weighting errors.

- Creedo Scale (Poser / Pro) - Changes Creedo Life Forms scale and bone names to allow import to 
Poser models

- Invisible Bones (Poser / Pro) - Make everything invisible (and not updating) when you make an object 
invisible. Used to speed processing for getting real time animation playback. Makes it easy to have 
multiple models in the scene by turning off the ones you don’t currently need.

- Joint Controlled Morphs (Poser / Pro) - Morphs can be automatically controlled by the rotation of a 
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bone.

- New Animation Controls - Separate functions to set keys for just the object transform or a single 
bone.

- Add and Delete frames - you can now shift animation on the timeline by adding or deleting frames 
for the whole scene, a single object or a single bone.

- Animation import to current frame - animation import now starts at whatever the current frame is, so 
you can import multiple animations to different sections of the timeline.

- Copy animation from one object to another. For use with lo res models for working in real time with 
sound. So you can copy the final animation back to the hi res model for rendering.

- Zero Object now alters animation, as well. If you roate an object with aniamtion, and then zero it, not 
only is the mesh moved to the new position as its new default, but it also recalculates all the animation 
on all frames so the new model will move the same as the old one. If you rotate a mesh 90 degress, but 
do not chnage the animation rotations, think how the legs would then move! :) 
So it is now easy to flip models aroung to match different game orientations.
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Release Notes - 1.014
There are lots of new additions with this release, the largest being the Game Exporter related items.
New Systems:

- IK (Pro) - multiple IK chains can be defined for each skeleton, works with both bone systems. From 
Object Info panel. Supports rotation limits.

- Null Objects (Pro) - for IK and animation

- Progressive Mesh (Pro) - Create multiple levels of detail with a slider. These stay animated to your 
skeleton! On Object Info panel. Also maintains multi surface texturing.
At last, the last of the big three game modeling functions - Poly reduce is now added to mesh merging 
and texture/uv merging.

- MTL file read and write added to the Obj import and export (All)

- Animation and LOD Export Panel (Pro) - Define multiple animation sequences by name and frame 
range for different model exporters. And Define Multiple LOD levels as manual or automatic. From 
Object Info panel.

- Torque DTS export (Pro) - Standard DTS and our new Morph capable format (TGE update available 
from us or Garage Games)
 Features:
 - Large Model export - 50K triangles and up available
 - Morphs that animate in Torque with out new DTS format (user selectable old or new)
 - Multiple textures per Model
 - Discontinuous UV support
 - Multiple animation sequences in DTS
 - Multiple bones controlling each point
 - Animation Flags for Blend and Cyclic
 - Collision Objects
 - BillBoards
 - Entire scene DTS export (multi model) static or animated 
 - Animation by bone or object transform, or objects parented to a non-exporting skeleton
 - DSQ export - regular and morph animated - multiple animation sequences
 - LOD meshes - auto or manual
- Torque DIF export (Pro)
 Features:
 - WYSIWYG textures - Game level type uvs built in (selectable)
 - All Torque light types supported
 - All Torque entity types supported
 - Map output with Auto compile to DIF

- Ogre Export (Pro) - Export Orge .mesh, .skeleton, .material format
 Features:
 - Multi surfaces per model
 - Discontinuous UV support
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 - Mutiple bones per vertex
 - Multiple animation sequences
 - Auto Convert from xml to binary - one step export
 - LOD meshes - auto or manual

Small additions:

- Split Improvement (All) - ends now will add a point to split a quad that is on the edge of a mesh (for 
half mesh modeling.

- Freeze Deformed Mesh (Pro) - converts a mesh deformed by morphs and bone scaling into a new 
mesh with the effects, but with no morphs or scaling. Freezes the results on the mesh and bones so the 
model can be exported to systems that do not support body part scaling or morphs.

- Delete Bone and Children (Poser / Pro) - Prune entire branches of a skeleton

- Use Limits (Poser / Pro) - Restrict motion to bone rotation limits

- Rename Morph (Poser / Pro) - Rename an existing morph in the morph mixer

- Move Perspective Rotation Point right and Left! - Ability to circle around a hand or other non central 
section. (Cntl/Shift/Rt Mouse)

- View Close (All) - Switch to let you zoom in much closer to a working mesh

- Major SubD speed increase for real time editing

- Perspective Move switch on Scene Settings panel - makes Move work perpendicular to your current 
screen view instead of on standard axes. Very Handy!

Bug Fixes:
- 3DS Import - Several import bugs fixed, more fromats now readable
- Move Perspective Rotation Point right and Left! 
- Selection off one mesh while it is over another - only items in current mesh can be selected
- Compact Mesh Fixed
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Release Notes - 1.013
The major addition for this release is the addition of Poser 6 abilities. This version adds the following 
to make it compatible with Poser 6:
- Auto texture locate for Poser 6 and Poser 5
- Compressed obj file reader
- New Poser 6 format cr2 reader
- Poser 6 binary morph file read ability

And to make working with all the compressed Poser 6 files easier, there is now an Uncompress File 
command under the File menu. It creates a new file with a txt extension added that is a clear text ver-
sion of the compressed file.

Also a few general bugs were also discovered and fixed:
- bug that blocked the walkthru mode due to the addition of the user settable hot keys
- a fix to the conforming method to correctly handle objects with multiple unconnected bone segments, 
like shoes.

And two small additions:
 - loading animation, pz2 or bvh, now sets the end frame for you to the last frame loaded.
- ToolBox now has the ability to parent one boned figure to another on load, instead of just props to 
bones.

Important Notes for Poser 6:

The body morph special files for the new P6 characters are script files, not figure files. You need to 
open these in Poser, which will pull together the model and the new morphs and then save to a library 
to create a full cr2 file in P6 format. This can then be loaded into ToolBox.

The only models that will currently not load correctly are the robots. They can be fixed by hand by 
uncompressing the obj file and changing the g group lines. These lines should have the bone name as 
the only or last name. It is in most cases, but in some the valid bone name is in various places. Moved 
to the end it will load correctly. Otherwise, the arms are not attched to the skeleton.

NOTE - The new hires modele (like Jessie) and VERY large, 115K faces compared to 75K for Vic3, 
so expect them to be much slower than normal.
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Features
The basic concept is for a modeling / animating tool with special functions (tools) built in  to facilitate 
work in two prime areas:

DAZ|Studio and Poser content creation 
For new figures, new clothes and other figures / props, and new morphs for existing characters.

DAZ|Studio and Poser aimed special tools:
Native Poser file read and write:
 Reads: obj, CR2, PP2, PZ2, FC2, HD2 (and Poser 5 compressed versions)
 Writes: obj, CR2, PP2, PZ2, FC2 - in Poser 4 format - Compatible with Poser 4, Poser 4 with 
  ProPack, Poser 5 amd Poser 6
INJ/REM Pose output for morphs
Mesh over mesh working ability
Show body parts in color display mode
Full compressed Morph system (similar to our commercial systems for Cinema 4D, Maya and shipping 
as part of LW 8)
Poser style bone system with full joint parameter creation and editing
Poser animation import and export, Mimic import
Built in Conforming figure functionality
Object (any type) parented to bone functionality
Object Transparency in all displays, selectable Trans map display , with no speed loss.
Anti-aliasing available in main Perspective window (very slow, for better screen shots)

Game content creation 
Aiming for easy level construction, animated model creation and modification. And the ability to import 
geometry from other editors and create the level, with all texturing, as it will appear in the game, for 
easy previewing.

Game Content special tools:

Game style texture mapping - duplicates the texturing of Quake, Halflife, 3DGS - see your texturing 
in the 3D app before exporting
MDL import (md2)
Blitz Basic B3D import and Export
Map export to Quake2, HalfLife and Torque map formats (Torque being changed to match new Torque 
format)
Full Conitec 3DGS Compatibility - WMP level import and export, HMP terrain import and export, 
   MDL7 vertex and bone animated model import and export
Vertex animation - fully supports (including import) point base animation - use bones to get the basic 
movement and then clean up the problem areas in point mode and then export as point animation
Morph to Vertex animation
Bone Animation
Bone to Vertex animation
Auto Stair generation tool
Auto colonnade generation tool
Array object duplication
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Terrain Generator
Terrain Fog

Plan to building - draw 2d plans with doors and windows and generate levels - support of single and 
multi level structures.

General features

Real Time fully textured display of object movement, bone posing and light movement and adjust-
ment!

Imports:
Read 2D format- jpg tif bmp png ico gif tga pcx wbmp wmf jp2 jpc pgx pnm ras
Real time texture mapping
Texture resolution selection per image - 64x64 to 2048x2048
Auto recognition all all importable file types
Imports all Poser File Types 
Hi speed binary save and restore of working scenes and objects

Materials:
Global material definitions
Diffuse, ambient, specular and even glow color supported
Specular highlight
Color mapping
Transparency mapping

Surfacing:
Surfaces by object - allows many objects to tie to a single material to allow updating of many objects, 
yet each object (even dupes) can be changed to reference a different material.

Parts:
Support for parts - used for bone attachment and Poser morph creation among other things
Parts have a user settable display color for part display mode. Also used to facilitate game level ex-
port.

Windowing:
7 Independent view windows - with independent cameras. Extra windows open does not affect scroll/
movement speed. Since camera movement and selection occurs in a single window, only that window 
has to be redrawn while you work. Only adding a new object/changing objects triggers an update of 
all open windows.
ToolBox remembers which windows were open when you close and where they were
Remembers this also in saved scenes
Optionally Auto reloads last scene you were working on (if you saved or loaded a scene since calling 
new scene).
Display in wireframe, flat, smooth, textures or invisible (to speed up scene redraw and make selecting 
easier - invisible objects have no impact on screen refresh)
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Editing:
Integrated UV Editor system
User settable 0-100 level Undo
Point edit mode - select point sets for editing
Edge edit mode - select edge sets for editing
Face edit mode - select faces for editing or creating/altering parts and surfaces
Bone edit mode - select bones inside mesh objects for animating
Zero Object - apply transform to points making new shape from transform
Full transform on each object
Select modes makes non-selected objects invisible (Controllable via a scene level setting)

Lights:
Built in Overhead ‘Sun’ color, position contollable
Non-lit mode
User added 7 lights - directional, positional or spots - full color, intensity and range  control and ani-
matable

Tags:
Text based ‘Tags’ on Objects, Parts and Surfaces - Tags allow misc user and tool info - labels for game 
objects, instructions for auto generating tools, etc

Animation:

ToolBox supports several animation modes. Most items can be animated. Light position, color and 
all parameters can be animated. Mesh objects can be animated at the object level by their transfom, 
and can also be animated within the mesh by game type vertex animation, bone animation and morph 
animation. Plan objects and other 2D tool inputs are not animateable.

Over all Design issues:

Windowing
The windowing approach is to allow several things - all windows are independent to allow use of dual 
monitors, all view windows and tool dialogs can be moved off the main screen. All tool dialogs are 
non-model so they can stay resident while you work. (There are only a few exceptions like importer 
popups).
All view screens are independent - this means moving the view in one does NOT affect any other win-
dow. I HATE it when I try to adjust one view and then my other views are out of place. It also allows 
me to have the large number of windows, since they are independent, only the one you are currently 
moving has to be redrawn as you scroll. So extra screens open do not slow down each other (but ge-
ometry and texture editing still can/will.)
Toolbox tries to be smart by defining single window verses all window updating. Anything that affects 
all windows, such as new geometry or new textures requires a full window update, but moving and 
selecting in a window does not. 
All tool windows are children of the main perspective window, so they are not affected by opening and 
closing other views.

Surfacing
The goal is to have a surfacing system that makes it easy to copy geometry and its texturing without 
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duplicating tons of materials info, and allow both the possibility that a lot of different objects can be 
textured with the same material to make changes easy, but also that any object can have an independent 
material. The choice to share or not share materials is up to the user.
To implement this, a two level system has been created. Each object (that can be surfaced) has its own 
surfaces. They contain the id used in the geometry (which faces belong to the surface), tags and the 
name and id of the material to use for the surface. These are private object level items. The materials 
are scene level and can be shared. They contain the color and image mapping data. Images reside in 
their own repository and can be easily hand loaded and applied. User controlled, on the fly, selection 
of display resolution for images is built in.

Since the targets are Poser and games, I will only be supporting color and image maps initially. Colors 
will be turned into the appropriate image file for game export, so anything you can apply can be ex-
ported. Since procedurals are not supported by either Poser or game engines, they will not be included 
at this time.

ToolBox Versions

ToolBox comes in several version, each adding more functionality. All versions are generated from the 
same code base so that any bug fixes are automatically made in all versions. This also makes it simple, 
and possible, to keep older verison up to date with bug fixes and enhancements. So no versions get 
‘stranded’ and are no longer neing kept up to date.

Our policy has always been not to charge for updates to purchased products. But Toolbox being such 
a complicated product andbeing continually in  development to add new technologies, it was not pos-
sible to have a single version of ToolBox that could be upgraded free through all the major additions. 
So we came up with the Levels of ToolBox. When you buy a level of ToolBox, that level will updated 
for free. Updates are not just bug fixes. We just added the Triangulate and Subdivide functions that are 
being updated to all levels. they were necessary to suppor the new subdivision surface functionality 
in ToolBox III, but are useful tools in their own right so we decided to add them to all levels and put 
them in the next update. So functionality will increase as well.

ToolBox I Game version
ToolBox I was designed to be a game level editing version. It has all the game import and export 
functions, the game uv system, terrains and mesh editing tools. What it does not have is animation 
functionality or Poser import ability. It does include everything in this manual that is not listed below 
as belonging to ToolBox II Poser or ToolBox III Pro.

ToolBox II Poser version
ToolBox II was designed to be a Poser content creation system. It has the basic mesh editing features 
plus:
 Animated Poser joint bone system
 Poser import and export - models and animation
 Mimic animation import
 Animated morphing system
 Object animation system
It also includes everything in this manual that is not listed below as belonging to ToolBox I Game or 
ToolBox III Pro.
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Poser model: Lilo by Thorne and Sarsa

ToolBox III Pro
ToolBox III adds game animated models, rendering, animation and hi end modeling tools. It contains 
all of ToolBox I and II plus:
 Animated Weight mapped bone system (in addition to the Poser bone system)
 Game animated model import and export
 Subdivision Modeling
 Animated multiple cameras
 Renderman output, selectable to Pixar Phororealistic Renderman, Air renderman 
  and 3Delight (free for personal use) renderer
 QT Player and custom Quicktime plugin to load and playback  hi-res animations 
 Compressed animation format export available through Quicktime ($29 for QT Pro) 
 Full true Subdivision surfaces system - no restictions on the mesh, will work with any mesh 
  you can create in ToolBox

ToolBox IV Dynamic
ToolBox IV adds dynamic Forces, Hair and Cloth and a Particle System  plus Sound to ToolBox Pro.

ToolBox Demo
The ToolBox Demo is a ToolBox IV version with all saving and output disabled. All import, animation, 
subD, progressive mesh, etc is available for testing. No scene saving or file exporting is included in the 
demo. Rendering with a GRRen Demo version (size limited and watermarked) is included.
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The Scene
The Scene Settings panel, found under the Windows Menu, contains settings that apply to the entire 
scene. These settings are saved with each scene and their current value is saved between ToolBox 
sessions when you exit ToolBox.
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Ambient Light
The specifies the amount and color of light coming from all directions. Use it for initial modeling to make 
it easy to see all sides of objects. Values are from 0 - 1.0. Select brings up a color selction panel.

Sun Light
A built it directional (light coming from one direction to all parts of the scene like a very far away light 
like the sun). This sets the sun color and strength.

Sun Position
The vector that defines the direction that the sun is shining from.

Sun Shadows On
Turns on shadows from the sun, if shadows are enabled.

Ortho Display Style
This is the display style used in the six ortho, fixed single direction, views. This allows you to set a 
different style for the main perspective view (like textured) while you work in a different (like wireframe) 
in the orthographic windows. Wire is wireframe and draws the figure as the edges of all the faces, Flat 
shows each face as a flat facet, Smooth uses average vertex normals to create a smooth surface and 
Textured is a smooth surface plus an overlaid image file.

WAD File Name (Game / Pro)
The name of the WAD file included in game level export formats that require one. Should be the same 
name you use to export the matching WAD file, or the WAD file you wish to use from the game.

Textures Directory
You can put textures for ToolBox anywhere you wish, this directory is just for game file import. The 
import WAD file tools put the broken out textures in this directory. Also, for game level import (like the 
3DGS wmp import), if a texture name in the import file can be matched against a file in this directory 
(if it is not already loaded as an image), the image will be automatically loaded, a material created 
and  this will be linked to the level surfaces using this image. So the game level comes in completely 
textured and ready to work on.

Close View
Switches on very close appraoch to models, will cause depth errors with large models, but very handy 
to work very close on dense models.

DTS Morph Version
Switches DTS export to the new morph version. When off uses the standard DTS version.

Export DTS Old Morphed
Switches Standard DTS to pick up the net effect of morphs, instead of the base mesh

DTS Export by Parts
When checked, a mesh is exported to DTS with a separate submesh per defined Part.
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Auto Normalization Off
Turns off the auto normalization of weights so you can see the weights as a game engine will to look 
for errors.

Invisible Bones
Make everything invisible (and not updating) when you make an object invisible. Used to spped pro-
cessing for getting real time animation playback.

Creedo Scale
Changes Creedo Life Forms scale and bone names to allow import to Poser models.

Show Normals
Turns on display of currently face normals..

Shadow Map Size
Size of auto created shadow maps, both in OpenGL display and in rendered output.

Shadow Bias
The offset to reduce self shadowing in rendered output.

Rotating Textures On
Turns display of any rotating (animated) textures on and off.

Auto Load Last Scene
Automatically reload the last scene you saved on start up.

Textures Off
Disables all image texture processing for speed while modeling.

Xray Mode
Allows certain items to be seen through other objects. Allows you to see bones through the surrounding 
mesh, seleted points and faces through their object and Plans through the buildings that were created 
from them.

Edit Single Object Display
Enables the removal of other objects from the screen when you enter Point Edit or Face Edit mode to 
make it easier to see your object. Affects all screens.

Double Sided Display
If you are making hollow single sided objects, or ripping faces off of objects so you can go inside 
them, this enables the display to show the back side of polygon faces, so they will appear solid instead 
of clear.

Use Lights
Turns lights on in OpenGL. With lights off objects show their base color, but no shading is calculated. 
Objects show as profiles.
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Large Grid
Turns on the larger version of the center denser grid. Outer 20,000 unit grid always on.

Ortho View Grids
Turns the background grid on or off in the Ortho views

Camera and Move Speeds
A multiplier to the default camera speed to allow you to speed up (for large scenes that refresh slow) or 
slow down (for finer control) movement rates. This affect all Camera modes - move, zoom, rotate and 
walk through. Move Speed affects Mouse rate of movement, faster or finer for small increments.

Snap To Grid
Enables forcing movement and points to am integer grid. Affects Plan segment creation and mouse 
movement tools. Does not affect setting values by panel fields.

Size
The size of the grid. Grid starts at 0,0,0.

Undo
Sets the number of Undo levels. Zero means Undo is disabled. Max is 100. Set to the LOWEST value 
you can work with as Undo chews up a LOT of memory if you’re working with large models.

Undo Move and Pose
Enables Auto Undo for object movements and bone posing (faster when off).

Obj Import Reverse Normals
Some obj type file imports have the points in the wrong order from other obj files. This reverses the 
order so the object can be loaded and used in ToolBox. This was added to be able to read Cinema 4D 
obj files.

Perspective Move
Changes how move selection (not object) works in the Main View. When off Move works along the 
x,y and z axes, when on, Move works x and y as right to left and up and down as it appears in the view 
(how you have it oriented). Z becomes the direction of view. Very handy to move points when working 
on meshes!

Trans Maps On
Enables transparency map. Normal Transparency of objects is always available.

Anti Alias On
Enables anti aliasing in the OpenGL display.

Shadows On
Enables OpenGL shadows.

Walk Through Mode
Switches the perspective window to a keyboard based walk through camera After selecting this switch 
(and hitting apply), make sure you click in the perspective window so Windows directs the keyboard 
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data to this window (it always go es to the current window). Once on, you can move around by using 
Arrow Up and Arrow Down to go forwards and back, Arrow Right and Arrow Left, to turn right and 
left, Q looks up, A looks down, W moves you up and S moves you down. You can navigate to any point 
in your scene and look in any direction. It’s the only way you can look at a larg, complex model, like 
a city layout from all directions.

Game Texture Mapping (Game / Pro)
Makes the game style texture mapping the default for objects created by the geometry generation tools. 
You can change this setting for any object. This just saves the effort of having to turn it on for each 
object.

Culling On
Turns on Frustrum culling. This is a simple bounding box culling method so that items not in front of 
the camera are not processed to speed up screen redraw (as used in all games). You may want to turn 
it off to get extreme closeups of objects.

Export Face Thickness (Game / Pro) - This is used by several game level exports to set the thickness 
of the slabs it creates to make game legal blocks out of single sided objects.

Auto Ogre Compile - Turns the background grid on or off in the Ortho views

Auto DIF Compile - Turns the background grid on or off in the Ortho views

Textures as JPG - Makes the default WAD save, sized texture save and other texure file creation saves 
switch from TI JPG

Game Export Scale - Export scale for some game exporters, currently only used by Ogre model 
export 

Toon Options

Outside Line width
Width, in pixels, of cell shaded model outlines

Material Line width
Width, in pixels, of the cell shaded model lines between sections of the model

Min Depth
Depth required to be an outside line. Suggested range 20 - 90 to start.

Apply
Most panels have an Apply Button. Nothing entered on a panel takes affect, or is saved, until you hit 
Apply. Close without hitting Apply leaves everything as it was before you opened the panel (or since 
you last hit Apply).
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Poser Settings - (Poser / Pro)
This Panel has the settings for importing and exporting Poser format files.

Poser Import Folder
This is filled out by browsing for the Poser.exe file. This is a path required for interpreting the partial 
paths in Poser figure files. It is used to locate the current Runtime folder for loading geometry files.

Work Directory
This is just a directory for temp files, used currently by the Poser import tools.

OBJ Folder
This is the output directory where your object files will be written. Should be in a folder under run-
time/geometries.

PP2 Folder
This is the output directory where your PP2, non-boned prop, files will be written. Should be in a 
folder under runtime/libraries/props.

CR2 Folder
This is the output directory where your CR2, boned 
figure, files will be written. Should be in a folder under 
runtime/libraries/character.

Pose Folder
This is the output directory where your INJ/REM pose 
files, animation pose files and single frame pose files 
will be written. Should be in a folder under runtime/li-
braries/pose.

Make Smart Props
This flag tells the Poser exporters to make any props 
currently parented to a bone of a figure into a smart 
prop for that bone.

Make Injection Morphs
This flag tells the Poser exporters to make any morphs 
into blank channels in the CR2 file and a set of INJ/
REM pose files for each morph. 

Note- If you setup the output folders under the Poser 
runtime as described above, your models will automati-
cally appear in Poser. (After you have opened Posr for 
the first time with the your folders in place.) So you 
can test them without re-starting Poser. They will just 
initially be missing your custom icon.
.
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Lights
This Panel, found under the Windows Menu, controls all lights 
in the scene except for the sun, which is controlled form the 
Scene Settings panel.

Top Area
This area shows all currently existing lights. You must selct 
one with the mouse, so it is highlighted, before any settings 
can be applied to it.

Color
Sets the red, green and blue values of the light. The range for 
each entry is 0-1.0. Select brings up a color selction panel.

Position
This is the xyz position of the light. For normal lights (and 
spotlights) it is the position that the light radiates from (like 
a desk light). For Directional lights, it the direction the light 
is coming from. Use the Mouse Object Move tool.

Intensity
This controls how bright the light is. Controled by the mouse 
Object scale tool as is range.

Falloff
This controls how fast the light fades as it moved away from 
it’s position. 0 means no falloff.

Linear
This makes the falloff linear, instead of squared.

Positional
Makes the current light a positional light, the default is a directional light.

Spot Light
Makes the current light a spot light.

Spot Direction
The direction a spot light points, determined by rotation. (0,0,0) is looking -Z. Use the object rotate 
tool with the mouse.

Spot Angle
The flare angle of the spot light. The angle it spreads from the spot direction vector (so the total spread 
is double this value).

Shadows On
Turns auto shadow on for this light.
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Active
This switches the entire light on and off, so you can deactivate it without changing any settings.

New Light
Creates a new turned on light

Rename
Changes the name of the selected light
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Objects
This panel found under the Windows Menu, gives 
you access to the basic information about each 
object in the scene. This includes static mesh 
objects, animated mesh objects, terrain, null and 
plan type 2D objects.

Top Area
This area shows a list of all objects currently in 
the scene. By selecting an object here, so it is 
highlighted, its info will be displayed on the panel 
and can be edited.
Position
The objects current position in 3D space.
Rotation
The objects current rotation.
Scale
The objects current scale settings.
Parent
The name of the parent of the current object, if 
any.
Tags
Tags are a text field that can hold many different 
things. It is a generic info place where you attach 
labels to an object. Tags exist on many different 
levels in ToolBox. Tags can marks which objects 
are exported as a level verses as an animated 
model to a game engine. The Plan system uses 
them to mark special segments that will be created 
as windows or doors. Tags are comma separated 
text strings. Tags can also have parameters the fomat being - Tag name:p1 p2 p3... Multiple tags can 
be in the same tag field. Desciptions of what tags are used by what tool as described in each tools 
documentation. And they are a flexible way to add ne functionality later without having to rewrite the 
basic object model.
Display Part Colors
This mode uses the colors set for each part as the base color for that area. These are preset by some 
tools, like the Poser loaders. This lets you diplay a figure so you can see where all the models parts are 
while you work. This is feature designed to let you work on Poser conforming clothing since the parts 
of each mesh have to match to get good movement in the boned models.
Toon (Pro / Dynamic)
This mrks an object as Toon rendered when using the special Realistic/Toon mixed rendering style.
Display Style
This is the display mode that is used in the main perspective window (the display mode for the 
orthographic windows can be set differently in Scene Settings). Display styles are covered under Scene 
Settings. There are two new ones here - Scene, which means just use the same style as is currently set 
in Scene Settings, and Invisible, which makes this object not drawn at all. NOTE - this does NOT turn 
off drawing of bones, so you can make the mesh invisible and work on animating the bones.
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Size
The Max extent on each axis for the current object
Use Face Normals
Objects have two sets of normals, face and point. Face normals are the direction the face is pointing. 
Point normals are the average of the normals of all faces that share that point. They are used to create 
a smooth interpolated surface. Which type you use depends on the object. With point normals on, you 
get a smoother surface as it tries to round off edges. This is normally used for organic figures. But 
with flat geometric objects (like buildings) the use of point normals tries to round the corners (Poser 
is famous for this problem). So for objects with inherently flat faces you want to use face normals, so 
the lighting system treats each face as having the same angle to the light from one edge to the other. 
Point normals create the illusion of a curved surface when it is actually approximated by facets, face 
normals makes the facets visible.

Use Game Level UVs (Game / Pro)
This switch controls which uv mapping mode the object is in (there is a default to preset this switch 
in Scene Settings). When off, you get normal uv mapping. When on, you get the position dependent 
mapping used by the Quake, Halflife, 3DGS and many other game engines. This mapping style allows 
for seamless tiling across multiple objects. it is designed to only be used for stationary geometry as 
texturing changes as you move an object. Game animated models us regular uv mapping.

Vertex Animation (Pro)
This enables vertex animation in animation playback and disables bone animation. Vertex is point 
by point based animation which is either loaded from a model format that uses vertex animation or 
is created by creating a vertex animation from a combination of morph and bone animation. Morph 
animation can be used with vertex animation, but bone animation can not.

Reflection On
This switch turns on a non-editable reflection of this object. The axis is set in the Create Menu. This 
lets you see an entire mesh when you are modeling half meshes.

NOTE - See SubDivision Surfaces for info on the SubD controls

Progressive Mesh (Pro)
Progressive Mesh is our version that keeps the mesh fully articulated by the skeleton at any level.
Min - Sets the minimum number of faces for the progressive mesh from 0 to total number of faces. It 
will stop at 2 or wherever it can't make any more reductions.

Keep UV Groups - Tells the reduction code to not cross uv discontinuities (the separate groups on 
the UV layout) so the texture stays correct. Will prevent the mesh from collapsing all the way as each 
section will collapse as far as it can. Used for Auto LODs. When off, mesh will compress more and 
more evenly, but will have to have the uvs regenerated. Used for a one shot permanent mesh reduction. 
The UV Editor now dsplays Pro Mesh uvs.

Create Prog Mesh - create a progressive version of the selected mesh. Status line will show the 
progress.

Remove Prog Mesh - deletes the progressive mesh - NOT the current object
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Prog Mesh to Obj - creates a new object, skeleton included, from the current progressive mesh setting. 
This lets you make manual edits to the meshes before using them as LOD models.
Slider - sets the current progressive level, from Min to full faces count. Or enter number of faces in 
the text box.

Edit Anim/LOD Export (Pro)
Brings up panel to define Animations and LOD levels for game exporters.

Edit Vertex Animation (Pro)
Brings up the Vertex Animation panel.

Edit Bones (Poser / Pro)
Brings up the Bone Info panel for this object where you can manage and animate bones.

Edit Parts
Brings up the Parts Info panel for this object where you can set part colors.

Edit Surfaces
Brings up the Surface Info panel for this object, where you can connect object surfaces to scene level 
materials.

Edit IK (Pro)
Brings up the IK Info panel if the current object is of type Mesh abd has bones. 
Edit Plan (Game / Pro)
Brings up the Plan Info panel if the current object is of type Plan. allows you to set default for the plan 
and add new plan segments.

Conform To (Poser / Pro)
Brings up the Conform To panel where you can select another boned object for the bones of this object 
to track to in animation.

Parent To
Brings up theParentTo panel where you can select another object to track to.

Import Skeleton (Poser / Pro)
Copy a bone set from another object to this object. Import to a new empty mesh to save a skeleton.

Zero Object
Zero object takes the current transform (position, rotation and scale) and applys it to each point of the 
object, zeroing the transform. This is a non-undoable function. Why bother? Mostly for rotation and 
scale. An object always rotates around it’s own origin. (An easy way to see what this is, is to make all 
position and rotation fields zero and all scale fields one. The object origin is now on the system origin.) 
For example, you make a door and you make it from a scaled cube. The origin is still in the middle of the 
door. If you move the door over, so that the point you want it to rotate by (where the hinges should be) 
is on the system origin, you can now zero the object and the object origin is now over to that side of the 
object and when you rotate it, you get a normal door movement instead of it spinning in the middle.
It also removes scale. Moving a scaled object can get confusing, and rotating a scaled object can create 
shear. It can be easier, once you have the object shape you want, to zero it before using it further.
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Delete Object
Deletes the currently selected object (same as Cut).
Rename
Lets you change the name of the current object

Apply
Applies all the current panel settings to the selected object

Close
Closes the panel, any unapplied changes are thrown away.
There are some default objects that you can create under the Create menu.

Cube - Creates a simple cube, that is setup for game mapping. So use it as a block base.

Sphere - Creates a Sphere or Dome. You can set the number or divisions in both directions and the 
radius. The Dome switch tells it to create just the top half of the sphere.

Cone - Creates a 3 to n sided cone. You can set the height, radius and number of sides.

Empty Mesh - Creates a new mesh object to hand create new objects.

Empty Poser Mesh  (Poser / Pro)- Creates a new mesh object with a Poser type skeleton (see Poser 
Object Bones).

Terrain  (Game/ Pro)- Creates a new terrain object. 

Null  (Pro)- Creates a new null object for IK targets
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Object Parts
This panel which is reached from the Edit Parts button on the Object Info panel, allows you to set the 
display color and Tags for an object’s body parts. Body parts are face sets (like surfaces) that can be 
used for different purposes. Poser models uses parts to define the faces and points that belong to each 
bone of the skeleton and are also the basis for Poser morphs.

Top Area
Shows the list of parts for the current object.

Tags
Field to set Tags for the selected part. (See Objects for a discussion of Tags).

Display Color
Color to use for this part when object is in part color display mode.  Select brings up a color selction 
panel.

Rename
Chaneg the name for this part. Do not change for imported Poser models as this name must match the 
bone name.

Apply
Apply current field values to the currently selected part.
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Object Surfaces
This panel which is reached from the Edit Surfaces button on the Object Info panel, allows you to set 
the scene level Material that each surface uses and its Tags. Surfaces are face sets (like parts) that are 
used for assigning different  materials to parts of a model.

Top Area
Shows the list of the surfaces for the current object.

Tags
Field to set Tags for the selected surface. (See Objects for a discussion of Tags).

Material
Material that is currently assigned to this surface.

Select Material
Brings up a small panel that lists the scene Materials to choose from.

Rename
Chanes the name for this surface. 

Apply
Apply current field values to the currently selected Surface.
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Materials
This panel, reached through the Windows menu, 
allows you to view, add and edit the scene level 
material definitions.

Top Area
Allows you to choose a meterial to view or edit.

Diffuse Color
The basic object color. Values are from 0-1.0. 
The color settings DO affect textures. a texture 
basically alters the object color setting. SO you 
can use the diffuse color to make a texture lighter 
or darker and shift the color. Nomally for textured 
objects, this color is white (1,1,1,1).  Select brings 
up a color selction panel.
Ambient Color
This is hte color that will pick up the ambient 
color from you lights. It’s advantage is that it 
is non-directional. You can use this, laong with 
the ambient sun or light settings to add color 
to shadows. This color is added to all parts of 
an object. It is normally set rather low or it will 
override the difuse color.
Specular Color
This is the hightlight color. Normally white, it can 
be any color. If this is off (0,0,0,0) you will have 
no highlights.
Glow Color
This is like ambient, in that it does not depend 
on light direction, but unlike ambient, it does not 
depend on lights at all. This light will appear on 
all faces of the object, even without light sources, 
so it looks like the object is glowing. It does not 
cast light on other objects.
Shininess
This sets the surface shininess or size of specular 
highlight. It is used with specular color to control 
the shiny highlingts on an object.
Add Prefab Mats
This is a convenience button. It adds the set of 
Materials that are used by the built in Prefabs. If 
these materials exist when you create a Prefeb, 
the surfaces of the same names are automatically 
hooked to these materials, so you don’t have to 
go to the Edit Surfaces panel from Object Info 
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and hook them all up yourself.

Texture Map
This displays the currently selected color map for this material. 
Select
The select buttons bring up the Select Image list so you can assign a new image to a material as a 
map.

Transparency Map
This displays the currently selected transparency map for this material.
Trans Strength
The percentage of opacity (1 = opaque) of this material, or the percentage of transparency to use with 
the transparency map if one is defined.

Bump Map
This displays the currently selected bump map for this material. Currently this does not display in 
ToolBox but will be exported with a model.
Bump Strength
The percentage to apply the bump map.
Displace
This switch turns on true displacement mapping in GRRen using the Bump map. The Bump Strength 
is the max distance in ToolBox units to move the eurface out.

Reflection Map
This displays the currently selected Reflection map for this material.
Reflection Strength
The percentage to apply the reflection map over the base texture.
Auto Reflect
This automatically creates a set of 6 reflection maps around the object this material is used on to allow 
the scene to be reflected in the object.  (NOT YET AVAILABLE)
Ray Reflect
This sets this surface to use true ray traced reflections. Reflection Strength determines the percent of 
the surface that shows reflection vs the normal appearance. A full mirror is Reflection Strength 1.

Refract Index
The index of refraction for this material. Uses standard refraction indexes. Air = 1, Water = 1.3, etc 
Ray Refract
This turns on Ray traced refraction through this object if Trans Strength is less than .98. 
Toon - No Mat Line
Marks this material as one not to be outlined in Toon rendering 

Rename
Changes the name for this material. 

Apply
Apply current field values to the currently selected material.
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Images
This panel, found under the Windows 
menu, allows you to load and unload 
image files to use as textures. and 
also to set the resolution that they are 
being used in the display (this does 
not alter the actual image reolution 
that will be used for export.)

Currently you can import images in 
the following formats:  jpg tif bmp 
png ico gif tga pcx wbmp wmf jp2 
jpc pgx pnm ras.

Top Left Area
This is where you select a loded 
image for editing.

Top Right Area
A thumbnail of  the selected image 
will be displayed here with the images 
actual size printed underneath.

Display Resolution
Use these buttons to set the screen 
display resolution.

Loaded Path
This is the path that was used to 
locate the file. For files loaded with 
importers, like for Poser or game 
models, this is the texture name and 
path from the file.

Full Path
This is the path and name actually used to load the image. If no path is shown, it was found in the 
current directory.
Apply
Apply current field values to the currently selected image.
Load
This brings up a standard windows Open File dialog to find the image you want to load.
Delete
Removes the currently selected file from loaded images.
Delete All
Removes all files from loaded images.
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Make Tiff
Creates a tiff file from current selection.

UV Editor Image Controls
This section controls the display of background images in the UV Editor window and functions related 
to this image.

Enable Display
When checked, the controls in this section are functioning. When not checked, the UV Editor displays 
black lines (and selected in yellow) on a grey background.

Switch to White Lines
This lets you switch to white from black lines when you are using darker textures.

Set Image
This sets the image selected in the top selection box of the Image Info panel as the image displayed as 
the background of the UV Editor window. NOTE - If the ambient light is off for the ‘Sun’ in the scene 
settings panel, the image will be very dark as it is very large, 1024 units square. The currently selected 
UV background image is displayed above this control.

UV Editor showing all uvs for a human Poser model.
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Selected Image UVs Only (Poser / Pro)
This switch allows you to work with multiple UV sets. When this is on and a UV Editor background 
image is selected, only the uvs of those surfaces that map via one or more materials to the selected image 
are displayed. So you can have a full set of uvs for each image and not have to edit them all at once.

With Selected Image UVs on, only the surfaces that are mapped to the face image are shown. To change 
UV sets you just select another UV Editor background anf hit Apply.
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Terrain (Game / Pro)
Terrain is a special mesh type designed to simulate outdoor landscapes. It has a different rendering and 
uv mapping method from normal meshes.

Creating Terrain
You create a new terrain by using the Create Terrain command found under the Create menu.

You can not set the individual x and z positions on a terrain. Like for the game engines, you choose 
the number of points in the x and z directions and how far apart the points are spaced and the terrain 
triangle grid is created for you. This determines the base mesh grid. This is what you get if you choose 
type Flat. Flat terrains can be of any size. 

You can also choose one of the two fractal based generators to create the height values for you. Smooth 
generates a smoother surface, from slightly rolling ground to smooth hills. One of its advantages is 
that it can work on a mesh of any size. Rough creates much more spiky terrains but can only work on 
square meshes of power of two sizes form 8 to 1024.(Warning - 1024 generates over a million points 
and 2 million triangles - it is going to be slow to work on except in wireframe mode!)

Smoothing is how much filtering (smoothing) is applied to the generated terrain.

Experiment with the Terrain settings, even size has an affect of the resulting terrain.

Like all of the ToolBox geometry generators, you can keep adjusting settings and hitting Show until 
you get something you want to keep. Then hit Apply to keep it or Cancel to discard it.

Note - After hitting Show, you can still go and edit it form the Object info panel or any other edit tools 
before hitting Apply.

TIP - Use Y scaling to stretch the terrain up and down to help determine if you want to keep it. Height 
values are keep within a range that the game engines can read so scaling is needed to complete many 
terrains.

Editing Terrain
Most edit tools will work on Terrain, but there are some limitations so that what you see in ToolBox 
will match what you see in a game engine.
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You can move the entire Terrain in any direction with the Object Info transform or the mouse move 
tool. You can NOT rotate a terrain at all. You can scale a terrain only in the Y (Height) direction with 
either the Object Info transform or the mouse scale tool.

You can select points or faces of a terrain to edit (Terrain does not support Edge Mode). On selected 
points or faces, you can use the Move or Move Normal commands and the mouse Move tool. But the  
selection can only be moved in the Y direction. In other words, you can use the normal mesh tool set 
to change the height of any points in the mesh, but not their horizontal position, as this data would be 
lost on generating a Terrain output file.

Texturing Terrain
When you create a Terrain, a single surface is automatically created - Terrain Base. You attached this 
to a Material that uses an image for Color and this image will be used to texture the Terrain, edge to 
edge. Optionally, you can create a second surface, of any name you wish, and apply an image based 
material to this surface. This image will be used for a repeating Terrain detail map. Surfaces beyond 
the first two will have no effect. And creating new surfaces by selecting faces of a Terrain has no effect. 
Terrain surfaces are just used to specify the textures to use. Terrains do not use standard mesh surfaces 
for determining texturing.

Displaying Terrain
You can control detail and fog Terrain parameters for your scene from the Terrain Display Control 
panel, found under the Windows menu.

Detail Map turns on the use of a second image for Terrain detailing, if there is more than one surface 
defined for a Terrain. You can also set the detail level, the number of reapeats, that are used with the 
detail textures.

Toolbox also allows you to create height based volumetric fog for your scenes. The Fog switch turns 
this on. You can set both the fog color to us. Note - black (0,0,0) makes no visible fog but will darken 
the valleys of your terrain. Fog depth sets the highest level at which fog is visible.
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Saving Terrain
Terrain can be saved with a scene or as a separate object, like any other mesh. It also has a special 
export method to export just the height values to a .hgt file. This can be reloaded on a new Terrain with 
the same points, but a different grid size. It’s a compact way to save generated terrains.

Terrains are also exported to game system formats. These will be available under File / Export.

Currently the hmp format used by the Conitec 3DGS system is supported for export. These hmp files 
can also be imported through the normal Open command.

Terrain 128 x 128 created with Smooth type, smoothing 40 and then scaled to Y 3.0



40

Greenbriar Studio ToolBox
UVs
For animated models you need uvs to be able to apply image textures. ToolBox supports both traditional 
UVs and the special game level uvs. Game level uvs are of a particular type and are easily calculated 
for any scratch built or imported object with the Modify / Create Game UVs command. Traditional 
uvs are more difficult to create.

ToolBox supplies three main tools to work with traditional uvs, a uv generator that can create the initial 
uvs using several different projections, an interactive uv editor and a uv template generator. Also to help 
with uvs there is the Face Info panel where you can set uvs directly and the Merge Textures command 
that combines multiple images and uv sets into a single new texture for game models

UV Generator
Uvs can be created by calling the Create UVs panel under the Modify menu.

The projection choices are: 
Cylindrical - revolves around the y axis, splits the object down the back (-z) and keeps faces that cross 
the dividing line together.
Cylindrical Capped - same as cylindrical but also uses a top and bottom plane, a very handy all around 
projection method.
Box - Uses 6 planes to create the uvs. Mapped to 6 different sections on the uv map. This is the only 
one that does not use the axis switches.
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Plane - Uses a single x, y or z plane
Spherical - Unfolds our sphere
Front and Back - splits the model down the x, y or z plane and creates two sections. With the separate 
Surfaces switch, it creates a section on the uv map for each surface and makes a front and back for 
each surface.
Examples:

Plane projection of a set of fairy wings.

Cylindrical Projection of a dress top.
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Projection Differences:
On the right is a simple 10 by 10 division 
column.

Below is the uv map that results from 
cylindrical projection. The top and 
bottom points are actually lying along the 
top and bottom lines. Fine if the olumn is 
a pipe with no visible ends, but not good 
if you need to texture the end caps.
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Cylindrical Capped reserves the 
top quarter of the uv map for the 
top and bottom of the object. This 
also works well on spheres, or 
anything you want to wrap all the 
way around, but need to see the 
top and bottom in a direct view 
for texturing.

The bottom sample is a Box 
projection of the same cylinder. It 
breaks the map into what is visible 
from the six planes of a box.

Note that the box format allows 
more space for the front and back 
of the object, so orient the object 
so the widest side is facing forward 
(and Zero the object) to make the 
uvs. Two sides are normally larger 
than the others, so this allows you 
more detail on these sides.
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UV Template Generator
To easily use a set of uvs that you have created, you need a template (like the examples shown of the 
cylinder) so you can see exactly where all the uv points fall on a texture. The Modify / Generate UV 
Guide does this for you. It creates a B&W image of the uvs connected by the lines of the mesh faces.  
When you run this command, a new image will appear in Image Info and it will automatically be saved 
in your texture directory as a jpg file. It creates a 1,024 x 1,024 image so it will be sharp, but you can 
scale it (evenly or not) to any convenient size for use in a paint program. Paint over it and then load it 
as the texture for your model and everything will line up.

Face Info
Under the windows menu there is a Face Info command which will list all of the faces of the current 
object.

The selected face will be visible in the UV Editor window and allows low level setting of uvs, where 
you might need to tweak uv points apart, etc.
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UV Editor
ToolBox includes a complete, integrated UV Editor system. You activate the UV Editor by opening 
its window under the Window Menu. While open, it will display the uv set (if any) of the currently 
selected object.

The display window works in either basic or image mode. In basic mode all UVs of your model are 
displayed as black lines on a grey background. In Image Mode (See Image Info panel for controls) 
a background image is shown so you can see where the uvs are falling on your image. Image mode 
allows you to switch to white lines for use with darker textures. Image mode also allows for multi uv 
map work. By selecting an image that the model has surfaces mapped to and turning on display image 
UVs only, only the uvs of the surfaces that map to the current image are displayed. This allows you to 
easily work with multiple overlapping uv sets on a model.

UV map of a Poser model that uses sufaces mapped to three images. Note the overlapping and confusing 
set of uvs. On the top of the next page see the diference that turning on Display Image UVs only makes 
as only the face set is shown with the face image.

Selecting UVs
In either mode, you can edit the uvs in the UV Editor window. Since UVs are creatures tied to faces, 
not edges, only Face and Point Edit mode works with the UV Editor. You can select faces in the UV 
Editor window, or in any other open window. You can only select points in the UV window as you are 
selecting uvs, not points. The selected faces will show as highlighted in all windows. This allows you to 
use the perspective window and all the select options there to select the faces you want to work with.
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Note - In Multi UV map mode, not all faces selected in a non UV Editor window may show up, but 
they will still be moved. When working with multiple UV sets, it is safer to select in the UV Editor 
window.

Editing UVs
Once selected, you can use the mouse Move, Scale and Rotate tools to move the uvs around for faces, 
you can only Move with point selections. Shift Move with a Point selection will separate overlapping 
uvs, but only if you have selected 4 or less. Scale has a special case - nomally scale makes the entire 
selection larger or smaller evenly, but hold Shift down and it will scale only horizontally to allow you 
to change the shape of the item.

Regenerating UVs
If you have run one of our generators to create your UV set, so a full discontinuous set has been created, 
you can also select sets of faces and use the generator to regen just those faces (see the UV Mapping 
Tutorial on how to  create maps of complex models). With the generator and the UV Editor you can 
UV Map any model.
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Merge Textures 

Merge Textures, under the Modify menu, is a utility 
to merge multiple textures into a new single image. 
Requires that the object have more than one image that 
object surfaces are mapped to. It works with up to 32 
textures currently. It also works with colored surfaces 
(no image). These can be mixed for a total of 32 surfaces 
and images.

The default options are to also reset all the uvs to match 
the new combined texture and to repoint all of the 
materials used by the object to the new image (Use New 
Texture). You choose the size of the new image. 

The new image will show up in the Image Info list and 
also automatically be saved as a jpg to your Texture 
directory (defined in Scene Settings).

A resulting combined image showing three images and 
the three sets of uvs replaced into their new locations on 
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the single map. This tool will remap a multi image Poser figure into a single image, non overlapping 
uv set in four to twelve seconds.

The main use of this tool is to create single texture mapped models for game export as most game 
systems do not support multiple maps on animated objects, except as full alternate maps, for color 
variation, etc.

Flip UVs vertical and Horizontal
These two commands, under the Modify menu, let you flip UVs to help align images. If there is a 
current face selection, these two commands will flip only the uvs of the selected faces. If there is no 
current selction, they will flip the entire uv map.

Note - When flipping selections, they will also move. A selection in the top right corner will be in the 
top left corner after a flip horizontal, so it will have to be moved back, or to wherever you want it.
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Sky Box
The Sky Box is a tool to let you surround your scene with a 360 degree panorama. 

Ambient Color
defines the light on the Sky Box, does not affect the rest of the scene.

Size
Defines the size in ToolBox units of the cube that the sky box images are inside of.

Maps
The 6 image files that create the 360 degree image.

Select
Browse for each image.

Enable Sky Box
Turn on the rendering of the Sky Box.
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Subdivision Surfaces (Pro)
The Subdivision surfaces in ToolBox III are an implementation of true subD surfaces. They are based 
on the Catmull-Clark and Loop methods. If you model with only quads, you will have a true Catmull-
Claek subdivision surface. But the verison in Toolbox also allows you to use meshes composed of mixed 
quads and triangles (as developed by Warren and Schaefer). This means that any mesh that you can 
create in ToolBox can be used as a subD object. ToolBox also supports the marking of points to not be 
diaplaced and of edges to be displaced as bezier curces independent of the rest of the mesh, This allows 
you to add creases and sharp edges to a subdivision surface as the Catmull-Clark method developed.

Subdivision surfaces are easy to use. As a test, just start with a cube as is shown in this section.

On the Object Info panel (see Objects section for panel picture), you set the Subdivision Level (1 - 8), 
whether subdivision is currently active and whether you wish to display the control points.

Subdivision Level
The subdivision level is how any times the mesh is going to be subdivided and smoothed. Each quad 
is converted into four new quads and each triangle is converted into four new triangles. This new mesh 
is smoothed and then repeated for each level.
 
Warning - a six sided cube at level 6 is 24,578 faces! The higher the level, the londer each frame will 
take to generate. A big advantage is that you can test with a low level and then do a final render with 
a high level.

Subdivision Active
Turns the display of the subdivision surface on and off. also available via a hot key.

Display Control Points
The control points are the points of your original mesh that control the new  subD surface. They normally 
display in red. If there are too many and confusing, this lets you turn them off. However, you can’t 
select and edit them if they are off.

Editing Subdivision Surfaces
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By selecting and moving the points or edges (with subD off) or points (with subD on) you can change 
the shape of the resulting object. Recommended - use level 1-3 for mouse editingto see real time editing 
changes.

Bones, Morphs, Vertex Animation and Subdivision
In an animated model, subdivision is the last step applied, so you can use bones, morphs and even vertex 
animation on a subD object. This is one of the major advantages of subD, the ability to animated a low 
res model, where bone weighting is simple and then let subD smooth out the mesh.

Subdivision and UVs
Subdivion preserves normal UVs as it divides. It does not, however, maintain game uvs which are position 
dependent. The data is still there for the game uvs. If you are using a subD object for a non-animated 
game model, just freeze the model when it is done and then select Create Game UVs to reset them.

Freeze Subdivision
The Freeze Subdivision command under the Modify menu, converts the base model of object into the 
current subD level. So Subdivision Level becomes 0 and Subdivision od off, but the model doesn’t 
change. thi sis useful not only for makeing a final model, but for doing a low level subD to get more 
detail to add creases to (see creases below). You can then further subdivide the model.

Subdivide
The Subdivide command inthe Modify menu is not really part of the subD system itself, but a helper 
tool (as is Triangulate under Modify). It adds a new center point to each currectly selected face and 
turns the face into four faces. This is just an easy way to add extra detail to a mesh section for greater 
control over a subD mesh. It is not restricted to use on subD meshes.

Creases
The one complex part of the subD system is the ability to define creases. creases are points or edges 
(actually the set of points defined by the edges) marked so that the smoothing system knows to treat them 
differently. for points, the point will not move. So you can select parte sof the model you do not wish 
to smooth. For edges, the edge will still smooth, but only influenced by the points of connected marked 
edges. the rest of the mesh does not affect them. So they smooth as a single bezier type curve.

NOTE - since edges are only affected by themselves, selecting only one edge means it will not move 
at all since all the points to smooth by are in a straight line. (You can smooth a curve, but smoothing a 
straight line is a straight line!) So selecting a single edge is the same as selceting the ends as points.

You select either the points or edges on the BASE mesh (or for points, by selecting the control points 
of an active subD mesh) with the normal select edge and point mouse tools. Then you use either the 
Set Crease Points command or the Set Crease Edges commend under the Modify menu. The current 
selection set then becomes the edge or point selection set.

Instead of the normal red, control points taht are part of an edge crease show in blue and points that are 
point creases show as green. Any may be selected to be moved, scaled or rotated.

NOTE- To maintain backward compatibility, the edge and point selection sets will NOT be saved to 
the scene file if the Subdivions level is zero. Subdivision may be turned off, but if level is zero, it will 
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not be saved as a subD object. Only crease info can be lost this way.

Points can be in both the edge crease set and the point crease set. If in both, that point on the edge curve 
will not move, but the rest of the set will still curve around it. When displayed, the point will show as 
a point crease in the display.

Single Crease EdgeSingle Crease Point

Top Edges as Edge Creases
Plus One point also as Point Crease
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Animation (Poser / Pro)
The Animation Control panel is found under the Windows menu. This panel allows you to create 
animation keys for all objects. Morphs have a separate animation control panel, the Morph Mixer.

The basic process is to first set Current Frame to the key frame you want to start with, then position any 
objects and lights, hit the Key Current Selection or Key All and then repeat for the next key frame.

To see your animation, set the start and end frames and click on run.

Frames Per Second
The maximum frames per second to 
play back. And the FPS value that will 
be used by exporters.

Current Frame
The current time in the scene

Start
First Frame to play back

End
Last Frame to play back

Stop
Breaks a Run

To First
Jump to Start Frame

Back Frame
Go back one frame

Next Frame
Go forward one frame

Run
Play animation from start frame to end
frame

Animation Keys
Four sections each with three buttons -
Key current frame, remove current
frame, remove all frames

Current Object
Creates or updates the animation key 
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for the currently selected light, object
or camera. Does not affect bones.

All Objects
Creates or updates the animation key for all lights, objects and cameras. DOES affect bones.

Current Bone
Creates or updates the animation key for the currently selected bone in the currently selected object.

All Bones
Creates or updates the animation key for all bones in the currently selected object.

Key Framed Objects
These are info fields. Key framed objects shows how many objects in the scene have a key on the 
current frame. Key on Object will be checked if the currently selected object has a key on this frame. 
Key on Bone will be checked if the currently selected bone in the currently selected object has a key 
on this frame. 

Insert and Delete Frames
This allows you to shift animation in the timeline by adding or deleting frames. Number of Frames 
is how many will be added or removed. (They are added BEFORE the currect frame, so you can add 
before 0.) By default, all objects in the scene are affected. By Checking Object Only, only the currently 
selected object is affected. If Bone Only, only the currently selected bone is affected.

Real Time
Check for real time run - when checked, pops up a warning when you run if frames are not being 
generated in real time.
Force - Forces playback in real time by skipping frames as necessary

Sound (Dynamic)
The sound panel lets you load and playback a sound track with animation playback. Browse lets you 
find and load a sound file. (WAV and other formats supported by OpenAL.) Play with Run turns on 
sound playback. Audio Size shows you the number of frames, at the current frames per second, of the 
sound file. This was added, since QuickTime has a nasty habit of extending the display time of each 
frame if there are less frames in the video than in the sound! This way you know the number of frames 
to export to match the sound clip. 
And to help prevent this problem, if your video frames are shorter than the audio, we now will list the 
last frame as many times as needed to equal the sound file length. So the QT playback will now do what 
you expect - the video simply freezes while the sound track completes, rather than have the video slow 
down to stretch to the audio length. But if you export MORE frames of video, QT will speed them up 
to match the audio length.
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Animation Grid (Poser / Pro)
The Animation Grid is a panel to visually display all keys in a scene. You can select a key, move it on 
the time line, delete it or call up its editor.

Reload List
Forces a relaod of all scene objects. Use after creating new objects with this panel open.
Arrow Keys and Slider
Changes frames displayed
Edit
Opens appropriate editor for selected key (Key selected with mouse)
Move Keys
Moves the selected key from frame to frame, but NOT through another key
Delete
Deletes selected key
Problem with Tree control - if you use the vertical slider to scroll up and down the list, you must click 
in the list before it will redraw the correct key lines
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Morph Mixer (Poser / Pro)
This main tool for working with morphs is the Morph Mixer panel found under the Windows menu. It 
allows to selct from any of the objects in the scene that contain morphs and set and animate them.

Select Object
This is where you select the object that you wish to work on. When selected, the morphs for that object 
will appear in the right hans part of the panel.

Morph Controls
These are the controls for the individual morphs. You can change a current morph setting by moving 
the slider or typing in the text box. Note - Changing a morph setting automatically creates or changes 
the animation key at the current frame.

Right Slider
This lets you scroll through the set of morph sliders. there is no limit to the number of morphs that you 
can have. Some DAZ models cvan have 3,000 which is supported by the ToolBox morph system.

Page Buttons
Below the right slider are page forward and page back buttons that you can also use to move through 
the list of morphs.
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Create All Keys
This button forces a key on all morphs at their current setting at the current frame. This will make keys 
for morphs that are at zero that have not been moved yet. This key, and all others described below, only 
affect the currently selected object.

Delete Current Keys
Delete all keys for any morph that ahs a key at the current frame.

Delete All Keys
Delete ALL morph keys for all morphs for this object.

Reset Values
If your object was loaded from an importer and came in with initial morph settings, this will reset the 
morphs to those settings. If you made the morphs in ToolBox, this will reset them to zero.

Rename Morphs
Change the name of an existing morph/

Close
Close Morph Mixer panel. Does not change or delete any keys or settings.

Joint Control Morphs
Link a morph so that it activates depending on the 
position of a bone. One bone can drive many morphs, 
but a morph can be controlled by only one bone. When 
this is set for a morph, any morph animation keys are 
ignored. 
The top field shows the current morph (last one used in 
the Morph Mixer panel).
The selection list lets you pick the bone yo want to drive 
the morph. Then select the axis that will drive it.
You can set three bone angles to control the morph and 
three morph settings to go with them. This allows you to 
have the morph move one way and then back as the bone 
moves. the bone angles must be in incresaing order, but 
the morph settings do not have to be in any order.
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Mesh to Morph and Morph to Mesh (Poser / Pro)
These tools are found under the create menu. They provide a very easy way to both create new morphs 
and edit existing morphs. (See the morph creation tutorial for a step by step walk though of creating 
a new morph.)

To Create a New Morph
You start with a base object that you want to morph. You can use any mesh object, regardless of source. 
It doesn’t matter whether it already has morphs or not. You then make a copy to alter. Make whatever 
alterations that you wish to the copy and rename it to whatever name you want the morph to have.

Next run the Mesh to Morph command and select the original object and hit Add as Morph. The morph 
is made. The Mesh to Morph command will show any objects in the scene that match the point count 
of the selected object.

To Edit an Existing Morph
To edit an existing morph, just select the object with the morph you want to edit, run the Morph to 
Mesh Command and pick the morph you want. It will create a full object that is the base object plus 
that one morph applied at its 1.0 setting. Texture copying is optional. The copy will become the current 
selection and will be at 0,0,0. You may need to move it away from the parent object to work on it. Use 
the procedure above to add it back as a new morph after you have edited and renamed it.
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Poser Injection Poses (Poser / Pro)
Exporting a single Morph
You can export a single morph as a INJ/REM pose pair for use with DAZ models that contain community 
channels. Under File Export, select Morph as Injection Morph.

Channel is which DAZ community channel you wish to use. If Body level morph is checked, a Body 
level dial is created to control the morph, regardless of how many body part morph are created from 
the selected morph. Unchecked, each body part has its own dial.

This tool is to export a custom character morph for a DAZ base mesh. Both  a INJ and REM file will 
be created to make installation simple. Files are written to the selected Poser Pose directory.

Exporting a new Model with Injection Morph Poses

You can also export a new model with all your morphs as INJ morphs and matching empty channels. 
To set this mode, check the Injection Morphs box in the Poser settings panel.

When checked, instead of putting your morphs in the CR2 file, only empty channels for each morph 
are craeted in the CR2 file (like DAZ CR2s are set up). Then for each morph, a INJ and REM pose file 
is created, allowing your users to install only the morphs they want.
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Object Bones (Pro)
Mesh objects can contain bones, which can be animated through the animation control panel. Bones 
can be created by model loaders or by hand from the Bone Info panel. Bones can be placed and moved 
via this panel or by using the Bone Select mode with the mouse and using the Move, Rotate and Scale 
Mouse functions. Active bones that are controlling meshes can be animated from the Bone Info panel or 
with the mouse by using Bone Select mode and Rotate and Scale functions (you can not move an active 
bone, which would pull the skeleton apart, they can only be rotated and scaled). If you need a skeleton 
to just animate a set of other objects, an empty mesh can be created to just hold the skeleton.
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The Bone Info panel

Top left is the area where you can select the current bone. This is synced to the Bone Select mouse tool, 
so you can use either method to select a bone to edit.

Position
The position of the bone is its Center of rotation and its End point. Only the center point is critical. It is 
the point of rotatioon for the bone. The end point determines how the bone is drawn. It does not have 
to connect to the Center of another bone. The end point is not used with manual mesh skinning, but 
will be used in the future for auto-skinning methods.

If the bone is not Active (if the root bone, the first in the list, does not have active checked) you can 
move the bone by simply entering new data in Center and End.

Move Bone
This section has the bone active flag and a move vector.

Bones can be active (they are being used to deform a mesh based on their movement away from their 
initial resting orientation) or inactive (they are not affecting the mesh) inactive is the bone editing state 
that allows you to move the bones around to where you need them so you can then define the bones initial 
reating state. Bones are active or inactive depending on whether the root bone (first bone in the list) has 
its active flag checked or not. The active checkbox has no impact if used with any other bone.

Move applies the same vector to BOTH Center and End points so you can move a bone without changing 
its rotation.

Animate Bone
The animate bone section has two uses. The obvious one is to animate the bones! When a skeleton is 
active, only this section can displace a bone by rotating it and scaling it. This can also be done with the 
mouse without using this panel.

The other use is to position an inactive bone by rotating and scaling it (which can also be done with 
the mouse).

Important note on Bone Scaling - Bones don’t scale like normal parented objects, or like some other bone 
systems do. Scale is not inherited. If you scale a forearm longer, the hand and fingers are not affected. 
They are displaced by the scaling of the forearm, but not scaled. This way you acn alter models with 
scaling without having to go and then scale back all the downstream bones.

Note on bone orientation - Bone orientations are in object space not world space. If the model has an 
identity transform, they are the same. If you bend a knee 90 degress and then rotate the model, it will 
still read 90 degrees, it does not get recalculated into a confusing new orientation everytime you move 
your model. This simplifies animation and also animated model export.

Links
Links determines which bone is the parent of a given bone and also which outside objects are parented 
to a bone. Child objects are other, bones or unboned, mesh objects that you wish to attach to a bone, 
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so the child will move with the bone. Once linked the child object is controlled by the bone and can 
not be independently animated.

Weights
The weight section is where you can manually link your skeleton to its mesh.
 
Clear Weights 
Removes all the links to points for the currently selected bone.

Weight Value
Determines the weight that will be assigned when the next set of pints are added to a bone.

Add Selection
Adds the currently selected points to the currently selected bone using weight value. To add points to 
a bone - Select the bone either in the  Bone Info window or with the mouse using Bone Select Mode, 
then enter Point select mode and select the points on the model that you want to attach to the bone, set 
the weight and then hit Add Selection. You can add points multiple times, with the same or different 
weights. If you add the same point more than once, the last weight is what is remembered. 

Weight Display Mode
Just under Add Selection this check box enables displaying which points are attached to the current 
bone. Yellow means weight equals zero (a bad thing) and red means positive weight (from pale near 
zero to strongest at 1.0) and blue means negative weight (from pale near zero to strongest at -1.0). 
Weight display mode can only be used when the Bone Info panel is open. It automatically disengages 
when you close the panel.

There is no limit to how many bones you can assign a point to. But the sum of all weights needs to 
be one. The bone system has a built in auto-normalization so that all bones will get moved correctly, 
but it may not do what you want. Since a point can be tied to any number of bones, the bone system 
doesn’t know until it has finished processing all bones which bones a point may use, so the on the fly 
normalization is pretty simple. IF a point ends up with a total weight less than one, the last bone that 
affected it is used to make up the difference. So a point with one bone with .5 weight will work as if 
it had 1.0, but a bone with two bones with .25 weights will move as if the second bone was .75. Once 
a point has accumulated weights of 1.0, and further bone affects are ignored. Just a heads up to those 
building multi weighted models. Auto normalization tools are on the list to be constructed.

Rotation Order
This displays and lets you select the rotation order for this joint.

Joint Orientation
Non-zero joint orientations are displayed and set here. As an example, you can use an orientation to fix 
a forearm that isn't exactly on the x axis, so it twists correctly given a simple x rotation. 

Limits
Rotation limits for each axis. Exported to various file formats.

Use Limits
Turns enforcing of Rotation limits on and off.
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Set Current Pose as Rest
Make the current position of all joints the zero position in respect to deforming the attached mesh. Used 
where a pose is required to adapt a skeleton to a particular model and you can't alter the skeleton as it 
has an existing animation set.

Auto Skin
Auto Skin sets or resets all the bone weights. It attaches each point to the one or two bones closest to 
it. If two bones it proportionally weights each bone based on distance. The Eyes switch tells it to keep 
the eyes separate form the rest of the mesh (if body parts rightEye and leftEye exist).

Zero Bone
This important function is used to set the initial resting (no affect on mesh) position. This only works if 
the skeleton is inactive. What it does is to apply the Move, Rotation and Scale to the bone. It calculates 
the new center and end points and zeros the transforms. The bone will not move, the transform will be 
zeroed and the current position becomes the new bone resting position.

Delete Bone
Removes a bone and reparents around it.

D Bone/Child
Delete Bone and CHildren - Removes a bone and all of its children.

Rename
Lets you change the bones name.

New Bone
Creates a new bone within the currently selected mesh object. If there is no bone selected, a new bone 
is created at 0,0,0 with no parent (make sure you only leave a single bone, the first one, with no parent, 
roots other than the first one will not affect the mesh).

If a bone is selected, a new bone is created as the child of the selected bone. The new bone’s center will 
be the end on the selected bone and it will have the same direction and length as the selected bone.

Tip - Create the root bone and them move it to where it needs to be before creating child bones. Moving 
inactive bones to position them does NOT move their children. If you need to move the skeleton later, 
you will have to move each bone.

Zero Pose
Sets all rotations back to 0,0,0 and the root bone movement back to 0,0,0. Quick way to reset the model 
and remove a pose.

Apply
Applies any changes you’ve made on the panel to the selected bone. Must be used after each change. 
Weight display mode affects all bones, all other fields only affect the currently selected bone.

Close
Exit the panel, any unapplied changes are lost.
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Poser Object Bones (Poser / Pro)
The Bones in a Poser Mesh Object are identical to a normal mesh object’s bones,  except for how they 
are joined to the object’s mesh or skin. Normal bones are connected via weights. A mesh point can be 
connected to one or more bones via a weight value which determines the amount of influence that each 
bone has on the point as the bones move. Poser mesh objects instead use a control methid similar to 
the native Poser system using joint angles, spherical matrices and bulges. While more complicated to 
set up, this system provides more natural joint deformations and allows you to create models that can 
be exported to DAZ|Studio and Poser.

NOTE - Always zero the Pose before working on the joint parameters or they will not be properly 
aligned in your view with how the parameters see the mesh.
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The Poser Bone Info panel (Much of this section is a repeat from the previous bone section.)

Top left is the area where you can select the current bone. This is synced to the Bone Select mouse tool, 
so you can use either method to select a bone to edit.

Position
The position of the bone is its Center of rotation and its End point. Only the center point is critical. It is 
the point of rotatioon for the bone. The end point determines how the bone is drawn. It does not have 
to connect to the Center of another bone. The end point is not used with manual mesh skinning, but 
will be used in the future for auto-skinning methods.

If the bone is not Active (if the root bone, the first in the list, does not have active checked) you can 
move the bone by simply entering new data in Center and End.

Move Bone
This section has the bone active flag and a move vector.

Bones can be active (they are being used to deform a mesh based on their movement away from their 
initial resting orientation) or inactive (they are not affecting the mesh) inactive is the bone editing state 
that allows you to move the bones around to where you need them so you can then define the bones initial 
reating state. Bones are active or inactive depending on whether the root bone (first bone in the list) has 
its active flag checked or not. The active checkbox has no impact if used with any other bone.

Move applies the same vector to BOTH Center and End points so you can move a bone without changing 
its rotation.

Animate Bone
The animate bone section has two uses. The obvious one is to animate the bones! When a skeleton is 
active, only this section can displace a bone by rotating it and scaling it. This can also be done with the 
mouse without using this panel.

The other use is to position an inactive bone by rotating and scaling it (which can also be done with 
the mouse).

Important note on Bone Scaling - Bones don’t scale like normal parented objects, or like some other bone 
systems do. Scale is not inherited. If you scale a forearm longer, the hand and fingers are not affected. 
They are displaced by the scaling of the forearm, but not scaled. This way you acn alter models with 
scaling without having to go and then scale back all the downstream bones.

Note on bone orientation - Bone orientations are in object space not world space. If the model has an 
identity transform, they are the same. If you bend a knee 90 degress and then rotate the model, it will 
still read 90 degrees, it does not get recalculated into a confusing new orientation everytime you move 
your model. This simplifies animation and also animated model export.

Links
Links determines which bone is the parent of a given bone and also which outside objects are parented 
to a bone. Child objects are other, bones or unboned, mesh objects that you wish to attach to a bone, so 
the child will move with the bone. Once linked the child object is controlled by the bone and can not 
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be independently animated. This section is also where you can parent other objects (unboned, normal 
boned or Poser boned) to a bone of the current figure.

Add Child
This brings up a seclection box to let you pick the object to add as parented to the currently selected 
bone. Any object type may be selected.

Remove Child Object
Select a child object  and then use this button to break the parenting connection.

NOTE - Conforming is done on an Object level, so it is done in the Objects Info panel, not either of 
the Bone Info panels.

Zero Bone
This important function is used to set the initial resting (no affect on mesh) position. This only works if 
the skeleton is in-active. What it does is to apply the Move, Rotation and Scale to the bone. It calculates 
the new center and end points and zeros the transforms. The bone will not move, the transform will be 
zeroed and the current position becomes the new bone resting position.

Delete Bone
Removes a bone and reparents around it.

D Bone/Child
Delete Bone and CHildren - Removes a bone and all of its children.

Rename
Lets you change the bone names.

New Bone
Creates a new bone within the currently selected mesh object. If there is no bone selected, a new bone 
is created at 0,0,0 with no parent (make sure you only leave a single bone, the first one, with no parent, 
roots other than the first one will not affect the mesh).

If a bone is selected, a new bone iscreated as the child of the selected bone. The new bone’s center will 
be the end on the selected bone and it will have the same direction and length as the selected bone.

Zero Pose
This button returns all bones to their rest position, removing any pose on the figure.

Tip - Create the root bone and them move it to where it needs to be before creating child bones. Moving 
inactive bones to position them does NOT move their children. If you need to move the skeleton later, 
you will have to move each bone.

Apply
Applies any changes you’ve made on the panel to the selected bone. Must be used after each change. 
Weight display mode affects all bones, all other fields only affect the currently selected bone.

Close
Exit the panel, any unapplied changes are lost.
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Joint System Information
The following section describes the controls used to control the connection of the mesh to the skeleton 
using Poser style joint controls.

Joint Params
This section displays the parameters that are spscific to one axis of movement. The axis is selected at 
the top, and the display shows the parameters associated with that axis.

Twist
The twist section shows which axis is the twist, by the check box. And if the box is checked, shows 
the Start and End values for the twist. The values display are the same as you will see in Poser (Poser 
scale) so it is recommended that you edit them with the mouse with Display Params on. Although you 
can manually change them here, as well.

Angles
If Angles are used for this section, the box will be checked and the angles displayed. they can be edited 
here or with the mouse.

Bulges
If bulges are used, the box will be checked and you can only edit bulges by the fields on this panel.

Matrices
If matrices are used, the box will be checked and they can be edited by turning on Display Params and 
editing them the Move, Rotate and Scale Object tools. There is no direct entry for the matrices.

Mouse Editing of Params
The param displays can be selected just like a normal object and then manipulated with the appropriate 
Move, Rotate or Scale Object tools. (Matrices allow all three, Angles - Rotate only, Twist -Move 
only.
Bulges can only be set in the Bone Info panel, there is no graphic equivalent. As long as a param widget 
is selected, all tool actions will apply to it. To go back to editing the main object, reselect the object. An 
object remains selected while a widget is being manipulated, so you can see the changes in the panels, 
but it can not be affected by mouse tools until re-selected.

There are other sections that show information common to all axes.

Joint Orientation
Joint orientation is the rotation away from the twist axis - x, y or z. It allows you to direct the twist in 
the exact direction you need. It also affects all joint params and is reflected in the param displays.

Rotation Order
This is the order in which the different motions are applied. It varies deoending on what works best for 
the joint. Look at Poser models for examples.

Rotation Limits
These are the limits that will be exported to Poser for this joint. They are for export only, they are not 
enforced in ToolBox.
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There are two joint param editing controls.

Display Params
This check box is used to turn on the graphical joint editing widgets. check the box and hit Apply and 
they will appear. It will stay on until you turn it off, or close the Poser Bone Info window. 

Note - unchecking the Use Matrices box will trun them off making it easier to see and edit the other 
params. It will not change them. but unchecking the Twist, Angles or Bulges WILL erase them, as they 
have screen displays that willbe zeroed.

Create Weights
This resets the current internal control data from the bone param information. You need to use this after 
changing params. Note - This will always zero the pose as it needs the bones resting positions.

Poser Mesh From Weight Mesh
Under the Create Menu, this command creates a duplicate of a normal Weight boned object as a Poser 
Joint system object with default parameters. You then need to adjust and test the joint paramters.

Weight Mesh From Poser Mesh
Under the Create Menu, this command creates a duplicate of a Poser Joint system boned object as a 
weight mapped object with default parameters. You then need to adjust and test the weights. (TBD)

Poser Model: NefToon Gal by Neftis
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Vertex Animation (Pro)
One of the unique features of ToolBox is the support for true vertex animation. Vertex animation can 
be loaded from game models, such as md2 models and played back in ToolBox. Since the bones or 
other deformers that created the initial animation are not in the files, most systems can only read the 
base object. We import the base object plus all the animation frames.

ToolBox can also create a vertex animation from a morph and or bone animated ToolBox object.

Why handle vertex animation as an actual type? Mostly for editing. You can import a md2 figure, add 
a skeleton and a new animation sequence, generate this to a vertex animation and add to or overwrite 
the original model’s animation. You can edit and extend game model animations.

Also, if you are making your own models, it lets you tweak your animations. Bones are nice, but it 
takes a lot of work to get good looking joints and you have to use a weight set that gives the best 
overall result. this may work great for most movements, but it’s not hard to find one that doesn’t look 
so great. Convert a bone animation to a vertex animation and you can then edit the frames that still 
need some work. Like editing frames in Photoshop, you can correct frames individually where needed 
before exporting.

Deformation caused by morphs as well as bones converts to a vertex animation.

Although games are starting to support bones more and more, they are still fairly limited and usually 
only allow one bone per point, making joints very rough for organic characters and facial animation 
about impossible. But using their older vertex animation formats, you can create smoother organic 
animations complete with lip syncing, if you want it. Bones are much better for mechanical animation  
as they require less space (but more runtime processing), but vertex animation still gives you more 
control over detailed animation for things like closeup characters.

Create Vertex Animation
This command, under the Modify menu, converts the selected range of frames to a vertex animation. It 
executes each frame of the morph and bone animation of the model and then captures the vertex deltas. 
Created frames are merged in with any existing vertex frames. New frames of the same frame number 
as existing frames will overwrite the existing frames. So this function both adds and replaces set of 
frames in an animation. Start and end can be any frame. End must be greater or equal to start.
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Edit Vertex Animation
From the Object Info Panel, you can select Edit Vertex Anim to bring up the Edit Vertex Anim panel. 
This panel displays a list of all the frames of the vertex animation for the selected object by name. When 
you select a frame, you will see the actual frame number of that frame. You can rename the frames as 
is appropriate for your target system. These are the frame names that will be exported with the model. 
You can also delete frames. Deleting a frame does not reset the frame numbers of the remaining frames. 
So you can delete here and then create new frames with Create Vertex Animation.

Renumber Vertex Frames
You can compact a vertex animation by running this command from the Modify Menu. It resets the 
frame number to be the position of the frame in the vertex frame list, starting with zero. The playback 
will then skip any frames that had been deleted.

Editing a Vertex frame
You can directly edit a Vertex frame to tweak and fix an animation before is is exported in vertex mode 
by turning on Vertex Animation in Object Info and then using the Animation Info controls to move to 
the frame you want to correct. You can now use the Point Edit mode to select points and move them 
with the mouse move tool to reposition any stray points. This type of editing only affects the current 
frame. To save the changes, use Modify / Vertex Animation / Reset Vertex Frame.

Delete Vertex Animation
Modify / Vertex Animation / Delete Vertex Animation to remove the vertex animation from an 
object.
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Object Conforming (Poser / Pro)
Conforming is a special type of parenting that applies only to two boned objects. A boned object can 
be made a child of another object, or of a bone, and it will move around with its parent. But there will 
be no automatic movement WITHIN the object.

Conforming makes the skeleton of one object follow or conform to the skeleton of another object. It is 
used mostly for clothes that you want to automatically move with an animated figure rather than having 
to animate them both. When a object is conformed to another object, its bones will jump to and track 
with the bones of the conform to object.

From the Object Info panel, select the Conform To button to bring up the Select Conform To Object 
panel. From here pick the object that you want the current object to conform to (track with). Only 
objects with bones will be displayed in the list (along with none, so you can turn it off). You will get 
an error if you try to conform an object to itself.

Future versions will allow you to specify scale, position and rotation separately for conforming so you 
can use it to make chorus lines, etc.
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Animation Sections/ Level of Detail (Pro)
Animation and LOD for Export
This dual panel lets you set up both animation sequences and level of detail definitions for game exports. 
This is accessed from the Object Info paenl and shows information for the currently selected object.

Animation Sections
This part allows you to divide a long set of animation frames into a set of named sections for export. 
They do not have to connect, you can use any sequence of frames for any section and they do not have 
to be in any order.

Animation sections - the names of each section defined for this object
Start Frame - the first frame to include in this section
End Frame - the last frame to include in this section
Cyclic - cyclic animation flag for Torque export
Blend - blend animation flag for Torque export
New - create new section
Rename - change the name of the selected section
Remove - delete the selected section
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LOD
This part allows you to define multiple levels of detail for game exports. They can be either automatically 
generated from a progressive mesh of your object, or they can be manual - you just select the object 
you've made that you wish to use for each LOD.
Note - the progressive mesh will export a model at any level, so you can start form the auto generated 
mesh (that is still hooked to your skeleton) and then manually edit it to improve it. Then you can use 
it as a manual LOD model.
Ogre Note - You must select all Auto or all Manual LODs. If not, you'll get an error and LOD will be 
skipped. Torque can mix LOD types.(LOD is not yet complete for Torque, with a little help from 
the Garage Games guys, we will have an update for it shortly. It is already set to use the progressive 
meshes or normal models, but an internal link in the DTS file is missing. They all show up as level 0 
at the moment.)

LODs - the names of each LOD defined for this object
Detail Level - The level number (if needed by the exporter)
Auto Progressive - if you have created a progressive mesh for this object you can specify that this 
level is to be automatically generated from the progressive mesh. When checked, Faces must be filled 
out, if not checked, you must select the object that is the LOD mesh for this level
Faces - for progressive mesh, The number of faces for this LOD
Distance - for Ogre - distance from the camera for this LOD to become active, for Torque - the size in 
pixels - both will require a little experimentation to make sure the shift is at the right size/distance.
Select Object - Brings up a window to let you select the object for this LOD
New - create new LOD entry
Rename - change the name of the selected LOD
Remove - delete the selected LOD
Apply - saves all info
Close - close window wothout saving

Alexis in Ogre Game engine
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IK (Pro)
IK Info
It is accessed from the Object Info panel and will show the defined IK chains of the currently selected 
object and allow you to edit them. You can only have IK on a boned mesh.

Select Effector - Brings up a window to let you select the end bone of the chain (that which will track 
the target).
Select Root - Brings up a window to let you select the start bone of the chain.
Select Target - Brings up a window to let you select the object the chain will follow. You can use a rel 
object, or create a null object if you don't want it to be visible.
Create - If all three of the above are filled out, this will try to create the IK chain. If so, it will show 
the number of links ion the chain. If the root is not a parent up the skeleton form the effector, the create 
will fail.
Active - Whether the IK is currently running, can not be trurned on until the chain is created.
Smooth Solver - the default IK solver that tries to bend each bone the same amount to reach the target. 
When off, a more common solver type is used, one that moves the closet bone to the target first.
New - creates a new IK definition for this object.
Rename - renames the selected IK chain
Remove - delete the selected IK chain
Apply - saves all info
Close - close window wothout saving
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Cameras (Pro)
Cameras are used with the Renderman rendering system to create still and animated rendered output. 
ToolBox supports any number of cameras. All camera data is animateable. Also, you can switch the 
main perspective view to look through any of the cameras instead. You can select a camera with the 
Object Select tool and use the move and rotate mouse tools to position cameras.

Rotation
Displays/sets the Camera rotation

Position
Displays/sets the Camera position

Field of View
The FOV angle of the camera, 1 to 180 degrees

Show Camera View
Turns on view through current camera mode in main perspective window. When this is on, you will see 
a yellow outline of the camera view (defined in Render Options). If you size the window to just fit the 
yellow box, the main window will mirror the camera view. Since OpenGL and Renderman calculate 
FOV differently, if you change the window size, they will 
no longer be an exact match. Show Camera View turns off 
automatically when you close the Camera Info window.

Looking At
Select brings up an object list to let you pick an object to Look 
At. Look At points the camera at the origin of the selected 
object. A good way to use this is to Look At a null. You can 
either animate the null to control the camera direction, or parent 
the null to a bone or another object. The camera direction is 
updated at the beginning of each frame.
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Rendered Output (Pro)
The Render Menu has five entries - To Window, to generate a test single frame render (which can be 
screen grabbed), To File, to generate single and multi frame outputs to one or more single frame files, 
OpenGL to File, OpenGL Playback and Render Options, to set the parameters for the render.

ToolBox uses the standard RenderMan renderer interface so that it can support multiple RenderMan 
compatible renderers. With the addition of Greenbriar's own special renderer, we now support three 
renderers - GRRen - Greenbriar Poly Renderer, a Renderman compatible renderer optimized for 
polygons, 3Delight and Pixar’s PRMan (Photo Realistic RenderMan), the tops in the industry. (See 
GRRen section for more details on GRRen useage.)
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Set Screen - sets the current main screen to be the same size as defined for the renderer

Ouput Size - renderer size in pixels

Size Menu - some standard sizes presets 

Background Color - Optional background color where there are no renderable objects in the 
background

Transparent Background - Disables background color and enables alpha channel output for tiff and 
exr output.

Multi Frame Out - For File output, if On, exports from start to end as image files, if Off export is 
current frame. To Window render is always current frame. If multi frame is On, a QuickTime movie 
file is automatically generated.

With Sound - export the sound file from the Animation Control panel into the QT out file along with 
the animation frames.

Poly Smoothing - emables a special GRRen function to smooth polygon objects based on their normals. 
(Currently in testing and final development.)

Anti Alias and Filtering - Anti Aliasing size (ex 2 = 2 x 2 sub pixel sampling) and filter type.
 
Output Filename - name for file output. Path from ToolBox home. Give the base name only, ToolBox 
adds a number, if multi frame, and the correct extension for the selected File Output Type.

Output Path - the directory to write the image and QuickTime files to. Note - due to a limitation of 
QuickTime, the sound file, if any, must be copied to this directory before QuickTime can open the 
movie file.

GRRen Ray Tracing controls

Disable - Turns off ray trace functions in GRRen only. This is to allow you to make quick test renders 
without ray tracing wothout having to change your material settings.

Recursion Limit - Sets the limit on raytrace recursion for all Renderers.

Photon Map - enables GRRen Photon Map for indirect light and soft shadows (COMING SOON)

Photons - the number of photons to initialize the scene with (COMING SOON)

Shadow Map Shadows - enables shadow map generation for all renderer types.

Soften Shadows - enables blurring of auto shadows - GRRen only

Shade Shadows - enables full shading of surfaces when making auto shaders (including trans maps) 
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Maps Only - enables a special color and trans map only mode for auto shadows - makes brighter 
colored shadows - GRRen only

Ray Object Shadows - Enables Ray Traced shadows for all renderers. With only this switch on, shadows 
are cast by an objects outline, ignoring any transparency mapping. Object Level Transparency is taken 
into account. Much faster than Ray Shade shadowing.

Ray Shade Shadows - Enables the ray traced shadowing through trans mapped and full shading of 
surfaces  (see next page for example).

Renderer - selects the Renderman renderer to use. Supported are: Greenbriar Poly Renderer, Pixar 
Photorealistic Renderman (the number one renderer in the movie industry) from Pixar.com,   and the 
3Delight renderer from 3Delight.com. The 3Delight renderer is free for personal (but not commercial) 
use. 

Realistic Render showing transparency maps on hair and eyelashes

Poser model: Alexis by Angielyn
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File Output Type - Type of output image file. For all renderers - TIFF and OpenEXR (High Dynamic 
Range output). For GRRen only - JPG100 and JPG50, lower memory use formats (number is the jpg 
quality setting).

File Render Style - Level of rendering for file output. 

Rendering Styles:

Realistic includes base color, color map, transparency map, bump map and environment per material

Textured includes base color and color map (faster)

Solid Color is base color

Cartoon has been totally redone with the creation of the GRRen renderer. You can now specify a single 
color per material, or a light and separate shadow color. (Set Specular to 0,0,0 and we will calculate 
the shadow color for you.) Plus outline widths can be specified on the Scene Settings panel. A separate 
width for outside lines (including where a model is in front of itself) and material lines - lines where 
materials meet, a need in cell shaded rendering that is almost impossible to do in most renderers. You 
can also mark materials NOT to be outlined in the Material Info panel.

You can still use transparency and texture and trans maps, if you wish, is Cartoon mode for a great 
variety of cartoon looks.

Cartoon mode even works with the new GRRen raytrace features! Cartoons refacted through lenses 
or reflected in mirrors can still have the outlines drawn on them even though they are just textures on 
another object!

Toon/Real is a new mode supported by GRRen that lets you mix fully shaded realistic models and 
cartoon cell shaded models in the same frame. When this mode is selected, the Toon switch on the 
Objects Info panel determines which objects will be drawn and outlines as cartoons. This was an 
request made early in the development of GRRen for the abiltiy to put cartoon chgaracters on a realistic 
background and set.
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Ray Object Shadows plus Ray Shaded Shadows
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Forces (Dynamic)
Forces are a part of the Dynamic subsystem. They are Gravity and Wind. They affect dynamic Hair 
and Cloth.

Gravity - Sets the gravity value. 1 is normal earth gravity. You can set it lighter or heavier or off.

Wind - Sets the wind in the scene. Wind direction is a vector, the direction the wind is blowing from. 
Wind speed sets the strength and Turbulence sets how random it is. With Turbulence 0, hair will balance 
at a particular angle, it needs some turbulence to make it move around.

Esmeralda
by Thorne
and Sarsa,
Hair by
Kozaburo



82

Greenbriar Studio ToolBox
Hair (Dynamic)
Hair is created on a mesh object. You use the Face tool to select a set of faces, then select Dynamics / 
Add Hair. A guide hair will be created from each vertex. You can create as many as you wish. Hair can 
be all controlled guide hairs or partly interpolated hairs between the guide hairs as you wish. You can 
create multiple goups of hair on one model. This lets you set different lengths and colors on the same 
model. A special hair shader for Renderman is included with ToolBox IV Dynamic.

Our hair can be 'permed' to remember a shape and its position edited with the move, rotate and scale 
tools.

Add Hair

Hair Group - The hair groups that exist for this object, plus 
'new' to be added
New Name - The name you want to give the new group
Diameter - The real world size of each hair - .02 is good if 
you will be making a lot of hair
Hairs per Line - The number of interpolated hairs to add for 
each face, 1 is no interpolated hair
Stiffness - 0 - 1.0 The degree of stiffness. Makes the hair stand 
out from the head, not just lie flat on the head.
Collision Offset - How far to keep the hair from any other 
object. Some space is required since objects are actually 
faceted and if the points lie on the faces of another object the 
hair lines will go inside the other object.
Style - Straight, Wavy, etc (TBD) 
Style Value - (TBD)
Perm Strength - The stiffness of the Perm Springs (See Perm 
in Edit Hair)
Hair Material - The material to apply to the hair (See Hair 
Shader for how to set up a material for hair)
Length - The total length of the hair from the scalp.
Segments - How many sections to break the length into
Offset - A value used to set the hair root - the hair root will go 
this far inside the scalp face and the first bendable joint will 
be this far above the face. This makes a non moveable extra 
section so the hair always goes through the scalp and doesn't 
start bending until just above the scalp.

Edit Hair
Once hair is created, it can be edited and controlled in various 
ways. this is done form the Dynamics / Edit Hair panel.
Hair Group Settings - These only apply to the currently 
selected hair group
Hairs - The number of hairs in the current group
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New Name - The new name you want to give the group
Diameter - The real world size of each hair - .02 is good if 
you will be making a lot of hair
Hairs per Line - The number of interpolated hairs to add for 
each face, 1 is no interpolated hair
Stiffness - 0 - 1.0 The degree of stiffness. Makes the hair stand 
out from the head, not just lie flat on the head.
Collision Offset - How far to keep the hair from any other 
object. Some space is required since objects are actually 
faceted and if the points lie on the faces of another object the 
hair lines will go inside the other object.
Style - Straight, Wavy, etc (TBD) 
Style Value - (TBD)
Perm Strength - The stiffness of the Perm Springs (See  
Perm below)
Hair Material - The material to apply to the hair (See Hair 
Shader for how to set up a material for hair)

Object Settings - These apply to all hair groups of the current 
object
Max Stretch - The maximum percent of the original length 
that each hair can stretch. 0 is off. Used to limit how much 
the hair will stretch. Can be less then 1. Keeps the hair from 
getting longer in strong wind!

Global Settings
These settings are for all dynamics in the system, all cloth and 
hair objects. They are here for convenient access.
Show Interpolated Hair - Turns on display on the interpolated 
hairs in the OpenGL work views. (Note - This swicth has NO 
effect on rendering. If Hairs per line is greater than one, the 
interpolated hairs will ALWAYS be rendered.)
Enable Hair - Turns dynamic hair on. So you can turn it off 
to move objects etc without disturbing the hair position.
Collision Faster - Runs collision with less collision detection 
steps to improve working speed. Should be off to render.
Collision Inside - Tells the Collision detection system to 
check for points way inside models, once that have penetrated 
away from the mesh. Very accurate, but VERY slow. Use 
only if needed.
Frame Steps - Sets the number of steps to make in between 
each frame. A fast moving model will require many steps per 
frame to keep a fast moving figure from pushing all the way 
through the hair in one step. More needed with Cloth than 
Hair. You will see each one on the screen, but only the full 
frame gets rendered. It lets the hair collide and keep up with 
fast moving objects.
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Perm and Memory Functions - You can place the hair in a desired position, by using the Drape function, 
moving hair with the editing tools, etc and then use the Perm function to remember this setting. This 
is not rigid, but adds an additional force to pull the hair back to the current styling. So the hair will 
bounce around, but settle back to this location. Note - It will still sag some with the effect of gravity, 
so you need to allow for that.
There are several ways to make a perm:
Group Perm - This sets a perm on all points of all hairs in the current group
All Perm - This sets a perm on all points of all hairs in all groups
Selection Perm - This sets a perm on all points of all hairs that have at least one point currently 
selected
Points Perm - This sets a perm only on those points currently selected
Rem Grp Perm - This removes the perm from all points of all hairs in the current group
Rem All Perm - This removes a perm from all points of all hairs in all groups
Memory lets you remember a position for the hair. Since hair is dynamic, it can take a while to settle 
and balance against gravity. Memory lets you remember a position so you can go right back to it without 
having to Drape, etc the hair. Memory is independent of Perm.
Memory Set - Save the current position of all hairs
Memory Apply - Set the current position of all hairs to the saved position

Reset Group - Resets the current group to its starting position (sticking straight out)
Reset All - Resets all groups to their starting position (sticking straight out)
Delete Group - Deletes the current group
Drape Group - Steps 10 times through the hair process for the current group. Allows it to balance with 
applied forces (like gravity). Used to settle the hair into position.
Drape All - Steps 10 times through the hair process for all groups. 

Collision Options - The Dynamics menu allows you to turn off all Dynamics, disabling cloth and hair. 
Collision options in the menu are Collisions, which turns on collisions to other objects, Self Collide 
which makes Hair collide with the model it is attached to and Cloth collide with itself so it won't pass 
through itself and Floor, which is a special collide function with Y = 0. So you don't have to make and 
test against a special ground object.

Hair Shader- Hair uses a special Renderman shader for rendering. Hair is only lines in ToolBox, but 
Renderman has special built in functions to turn that into visible tubes of the diameter you specify at 
render time. It is very fast and includes hair to hair shading. Each hair is converted to a curve.
You make a normal material to use with hair, but it is read a little different. All texture images are 
ignored. Only four values are used - Diffuse color is the color of the hair root, Ambient color is the 
color of the hair tip. The hair will be shaded along its length between these two colors, they can be the 
same or different. Specular color and shininess are used as they are normally.
You can make as many materials for hair as you like. Each hair group of each object can use a different 
one, if you like.

Editing Hair Placement - Hair now has its own edit mode button, the button with the three red squiggly 
lines. You must have an object selected that has hair to use this mode. Hair mode is similar to point 
mode. When you use it to select part of the hair, you will see the points in the hair highlight. You can 
then use the Move tool to move them, the Rotate tool to rotate the selection around its center (usually 
then using the move tool to realign the section) and the Scale tool. The Scale tool is special for hair. 



85

Greenbriar Studio ToolBox
Since hair is really one dimensional, the scale tool only works one way. What it does is to lengthen or 
shorten all the sections of any hair that has one or more points selected. The purpose? Hair cuts! Since 
the hair is initially all the same length, it will fall in ever longer rows at the bottom. This tools lets you 
select the lowest set of hair points and then scale them back up even with the shorter hair (or vice versa). 
Go slow with this tool and use drape in between to see where the new hair length will settle!

Noa by Thorne with Dynamic Hair
The hair is two hair groups, the bangs and the rest. 22,000 hairs rendered.
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Cloth (Dynamic)
Cloth can be created on any part of any mesh. But it works best on a mesh that is a plain quad grid. 
To make an object cloth, you first select the mesh and select all the points with the Point (or face or 
Edge) select tool, then use Dynamics / Make Cloth. Now the whole object is cloth. If you want part 
of the object to be NOT cloth, to stay fixed, you then select that part with the select tool and then use 
Dynamics / Fixed Points. These points are now non dynamic. They will continue to move with bones, 
morphs, etc.
You can use the Select Faces tool which lets you select by part or surface to select the part you need.
Make cloth uses the Build and Object settings in Edit Cloth to make the cloth.

Edit Cloth
Points - The number of points in the cloth system
Stretchiness - How stretchy the cloth is. A reasonable Max 
is 100, less is more stretchy.
Stiffness - Is how stiff, or how slow the cloth moves. It is 
also medium viscosity, so slows down movement
Mass - The weight of each point, normally 1, adjust slowly. 
Over 1 can make the cloth fly apart.
Y Spring Adjust - Since this is designed to work with existing 
models, if you make all springs the same strength, the model 
will sag in the Y direction due to gravity. This scales the 
edge springs shorter in the Y direction to balance the effect 
of gravity. The more points in a vertical line, the smaller this 
number will need to be. Use drape to see where the cloth will 
hang and adjust accordingly. This is a major feature that lets 
you use existing models.
Rebuild Cloth - Resets the cloth to the current Build and 
Object Settings. Can take a while!
Collision Offset - How far to keep the cloth from any other 
object. Some space is required since objects are actually 
faceted and if the points lie on the faces of another object the 
surface of the cloth will go inside the other object.
Thickness - This sets the cloth thickness. It is used to detect 
collisions between parts of the cloth to give an apparent 
thickness. It is also used in collision processing to other 
objects.
Cloth Steps - When cloth impacts an object, like a leg moving 
a skirt, it can take a couple of cycles for the cloth to fully 
move. this settings is how many passes on the cloth are done 
for each frame or sub frame.
Spring Type - Controls the type of spring set created, the more 
the slower and the better the cloth is defined. Edge - Each edge 
of a face gets a spring. Add Cross makes edge and an extra 
pair of springs on the diagonals of each quad face. This will 
work on all models. Add Horiz adds a set of horizontal springs 
that skip one point. This makes the cloth harder to bend in this 
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direction creating more natural folds. Full (Add Vert) also adds these in the vertical direction. These are 
not as critical since gravity prevents much folding this way, Since these last two spring sets depend on 
the vertical orientation of the model, they work fine on hanging quad meshes, but not well on things 
like spheres which have quads at all angles. For those use only Edge or Add Cross.

World Movement- When checked, makes the cloth respond to the world movement of objects it is 
attached to. But fast movements will make the cloth over stretch. But move an object over and the cloth 
will correctly sway back and forth. But you will need this off for a fast walking figure. You need the 
cloth to just follow the walking legs, not drag way behind the model.
Reset- Sets the cloth back to its initial position
Drape - Runs the cloth process 10 times without changing frame. Used to settle the cloth into 
position.
Memory Set - Saves the current position of the cloth. Very Handy! Once you get the cloth settled to 
its starting point, use this to save it so you can go right back to this point without having to wait for 
the cloth to settle.
Memory Apply - Sets the cloth back to its memory saved position

Global Settings
These settings are for all dynamics in the system, all cloth and hair objects. They are here for convenient 
access.

Enable Cloth - Turns dynamic cloth on. So you can turn it off to move objects, etc without disturbing 
the cloth position.
Collision Faster - Runs collision with one iteration on the cloth process instead of the number of Cloth 
Steps
Collision Inside - Tells the Collision detection system to check for points way inside models, ones that 
have penetrated away from the mesh. Very accurate, but VERY slow. Use only if needed.
Frame Steps - Sets the number of steps to make in between each frame. A fast moving model will 
require many steps per frame to keep a fast moving figure from pushing all the way through a piece 
of clothin one step. Some animations work with only 1, some I've had to use 10. You will see each 
one on the screen, but only the full frame gets rendered. It lets the cloth collide and keep up with fast 
moving objects.

Collision Options - The Dynamics menu allows you to turn off all Dynamics, disabling cloth and hair. 
Collision options in the menu are Collisions, which turns on collisions to other objects, Self Collide 
which makes Hair collide with the model it is attached to and Cloth collide with itself so it won't pass 
through itself and Floor, which is a special collide function with Y = 0. So you don't have to make and 
test against a special ground object.
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Noa by Thorne with Dynamic Hair and a Sweet Pea dress with dynamic skirt
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Particles (Dynamic)
The ToolBox particle system, with GRRen, 
Greenbriar Poly Renderer, offers one of the 
most flexible particle systems available. 
Any section of any mesh object can be a 
particle generator, so you can use meshes 
to create particle emitters of any size, shape 
and orientation.

Our particle system allows random variation 
of many variables for more relistic effects. 
As well as starting and ending colors, two 
other color change points are available, their 
location defined by the user.

Two options only available with GRRen 
are - spherical shaded particles, as opposed 
to the usual flat shaded circles and the 
unique ability to texture, trans and bump 
map particles. Most particle systems are 
designed to be sub pixel sized which is great 
for creating things like smoke and fire. We 
allow particles to be of any size, so it is easy 
to quickly create things like bubbles, using 
spherical particles and particle with shapes 
like snowflakes with trans mapping. (See 
examples in the GRRen section.)

Particles are a simple system that can be 
used for an incredible range of effects. In 
OpenGL, they appear as variable sized 
points (squares).

Creating a Particle Emitter
First create a mesh object of any type. A mesh 
object must be selected to use the Particle 
System panel. Enter Face select mode and 
select one of more faces of the mesh. They 
do not have to be adjacent. You must be in 
face mode to create an emitter.

There are only two fields that must be set 
before creation - Max Particles and Emitters 
per Face. Max Particles is the largest number 
of particles that can exist at one time from 
this mesh object. It can be any size, but more 
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than you need wastes memory. 
Particles are automatically generated form all the vertices of the selected faces. You can optionally add 
more emitters by setting Emitters per Face greater than zero. This number is the number of randomly 
placed extra emitters that will be created on EACH selected face.

With these two fields set, click Apply to set the values you just entered and then click Create and the 
Particle framework is created. If yo need to change the emitter setup, you just have to have an object 
with faces selected and you can hit Create again. You will get an error if no faces are selected.

You can change any other parameter at any time, then hit Apply. New particles created will use the new 
settings. You don't need to wipe out existing particles to make changes. So experimenting is very fast. 
Variances are optional. If zero, all particles will have the base value.

Max Particles
Maximum number of particles allowed fomr this mesh objest's emitters.

New Per Frame
On each new frame, this many new particles are created, rendomly assigned to your list of emitters.

New Var
The variance of new particles per frame. The number of particles created on each new frame will be 
between New Per Frame minus New Var and New Per Frame plus New Var.

Emitters Per Face
Extra emitters added to each face in addition to the vertices. All emitters start the particles in the direction 
of the points normal. Extra emitters have directions interpolated from the faces' points' normals.

Direction Var
Variance in all three axis in object coordinates.

Initial Velocity
Initial Speed of each particle.

Velocity Var
Speed Variance.

Size and Size Variance
Controls the size of each particle in world units. With this system, particles can be any size.

Velocity Damping
Set this to less than 1 (try .9 to start) so the initial velocity will be bled off. This will never cause the 
velocity to reverse. This is useful for explosions where you want them to start fast and then slow down 
as they expand, or even stop.

Gravity Factor
Allows the particles to be affected by the gravity settings. One is fully on. Can be grater than one or 
negative to make things fall up! (Like smoke.)
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Wind Factor
Allows the particles to be affected by the wind settings. One is fully on. Can be grater than one or 
negative .

Life and Life Variance
How long the particles live before they 'die' and vanish. In Frames.

Start Frame
Optional Fame to begin generating particles.

End Frame 
Optional Frame to stop generating particles. Existing particles at End Frame will continue until they 
die. Start and end lets you schedule a single burst of particles, for explosions, etc.

Repeating
Repeat on and off based on Start and End Frame. Off is Start Frames number of Frames, on is End 
Frames minus Start Frames number of frames.

Spherical
Enables spherical partical shading (if Light Emitting is off). GRRen only.

Light Emitting
Glowing particles. They will appear the color you set in thsi panel. They will not be shaded by lights 
hitting them. Makes flat colored circles for explosions, fires and glowing objects.

Material
Optional material. This is used if you want to apply texture or trans or bump mapping to particles. Use 
small maps as all texture filtering is not available with particles since they are only actually a single point. 
Color and trans strength from the material is ignored as they are set by the particle color controls.

Enable Particles
Turns the entire particle system on and off while working on the scene.

Extra Force
An extra force that you can use to modify particle movement. Sets both direction and speed (by lenth 
of vector) . Value here is added to each particle each frame.

Colors
There are four colors you can set, with variances for each. The A filed if each color sets the transparency 
of the particle. So these can vary from particle to particle as well as through the life of the particle.

Start Color
The initial color of the particle.

End Color
The final color of the particle.
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Color1
If Use Color 1 is checked, particle color will shade from Start to Color1 then to End color. Color 1 
Percent sets the percentage of the life of particle that will be at Color1.

Color2
If Use Color 2 is checked in addition to Use Color 1, particle color will shade from Start to Color1 
then to Color2 then to End color. Color 2 Percent sets the percentage of the life of particle that will be 
at Color2. If Use Color2 is checked, but Use Color1 is not, Use Color2 has no effect.

Create
Create data stores for particles and create emitter set.

Apply
Save all current values

Clear
Remove current particles

Close
Close panel
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Real Time Animation (Pro / Dynamic)
Several features have been added to ToolBox with the goal of being able to work with animations in 
real time. Why? To match a sound track, to be able to lip sync to a voice track and match movements 
to a music track. To do this, most systems use lower res stand in models that can be manipulated real 
time, as the rendering models are usually too slow. ToolBox was created originally to be able to set up 
and render animations with sound with hi res models. If this is your goal, whether for a game cut scene 
or a stand alone animation, here is a work flow that you can use.

Create the models you wish to use for rendering. If the models are hi res and your initial animation will 
not play back real time (using the real time test switch in the Animation Info panel), you will need to 
create lower res stand ins.

To make the lower res models, first decide how much you need to convert. Do you need lo res clothes? 
Or is all the animation just on the main figure? If you are lip syncing, do you need the hair for the real 
time work? You can convert everything, but you will usually not need to.

Once you know what you need to convert, make each of those models into a Progressive mesh model and 
use Prog Mesh to Obj to make a model at any resolution you want. (Note - models must be triangulated 
if they contain quads before making them a Progressive mesh, so always save your original model 
first!) From a 143K triangle model, I make about a 10K version for animating. Except for a few normal 
glitches, it is almost the same model. Morphs and bones are preserved in this new model. (Note - if it 
is a Poser rigged model, you will need to make the new one a normal weight mapped model, the Poser 
system will distort the greatly reduced model too much.)
Any animation you had already on the original model is also on this low res copy.

You can again test for real time playback of your model. When you have models that will run in real 
time, you can do any animation editing you wish and this can be against an imported soundtrack.

You can make test renders and animation using the lo res models, but eventually you need to transfer 
the final animation back to the hi res models. You use the command Modify / Copy All Animation to 
move the full animation set from the low res back to the high res model.

And so you don't have to remove all these models from the scene (I have the lo res and high res 
superimposed), we added a new type of invisibility. When you make an object Invisible, you can 
normally still see the bones, the mesh is just not drawn. This lets you edit the skeleton. But it also means 
all the backend work of manipulating that model is still going on, slowing down the scene. Now there 
is a switch in Scene Settings, Invisible Bones. When on, invisible objects are completely invisible and 
they are not processed at all. Speed wise it is the same as if they were deleted. So after making your 
low res models, you just make the hi res ones invisible and the scene speeds up. Copy the animation 
back and then make the low res models invisible to render in hi res with sound.

ToolBox creates a custom QuickTime file (and supplies a QuickTime plugin to go with it) that gives you 
a file that will open with all the rendered frames and the soundtrack in QuickTime. Using QuickTime 
is the most common method to get frame based animations into a format that video editors can handle. 
For example, Final Cut Express/Pro does not read individual frames.
Have fun!
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Game Level Construction (Game / Pro)
This section covers the tools and techniques built into ToolBox to aid you in making levels for new 
games or mods for your favorite games.

ToolBox contains both tools to build and texture geometry and systems to help you preview your level 
in ToolBox.

Building Levels Overview

To build a game level in ToolBox there are several special tools to make level building fast and easy. 
the basic principles behind teh ToolBox level tool set is to automate the repetitive tasks as much as 
possible so you can spend your time making doing the special work.

First you can build large sections with prefabs, which supplies basic rooms, hallways and wall sections. 
And the plan tool lets you lay out a 2D Plan object of any complexity with doors and windows that 
will geneate an entire level or story of a building. You can make multi-story builds by laying out each 
floor plan.

And we have some special tools for common repetitive tasks. A stair generator, which will automatically 
generate straight and curved stairs for you. And a cloumn generator which will create columns of many 
shapes and variable surfaces, plus build them in single rows or n row arrays for you.

All of the generator tools use the same basic process. You enter the parameters (or choose the Plan you 
have created) and click on Show. The geometry is fully created and you can move arond it and look 
at it and see if it is exactly what you want. If not, you cna make changes and then hit Show again. The 
old geometry disappears and a new version appears. When you have what you want, hit Apply. Or hit 
Cancel and it goes away. So twiddle the dials until you get what you want and then keep it.

You can, of course, build custom sections with the normal mesh tools.

Texturing and Lights

Next set your textures and lights. 

One very special feature of ToolBox is that unlike other 3D systems, it has multiple texture mapping 
systems built in. In addition to normal UV mapping, used for game models and Poser models, Tool-
Box has Quake style texture mapping built in which is used by many game engines for texturing level 
geometry, so you can adjust and set your textures in ToolBox and have them load the same into your 
favorite game engine. Quake style mapping is a special type of mapping designed to work with tileable 
textures and is based in the physical size of the textures and where an object is in world space. This 
allows seamless texturing from one object to another and across different sized objects that share the 
same texture, unlike regular UV mapping that starts each texture again on each object and stretches it 
to fit the object.

Some game systems do use regular UV mapping. So there is a switch in the Scene Settings panel that 
selects which texture method to use as a default for generated geometry. You can always change this 
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setting for an object in the Object Info panel.

Preview

We also try to help you preview your level before sending to your game engine. You can use the SkyBox 
to set up a background for your level if it is outdoors.See www.planethalflife.com/crinity to see some 
great examples. Also you can add a terrain if it is appropriate for you rengine. See engine listings for 
what we can export to each engine.

If you have the complete version of ToolBox, you can also place your static and animated models in 
your scene to be exported.

And once you have everything set up we also have a built in keyboard based walk through mode (de-
scribed under Scene Settings) that lets you walk around and check your level. I fact, the walk through 
is not a special preview only type mode, but a working camera mode, all editing tools can be used in 
this mode, so you can walk around and make corrections to your model as you go.

Export

Export to and import from different game systems is built into ToolBox. New systems will be added 
as fast as possible. ToolBox can import WAD2 and WAD3 format texturefile, breaking them apart into 
tif files in a directory you define so you can load and use them in ToolBox. ToolBox can also export 
WAD2 and WAD3 files of all the textures (and also make a texture of any colored surfaces you use). 
ToolBox has built in an adaptive color mapping system so it can calculate the best 256 colors to repre-
sent any full color texture for export in the palettized WAD3 format. Both WAD2, WAD3 and where 
applicable game model maps are generated with mipmapps. Map output is also available. Plus game 
specific formats like wmp for Conitec 3DGS A6 system.

Poser Model: Ziza by Thorne, Long Silky Hair by Quarker
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Generator - Steps (Game / Pro)
This geometry generator, found under the Create menu, is designed to make stair creation easy. But it 
can also be used anytime you want to duplicate an object with a transform between each copy. It works 
by duplicating the currently selected object. So it can make a row of statues, a row of objects to make 
a set of railing supports, etc.

There are two modes for this tool, Normal and Auto Calculate. In normal mode, you put the transform 
(position change, rotation change and scale change) that you want to use between each step. This 
change is added cumulatively to each object as it is created. In normal mode you can use all fields of 
the transform.

In Auto Calculate mode the transform defines the total you change you want between the start and the 
last step. In Auto Calculate mode you can use Y roation, but not X or Z in addition to the position and 
scale fields. Auto Calculate also reduces the total Y move desired by the Y thickness of the step so the 
top of the top step is flush with the desired height.

Do not run another generator until you close this one with apply or cancel. The generators share a 
common temp geometry list.

Position, Rotation and Scale
These fields hold the desired per step or total transformation.

Auto Calculate
When checked, the transform is the total of all steps and the
transform for each step is calculated for you. And if you set 
Number of Steps to zero, it will calculate the number of steps
for you.

Auto Parent
Create all steps already parented to the base step, to make moving
the new set of stairs easier.

Number of Steps
The number of new steps to add in addition to the selected object.

Show
Clicking on this button causes the geometry to be generated. You
can then change the settings and click on it again. The old
geometry will be deleted and new geometry generated.

Apply
Once you have what you want, click on Apply and the geometry
is added to the scene.

Cancel
On cancel, any generated geometry is deleted and the panel is closed.
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Generator - Columns (Game / Pro)
This geometry generator, found under the create menu, is one of the most complex. It contains three 
sections. The column geometry generator where you specify height, width, number of faces and vertical 
divisions, and array generator that will make copies of the generated column in two directions plus the 
column designer, whih lets you alter the size of each row of points in the model and also set how far 
apart they are. You can also setup the surfaces to be used on different sections of the column so that 
they appear fully multi-textured when generated.

The Grid Creator and Column designer can be used alone or both together.
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The Basic Column Generator

Width 
The diameter of the column

Height 
The totaol height of the entire column

Faces
The number of sides to the column, must be 30 or less for columns to use in game. The minimum is 
3.

Divisions
The number of vertical sections. Each vertical section will become a block in a game output. Use the 
minimum number of divisions possible to minimize game geometry. there is no point in haveing two 
adjacent sectiosn that are the same size and surface.

No End Caps
When this is selected, the column is created as a hollow tube with no ends. You should turn on double 
sided display in Scene Settings to work with hollow objects so you can see the inside. A hollow tube 
can still be exported as a solid column to the game formats. to export as a hollow tube, you need to 
change the object’s tag from Column to byFace (see export formats).

The Grid Creator
To create a row or a multi-row array of columns, use Grid Create

Grid Creator
Turns the array create function on and enables the controls in the Grid Create section of the panel.

Dupes in Dir 1
Number of copies (including the original) to make

Move 1
Specifies how much to move each new column from the last one

Dupes in Dir 2
Number of copies to make of the entire Dir 1 set

Move 2
Specifies how far apart to make the rows.

The total number of columns created is Dupes in Dir 1 times Dupes in Dir 2. If either are zero, you will 
have no output. If you only use one, you can use either, with the other one set to 1. If there is not more 
than 1 specified the Move data is not used and it can be left blank. Note if you make 100 columns with 
the moves set to 0,0,0, all 100 will be sitting on top of each other.

Auto Parent
If you are using Grid Create, you can turn on Auto Parent and all copies will be auto-parented to the 
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first column, to make it easy to move them as a set. Any trnsform applied to Col 1 will also be applied 
to all the children.

The Column Designer

The Column Designer is to let you specify the diameters of each section and the height of each vertical 
section so you can make columns with a minimum of blocks for game use, so you can for example, 
make the top and body section very small with a long trunk, rather than having to use a high large 
number of divisions just so you can have the tops and bottoms of columns thin.

Column Designer also allows you to setup multiple textures to use on diferent sections of the columns 
so your array is generated fully textured. (No point in manually assigning several surfaces each to a 
field of 300 columns!)

Note - When you use the Column Deisgner, you are limited to a max of 8 divisions

Column Designer
The switch activates the column designer and its settings
There are three sections of the Column Designer - widths, heights and surfaces

Width %
The Width%s are always in use when the Column designer is used. Their default value of 1 just gives 
you the standard straight column. There are 9 widths, one for each row of points that makes the max 
of 8 divisions. The use the Widths, set your overal Width at the top of the panel to the largest diameter 
that you need for this column and then set the widths here to the fraction 0 - 1 that you want each row 
of points to be. These are listed from top to bottom of the column. These rows will be pulled in smaller 
as they are generated. You can leave the 1’s in any rows that you are not using.

Use Vert%
The switch enables the vertical size controls. If off the vertical divisions are evenly spaced.

Vert %
This gives the relative height you want for each section. They must sum to 1.0. You need to set 0 in 
any sectins that are not being used. These values control the relative size of each section.  These are 
also listed from top to bottom of the column. You can use these to put small caps on long columns, etc, 
without wasting blocks.

Face Normals
The makes al craeted columns come up with face, as opposed to point, normals turned on. this makes 
the column look faceted, rather than round.

Surfaces
If you leave all the surfaces blank, the columns will be craeted with a single surface that you can then 
assign to a material. Or you can fill in this section and it will use these names. It is here so you can 
apply different textures automatically to different sections of your columns.

Surface Name
The name of this new surface. Important Note -If there exists a scene Material of the same name as te 
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name you use here, the column creatoe will go ahead and connect this texture to that material and the 
column will be already textured upon generation.

Sections Per
This is how many vertical divisions, starting from the top, belong to this surface. If the total of all 
sections listed here is less than the total generated, the last texture listed here will be used o the remaining 
sections. If you are creating tops and bottoms on the columns (solid columns) the surfaces assigned to 
the top and bottom are the surfaces used for the top and bottom vertical sections.

Like all the generators, you can hit the Show button, then make changes and hit Show again until you 
have what you want. The panel will stay open and active until you hit Apply to keep what you see or 
Cancel to discard it.

The sample below shows all of these in action on a simple set of columns. the five surfaces have been 
set to different colors to make them easier to see. Note that two sectins were used in the center section 
of the column so it would swell towards the center rather than be completely straight. The tops and 
bottoms of the columns can, of course, be made much thinner.

You can also create more complicated columns by craeting them in sections, so each can have different 
numbers of sides. ie - Create a set of square bases, on top of this array craete a set of 20 sided fancy 
columns, on top of that create a set or octagonal caps. This also allows you to use a total of more than 
8 blocks per column where needed.
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Generator - Prefabs (Game / Pro)
This tool supplies some basic building sections for game layouts.

More will be added, particularly odd sections like roofs that are difficukt to build with the plan 
system.

Scale
Allows you to pre-sclae up or down all the sections to match your other models. All prefabs are the 
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Generator - Plans (Game / Pro)
A Plan in ToolBox is a special new object type. You create a new empty one with the Plan command 
found under the Create menu.. Once created, you can select and edit it in the Object Info panel.

The basic purpose of a Plan object is to make it easier to generate user defined geometry, primarily 
walls and buildings. The steps are: Create a new plan, setup surfaces with the normal Object Info Edit 
Surfaces, open the Plan Info panel from Object Info and set up your defauts for the line segments that 
will make the geometry and then create the segments, either with the Edit Segments panel or with the 
mouse based Add Segments tool in the Top orthographic view. Note - Plans don’t become mesh objects. 
a separate mesh object is craeted by the Plan Generate command. Your plan is still there.

Step 1 - Create a new Plan Object. Note - some items in the Object Info panel do not apply to Plan 
objects, and while yo can move the plan around with the transform in the Object Info panel or the mouse 
move tool, you can noy change the Y direction, It is a 2D object in the X Z plane.

Plan Info
The Plan Info panel allows you to set info needed 
by the Plan generate command and also defaults 
to use for each line segment, so you do not have 
to repeat this work for all line segments.

Move on Build
This is the x,y and z movement that you want 
applied to the object created from this plan. This 
allows you to make a se of plans laid out side by 
side for a multi-story building that when generated, 
stack correctly into a single structure. Putting plans 
on top of each other is too confusing, this way you 
can spread them out to work on them.

Make Floor
Will create a separate floor mesh object with the 
surfaces defined on this panel and using the thick-
ness as the height. It will start at minus thickness 
and come up to zero.

Make Ceiling
Will create a separate ceiling mesh object with the 
surfaces defined on this panel and using the thick-
ness as the height. It will start at wall height.

Bevel Corners
On by default, this tells the generator that at all 
corners are to be angled to make neat intersections 



103

Greenbriar Studio ToolBox
at joints. This makes the corners the intersection of the inner and outer wall lines which are based on 
the wall thickness. This correctly handles the joining of different wall thicknesses and multiple walls 
meeting at the same point.

Use For All Surfaces
This switch indicates that the first surface, Right Surface, it to be used for all surfaces of each block. 
Whatever material is applied to the surface selected here will be applied to all faces of all blocks.

Surfaces
All segments have a start and end point. With the start point in front of you and the end further away is 
how the surfaces are labeled, right, left, top, bottom, near end and far end. Since segments are normally 
drawn one after the other, all of one side will tend to be inseide an area and the other side will be outside. 
So these are st up to minimize the surface settings that you will have to make on the segmenst them-
selves. The settings here are copied to each new segment whener thay can then be edited as needed.

Wall Height
This is the default height of each wall section. It can be changed for any segment.

Thickness
This is the default thickness of each wall section. It can be changed for any segment.

Edit Segments
This brings up the Plan Segment Info panel, described next.

Apply
Update the selected plan with the data on theis panel.

Close
Exit without updating.
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Plan Segment Info Panel
First we’ll cover the detail, numeric method to create and edit plan segments, then we’ll cover the 
faster mouse short cut method.

Using the Plan Segment Info panel, reached from the Edit Segments button on the Plan Info panel, toy 
can create and edit segments. All fields, except for Position and Tags, will be filled out for you from 
the defaults set in the Plan Info panel, to minimize the amount of work needed to create segments. You 
only need to change it where it is different from the defaults that you set up.
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Position
This is the start and end points of the line segment. If you are creating segments from this panel, when 
you click on New Segment, the end point of the last New Segment will be copied to the start point of 
this one, so you only have to enter the next point in the structure.

Top Left Area
Thi sis where you can select an existing segment to edit.

Surfaces and Use all Surfaces
These are the same as described under the Plan Info panel. The only difference is that these will only 
affect the one current segment. So you can make them all different, if you wish.

Thickness
The thickness of the wall that will be generated from this line segment. Each segment can be different. 
Pre-populated from the plan height field.

Height
The height of the wall section for this segment. Each segment can be different. Pre-populated from the 
plan height field.

Tags
Tags are used to control thigs other that shape and position. the commands that can be used here will 
increase as we develop ToolBox. The first two are: 

Door - If this string is somewhere in the Tag list, an open area is left, topped by a block, for this segment. 
The default values are .8 of height open and the remaining .2 is filled with a block.. The custom com-
mand format is Door: %opening - ex Door: .9  The top block is what’s left, if any. Segments Tagged as 
doors shown up in the user interface coded green. Note- the spelling of Door is important, not DOOR. 
Spaces before and after the : are optional. Doors also accept a flag to breakup the top block and make 
it into an arch. The command is arch2 - arch7, which denotes the number of blocks. basic format is: 
Door : arch5. You can also specify how far the arch should cut into the top block. To use this, you also 
have to specify the % of opening. Ex: Door : arch6 .8 .8
This is a Door with .8 (80%) of the height being the opening and the 6 block arch cuts .8 (80%) of the 
way through the top block. Arches with an even number of blocks have a point in the center, with an 
odd number, a flat in the center.
Ex:
Door
Door:.9
Door : arch3
Door : arch5 .6 .25

Window - If this string is somewhere in the Tag list, a aloding block is made, then an open area is 
left, topped by a block, for this segment. The default values are .25 of height for the bottom block, .5 
of height open and the remaining .25 is filled with a block. The custom command format is Window: 
%bottomblock % space - ex Window: .2 .7  The top block is what’s left, if any. Segments Tagged as 
windows shown up in the user interface coded red. Note- the spelling of Window is important, not 
WINDOW. Spaces before and after the : are optional. Windows also accept a flag to breakup the top 
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block and make it into an arch. The command is the same as for doors, arch2 - arch7, which denotes 
the number of blocks. basic format is: Window : arch5. You can also specify how far the arch should 
cut into the top block. To use this, you also have to specify the % base and % of opening. Ex: Window: 
arch6 .2 .7 .8
This is a Window with .2 (20%) of the height as the under window block .7 (70%) of the height being 
the opening and the 6 block arch cuts .8 (80%) of the way through the top block. Arches with an even 
number of blocks have a point in the center, with an odd number, a flat in the center.
Ex:
Window
Window:.3 .5
Window: arch3
Window: arch5 .2 .6 .25

Remember that commas are the Tag separator and colon separates the Tag name from its parameters. 
If you put multiple generate commands in a Tag list, the one that is checked for first will be the one 
used.

New Segment
Creates a new blank segment. It is not added to the plan until you hit Apply.

Rename
Lets you change the name of the current Segment.

Apply
Update the current segment with the current panel values.
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Creating Segments with the Mouse

The easiest way to create segments is with the mouse. After creating a Plan object with Create/Plan 
you can open the Top view and click on the Add plan segments button. A plan must be selected to use 
this command and it will only add segments in the Top view.

To add a set of segments, just click in the Top view where you want a segment to start. When you do 
you will now have a segment line tracking with the mouse from your start point. Simply click where 
you wish that segment to end and it begins another. You can very quickly add a large run of segments 
this way.

When you have made the last segment for this set, just go click on the normal select arrow to turn off 
the Add Segmenst tool. As long as the plan is selected, you can add as many segments to the same plan 
as you wish. They do not have to connect. The auto connect of the Add Segments tool is just because 
that is a comman use.

TIP1 - make sure you set the defaults you want in the Plan before making segments. Once created, you 
will have to edit the segments one at a time in Plan Segment Info.

TIP2 - Turn on Snap to Grid in Scene settings. While not required, it lets you join segments back to 
themselves. If you use a point that is already in use (like to butt a wall back to an existing joint) it will 
use the pre-existing point and only point will drive all the walls. But this is very hard to do with the 
mouse without Snap to on. You can set it as low as 1, just to help you match points with the mouse.

Editing Segments with the Mouse
Once created, you can use the Point Select Mode to select point(s) that can then be moved with the 
move object tool juat like points of a normal mesh. Bu they will only move in the X Z plane. Rotate 
and Scale tools do not function on segments.

(You will shortly be able to select a segment for editing in the Plan Segments Panel with the mouse, 
right now the mouse can only select the entire plan object.)

Background Picture
Under the Create menu, there is a command to make a background plane to put a picture on for tracing 
to a level Plan. The Background Picture command creates a single polygon the size of the entire grid, 
just below the grid. It also creates a matching material linked to it, so all you have to do is add an im-
age to the texture (color) channel and then you can resize it like any other mesh object and then trace 
over it with the mouse to create you level plan.
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Generating Objects from a Plan

The whole point to a plan is to quickly generate objects. And to let you preview the objects and make 
repeated changes util you get what you want, then accept it.

The Plan Generator panel is very simple. To use it, first make a plan the currently selected object, then 
open the Plan Generator window by selecting Create/Plan to Level.

Click on the show button and your geometry will be created in the scene. You can use the window 
control buttons to look around at it, you can even use the mouse move or Object Info panel transform 
to move it around. It is a real object. It is just still marked as possibly to be deleted.

If you see things you want to change, use the Plan Info panel or the Plan Segments Info panels to make 
changes and then hit Show again. It will show you the new version. if you need to use the mouse to 
move points around, just hit Cancel, closing the Plan Generator. your object is deleted and yu can now 
see the plan segments to edit them.

You can make all the chanegs you wish. When you want to keep it, hit Apply and the object is a normal 
object in the scene. (You can always delete it with cut or delete.)

If you made floors and ceilings you can now parent these to the main mesh so they will move together, 
Floors and Ceilings are created as separate objects so you can easily make them invisible to work on 
the model.
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Game Texture Editing (Game / Pro)
This only applies if you are using Game Level UV mapping for an object.

After you have applied Images via Materials to the surfaces of your objects, you may need or want 
to edit how they lie on the surface. This is accomplished with the Face Textures Options panel found 
under the Edit menu. You must have an object selected and enter Face Seltion mode by clicking on the 
Face select mode icon (yellow square around green triangle button). Then open this panel.

When open it will show you a list of all the faces, plus the item ALL. If you select ALL, all faces of 
the object will be updated when you click on Apply. Since faces do not have names, you need to click 
on a face to see which one it is. The selected face will be highlighted on the object. To see it more 
easily when it is textured, turn on XRay mode in Scene Settings. This allows you to see the selection 
highlight through the object.

(Selection via mouse in the works.)

Once the face is selected, you can change the settings. Hit apply and they will update the UV real time 
so you can see the affect. The Offsetys moves the texture side to side and up and down. The scales 
chanegs the repeat of the texture and rotation the rotation on the face surface (rotation TBD).

Whe you are finished, close the panel and exit Face select mode by clicking on the normal select mode 
arrow.



110

Greenbriar Studio ToolBox
3DGS Importing and Exporting (Game / Pro)
ToolBox I can read and write Conitec 3DGS level (wmp) and terrain (hmp) custom formats. ToolBox II 
can also read and write the animated model (mdl7) bone and vertex version. So we can read and write 
the full set of 3DGS file formats.

These notes are so you will be aware of the changes that are created as you load and save files.

Terrain Files - Terrain files can be read back and forth with no effect on the files. Only the ToolBox 
fog setting (which can not be exported) is lost when you export the hmp format.

Model Files - Mdl7 files make a few changes to your model. All 4 sided polygons are triangulated, 
terminal bones lose their end points and each image tied to a surface becomes an alternate texture. 
ToolBox II has tools to let you merge multiple textures and uv sets into the single set that the mdl7 
format can handle. When you reload a model, it will, of course, now be all triangles, the first skin in the 
model will be loaded as the texture, the others will be loaded as images, so you can place them on the 
model by changing the image that the surface material is using. To export it back out with all textures, 
you’ll have to define a one poly surface for each image and assign the image to it. Bones will come 
back in with the ends of the terminal bones calculated from their parent bone (terminal bones don’t 
have end points in the mdl7 format). It’s not a problem, the bones will work the same and they won’t 
change after the first load back.

Level Files are a little different. While repeated round trips of terrain and model files have very little 
impact, the same is not true for level files. Levels are partially built using the Plan generator, column 
and other geometry generators. These tools use parts to mark sections that can be easily exported, to 
make geometry export easier. Also there are different tags that you can use to specify how each object 
is broken up for export. All Tags are lost when you export to wmp format. When you export to wmp 
format, geometry is also broken up into bsp legal blocks. One object in ToolBox can become many 
blocks in the wmp file. When reloaded, they will come back in as this large number of blocks, making 
them much more difficult to work with, re-texture, etc. So while I wanted to be able to import wmp 
files, the real reason is so you can pull in other components that are in wmp format to add to your levels. 
It is better to work in ToolBox and then export to WED via wmp rather than a lot of round trips back 
and forth. But you can do it!

NefToon Gal by Neftis Cayenne by Thorne and Sarsa
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Edit Tools
Edit Button overview
In order from left to right:

Rotate Screen - applies to main perspective view only
Move screen - works on all view, on main perspective screen only moves center up and down.
Scale screen - works on all view

Select Object mode - normal select mode, turns off Face Edit and Point Edit and Segment Create 
modes
Face Select Mode - enters Face Edit Mode
Edge Select Mode - enters Edge Edit Mode
Point Select Mode - enters Point edit mode
Bone Select Mode (Poser / Pro) - enters Bone edit mode

Move -Moves objects in Normal select mode, moves selection in  All Edit Modes
Rotate - Rotates objects in Normal select mode, rotates selection in  All Edit Modes
Scale - Scales object in Normal select mode, stretches selection in All Edit Modes

Create Segment Mode (Game / Pro) - enables drawing segments with the mouse. Top view only
Add Point Mode - enables adding points to the current mesh with mouse clicks. Works in all 6 
orthographic windows. Add Point works with the Scene Snap To setting. Although selected points are 
visible in any display mode, wireframe mode draws unselected points as individual dots so you can 
easily see new unconnected points. Note - To set the depth where points are created, just select a point 
near where you want the new ones. New points will then be created using the depth of the last selected 
point (first point of a set if you select more than one).

Special Mouse keys
Shift  w/ any Edit Mode adds items to the current selection, or removes them if they are already in the 
selection.
Shift  + Control w/ any Edit Mode adds only the closest item to the current selection, or removes it if 
it is already in the selection.(So you can select only the nearest wall of a building, etc)
Control w/ Face Edit Mode selects only faces that are toward you (ignores back faces)
Control w/ any Edit Mode changes Move to Move Normal so this can be done with the mouse.
Shift  with Move, Rotate and Scale convert the XY orientation of these tools in the Main view to XZ 
so you can affect objects in all three planes in the perspective view.
Shift + Control with Scale makes it scale evenly in all three directions.

Mouse Camera Controls
In addition to the Screen movement buttons for the left mouse, you can always control the camera with 
the right mouse, regardless of what mode you are currently in.
Right Mouse - Rotates main perspective view
Shift Right Mouse - Moves all views, main up and down
Control Right Mouse - Zooms all views
Shift/Control Right Mouse - Moves main view right and left (NEW)
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Hot Keys
The view windows support hot keys (user settable). A pop up editable list of the hot keys can be found 
under the Help menu. At this time you must enter hotkeys as upper case letters.
Move Selection
Located under the Modify menu, this panel lets you enter exact values to move object in Normal mode 
or the selection in any edit mode.
Move Normal
Located under the Modify menu, this panel lets you move Points in the direction of their normal (or 
reverse with negative values). It works in all edit modes. It can be open at the same time as the move 
panel.
Stretch Selection
Located under the Modify Menu, this panel stretches the current selection in any Edit mode. It works 
by moving points towards or away from the center of the selected points. So if you select a face and 
a stretch of less than 1, the points will move towards the center, tapering the shape, but staying in the 
same plane of the original face. If will work on any selection set.
Extrude
Located uder the Modify menu, Extrude only works in Face and Edge Edit and has two modes. In Face 
mode, mode one works if you have only one face selected or check the Separately flag. In this mode, 
each face is disconnected from the mesh and moved out the distance specified along the face’s normal 
and new faces are created to connect it back to its original neighbors. Bevel may be used in this mode 
to specify how much inward (positive) or outward (negative) distance to move the points at the same 
time. Note this is in world units, rather than percent like stretch uses, otherwise it is the same thing. 
Each face is extuded separately in this mode.

The other Face Mode is when you have more than one face selected and you do not check Separately. In 
this mode the whole selection is disconnected, moved the spcified distance, the whole area stretched to 
yield the given Bevel and new faces added along the edge. In this mode each face is not extruded, only 
the whole section and the direction it travels is the average of all the face normals that are moved.

Extrude in Edge mode also works in two modes. With a single edge or Separately checked, each edge 
is extruded along the direction of the other edge at the end points. With multiple edges selected you can 
also select edge group and the average of each edge direction will be used for all. NOTE - this doesnlt 
work for a radial extrude, like around an eye, but works for a tubular extrude, like an arm. It keeps the 
edges together so the variations in edge direction doesn't make them collide. It can also be used with  
a bevel value. Edge group flag only affects edge extrusion. 
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Create Empty Mesh
Located under the Create menu, this will create a new empty mesh with no points or faces for creating 
mesh objects from scratch. Use the Add Point and Add Face commands to build up a custom mesh.The 
mesh has a default Part and Surface.Create Empty Poser Mesh does the same thing, but indicates that 
it will use a Poser style skeleton.

Add Face
Found under the Modify menu, this tool craetes a face based on a selection of three or four points. 
Select the points in clockwise order, so the resulting face will face towards you.

Flip Face
Found under the Modify menu, flip face reverses the point order of the selected faces so the direction 
the face points will reverse.

Delete Faces
Also under the Modify menu, this command deletes selected faces to allow you to make hollow objects. 
Points are not affected.

Point Info
The Point Info panel is to allow you to set point coordinates to exact values. Select the point you wish 
to edit and the current normal and position is displayed. The total number of points in the currently 
selected mesh is also displayed.

Position
These fields can be changes to move any point to exact coordinates.

Apply
Updates the currently selected point.

Edge Info
The Edge Info panel is to allow you to see what 
points and edges are being referenced by each 
face. It is mostly used to figure out problems with 
tangles meshes.
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Weld
Located under the Modify menu, this tool works by merging multiple points. It can be used in Point, 
Edge or Face modes. In point mode, all selected points are merged into a single point. In edge mode, 
the ends on the selected edges are matched up based on which ends are closest and the points of each 
end are merged. In face mode the face corners are matched up by distance and each corner’s points are 
merged. Face mode has the additional restriction that the faces have to all have the same number of 
points. Only one face remains, the extras are deleted. Multiple points, edges or faces can be selected 
for this tool.

Skin
Located under the Modify menu, this tool works by creating a new face between two edges or two 
faces. A single face is created between two edges. A face for each side of the faces is created in face 
moce. In face mode the two faces must have the same number of points. Only two edges or faces can 
be selected for this tool.

Compact Mesh/Plan
Located under the Modify menu, this tool compacts a Mesh or Plan object to remove an deleted faces 
and unused points. Edit operations can leave unused points and deleted faces are just marked as number 
of points equals zero. Since objects with morphs and objects to export to Poser are vertex order sensitive, 
this operation, which rearranges the vertex list and face list is never performed automatically by edit 
tools.
NOTE- Do not use this on objects that already have deformers - bones or morphs. Make a copy. After 
running this tool. morphs will no longer be valid since they are vertex order dependent.

Merge Mesh
Located under the Modify menu, this tool lets you add another object into the current mesh. The original 
added mesh is deleted. To use this tool, select the object you wish to start with then run the tool. In the 
popup select the object you want to add and hit Add. You can add multiple objects, one at a time.
NOTE- This tool zeros both objects before merging to make sure their transforms are the same. So the 
resulting object will have everything in the world positions that you have set up and a transform zeroed. 
This tool now preserves all surfaces and even morphs in the object being merged in.

Create New Surface
Located under the Create menu, this will create a new surface from the currently selected set of 
faces.

Create New Part
Located under the Create menu, this will create a new part from the currently selected set of faces.

Object From Selection
Located under the Create menu, this will create a new mesh object from the currently selected set of 
faces.

Create Game UVs (Game / Pro)
Located under the Modify menu, this will set or reset the uv vectors and other data needed to use the 
game mapping systm. This utility is supplied so you cen set up inported meshes for the game mapping 
style.



115

Greenbriar Studio ToolBox
Reset Normals
Located under the Modify menu,this tool resets both the points used to calculate the normals and resets 
all face and point normals. Will repair the normals on imported or sratch built models.

Triangulate
Located under the Modify menu,this tool divides all quads in a mesh into two triangles so that the model 
is now compased of only triangles.

Subdivide
Located under the Modify menu,this tool works with the currect selection of faces. It adds a point in the 
center of each face and turns each face into four new faces for quads or three new faces for triangles. 
The selction can be mixed tris and quads. UVs are preserved by subdivide, morphs are not.

Use Subdivide to add extra geometry in areas where you need more detail in regular meshes or meshes 
to be used for subdivision surface control.

Magnet Tool
Located under the Modify Menu, the Magnet tool is designed to allow you to easily stretch a mesh. 
It’s main goal it to make morphs, altering a start mesh by pulling or pushing the mesh. There are two 
modes of operation.

For the sphere mode there is a center (shows up as a blue cross). This center can be moved - to position 
the tool and to alter the mesh. It can also be rotated to position the tool to the model (this does NOT 
currently move the mesh, just align the tool).The center position and rotation is shown in the panel 
and can be changed by direct entry (and hitting apply) or by using the move and rotate mouse controls, 
same as for moving any other object. The center is the only item that can be moved.

The spherical Magnet Tool has two spheres - inner green and outer red (colors the same as the poser 
joint spheres, on purpose) and they work the same as the Poser spheres - anything inside the green 
sphere will be moved 100% (even if it is outside the red) - anything outside the red AND green is not 
moved - and points that lie between the red and green spheres are moved proportionally to their relative 
placement between the two spheres.

Freeze Deformed Mesh
Located under the Modify Menu, this tool allows you to 
reshape a mesh with morphs and bone (body part) scaling 
and then apply the results to the mesh. the mesh still looks 
the same, but there will no longer be any morphs or scaling 
being applied. Both the mesh and boes are altered. This 
allows you to export to game formats your new morphed 
and sclaed figure, since they don't suppotr these operations. 
And a handy way to make variations on your own meshes! 
(Why I wrote it in the first palce!)
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The two spheres can only be scaled - but this lets you make them into two very different shapes if you 
wish. The red can be partially inside the green, in that case the red has no effect (there is no falloff) in 
that area. So you can set them up to have more falloff in some directions than in others. It is not just 
two simple spheres one inside the other. Once you set the tool shape, the ability to rotate the center lets 
you move and align the tool without changing the relationship of the two spheres. (That’s why you can 
rotate the center.)

To Use -
-Open the Magnet Tool Panel. Select the blue center cross and use the mouse to move it roughly where 
you want it (or enter the position you want).
-Reshape the spheres (you must do this by selecting and scaling them).
-Position the tool exactly where you want it.
-Make sure the proper object is selected that you want to alter.
-Set the Active checkbox and hit Apply.
-Select the blue cross and move, with mouse or numeric entry, the mesh.
(Numeric entry is there so this part can be done very exactly if you need it.)
To disconnect tool, uncheck active and hit apply - even if it says you don’t have an object selected, it 
will clear the tool.

Note - once the Tool Panel is open, you can use it on multiple objects. The object is actually set for 
the tool every time you hit apply with Active checked. It uses the currently selected object. So you can 
shape the tool and use it on different objects just by selecting the object you want and hitting Apply 
with active checked.

Important NOTE - make sure that if your model has bones, you go into Bone info and zero the pose. 
This tool works on base points, not their position after applying bones (it has to work that way since 
changing bone affected points has no effect - they are calculated from base points by applying the bone 
affect). If you have a pose on the model, you might  not be selecting the points that you think you are. 
The same is true for morphs.

It does work correctly on models with both bones and morph. It will correctly redraw and update these 
models.

Selection Mode
In the Create Menu there is a flag that turns Select Front Only on and off. When off, all points, edges or 
faces will be selected inside the selection rectangle. When on, only those items that are facing towards 
you are selected. This makes selecting the items only on the near side of an organic mesh for editing 
easy. This has a hot key setting.

Split
Found in the Modify menu, the split command is similar to a knife, in that it adds extra geometry to a 
mesh, but rather than make a straight cut, it splits the selected set of faces, so they can follow any path. 
Faces must connect to no more than two other faces (no ‘T’s). Each face not on an end will have the 
common edges bisected. The two end faces will have a new edge from the common face to the closest 
of the two opposing points, if a quad, or the remaining point if a triangle.
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BackGround Pictures
Each Ortho view can have a different background picture that shows in just that view. There is still the 
Background object that shows in all views and can be moved and rotated like any other object. But it 
is more convenient to have distant image for model building that doesn't clutter the workspace.

You can load any image as a background pic that has been loaded into the Image Info window. You can 
also then move the pic as neceassary and scale it from this panel. 

NOTE - x and y adjust will follow the direction of the axis bars you see in the window at 0,0.
These are drawn with 100% Ambient set, so you can brighten them by increasing the Ambient in Scene 
Settings. 

Mirror
The mirror tool, found under the Modify Menu, allows you to 
replicate in reverse, including face order and normals, any mesh 
geometry. It will mirror in the X, Y or Z direction. It normally 
creates the extra geometry within the existing mesh object, but it can 
be switched to create the mirror image as a separate object. If you 
transform the object to align with an axis for mirroring, remember 
to Zero the object, as mirroring only uses the point’s local values 
and ignores the transform, since it was designed prinarily to create 
new geometry within a single mesh object. If mot creating a separate 
object, you can auto weld the two halves together. And you can set 
the tolerance for the weld. Do not mirror Boned or Morphed figures! 
Mirror them first.
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Undo
Toolbox has a multilevel Undo feature for editing operations. To keep it simple, fast and reduce memory 
hogging, it only applies to editing operations, operations that can not be easily undone by the user.

Undo levels can be set from zero to one hundred in the Scene Settings panel. The default is ten.
To conserve memory, use the lowest number of Undo levels that you really need to work with. Large 
models eat up memory faster. Don’t have more levels turned on than you normally need to work or 
you’re just filling memory with model copies.

Mesh, Plan and Terrain objects all work with the Undo system. Currently Lights do not.

Functions that support Undo:
All Move, Rotate and Scale of objects or selections with the mouse. (Optional on Scene Settings)
Move Selection Command
Move Normal Selection
Stretch Selection
Rotate Selection
Extrude / Bevel
Mirror
Weld
Skin
Delete Faces
Add Faces
Flip Faces
Create New Surface
Create New Part
Compact Mesh / Plan
Create Vertex Animation
Renumber Vertex Frames
Reset Normals
Create Game UVs
Face Texture Options
Mesh to Morph
Create UVs
Set and delete animation keys
Apply function in Object Info and Bone Info
Cut and Delete - Special note - once deleted, an object can be ‘undeleted’ with Undo, but any earlier 
changes in the undo queue will have been lost.

Functions that do NOT support Undo:
Most functions that create a new object (you can just delete these yourself)
Duplicate
Object from Selection
Morph to Mesh
Other Items under the Create Menu
Any Importer
Merge Mesh - We can not Undo this function at this point, but hope to in the future.
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Importing
Importing occure either through the File /Import functions, or more commonly through the File / Open 
command. 

File / Import
WAD2/WAD3 to Textures (Game / Pro)
This finction imports a Wad2 or Wad3 file by breaking out the textues in the wad files to individual 
images in your Texture directory (specified in the Scene Settings panel). Importing Wad2/Wad3 
handles Wad2 565 16 bit, Wad2 8 bit, no palette (default Quake palette) and Wad3 8 bit with palette 
for each image.

File / Open
Most files are loaded natively through the Open command. Some, such as loading Poses or Anima-
tions may require an object be selected, others create new object.
Imports through Open -
Greenbriar Scene - Complete ToolBox Scene
Greenbriar Object - ToolBox Mesh, Plan or Terrain
Greenbriar Pose - Boned figure Pose
Poser Files - Poser Model and Animation Files (Poser / Pro)
Game Models - md2, mdl7 (vertex and bone animated) (others soon) (Game / Pro)
3DGS Game levels - wmp files (Game / Pro)
Object files (.obj) - Wavefront models (See Scene Settings for special Cinema4D switch)
Height Files (.hgt) - ToolBox saved terrain heights (Game / Pro)
Terrain Files (.hmp) - 3DGS Terrain File (Game / Pro)

Quake Model: Sailor Moon, Vertex Animation running in ToolBox
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Exporting
Scene Export (Game / Pro)
Entire scenes can be exported to several game level formats.

The game export formats all use the same geometry Tags to let you control the export. the different 
map exports and the wmp exports allow you to specify how the geometry is broken up. The Tag system 
is used for this purpose. The ToolBox geometry generators all premark the geometry they create so 
that it is easily exported to the game formats. This is done by Tags and the use of Parts. Multi-block 
generators mark each section that should be exported as a block as a named part. The point of this 
system is to allow the user to control how different objects are exported, so you can mark the special 
items that need a particular export method and still be able to export the scne in one pass, not separate 
passes for each type of object in the scene.

The Tags that control export:

Skip
If you put this label in the Tags field of an object, the object is ignored for exporting.

BSPLegal
If you put this label in the Tags field of an object, the exporters will export all faces as a single object, this 
prevents the engiones from braeking up geometry that you know can be exported as a single block.

ByFace
This Tag means to export each face as a separate block. It is the only way to make most hollow objects. 
Almost any object can be exported with this method. The thickness of the blocks is controlled by the 
Export Face Thickness field in the Scene Settings panel. The blocks are always extruded towards the 
inside (reverse normal direction). The blocks are all beveled so the blocks are flush on botht heinside 
and outside.

Column
The Column Creator marks it’s output objects with this tag and makes each set of column faces into a 
separate part. Since each section is a solid block, the triangulated end caps are ignored and exported 
as a single face.

Prefab and Plan
These Tags are applied by the Prefab generator and the Plan generator. These objects also have each 
block marked as a part for export. You can hand set the parts on customgeometry to control export 
breakup.

Material Export
Materials can be exported to different game and 2D formats.
WAD2 and WAD3 export makes a copy of each texture, at it’s original size (all textures must have both 
dimensions evenly divisible by 8). All color only materials are turned into small textures. JPG export 
makes a jpg file from each texture (including colors). There are no size restrictions for jpg export but 
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check for restrictions for your game engine. All textures will be names the same as the Materialthey 
are derived from.

Object Export
Objects can be exported individually. 
Obj Export creates a Wavefront obj file.It includes points and faces. Mtl files with the same filename 
will be created and read if in the same folder.

MDL7 Export Vertex (Game / Pro) creates a vertex animated mdl7 model file. All textures attached to 
surfaces of the model are exported as alternate textures. Works using either bone or vertex animation. If 
vertex animation frames are available, their names are used else Frame#. Start and End frame exported 
are the current settings in the Animation Info panel.

MDL7 Export Bone (Game / Pro) creates a bone animated mdl7 model file. All textures attached to 
surfaces of the model are exported as alternate textures. Works only using bone animation. If vertex 
animation frames are available, their names are used else Frame#. Start and End frame exported are 
the current settings in the Animation Info panel.

Export Morph as Injection Pose (Poser / Pro) - Poser Injection Poses

Terrain Export (Game / Pro) 
Terrain can be exported as a height file only file. This will allow you to both save a particular terrain 
compactly, plus allows you to move the height set between terrains with different mesh sizes (same 
number of points, but dirrerent speads between points).
Terrain can also be exported to the Conitec 3DGS hmp5 format.

Pose export (Poser / Pro) 
The pose of the current object can be exported to a Greenbriar Pose file. It is reloaded onto the currently 
selected boned mesh object with the normal Open command. Poses are saved by Bone name. Bones 
that are matched will be loaded, unmatched bones will be left alone, so perfect match of skeletons is 
not required to move poses, unlike most systems.

Poser Format Export (Poser / Pro) 
There are five commands to export Poser format files.

Poser Pose (Poser / Pro) 
Exports the current pose of the selected boned figure as a Poser Pose file.

Poser Face (Poser / Pro) 
Exports only the head morphs, eye morphs and eye positions/rotations as a Poser Face file.

Poser Animated Pose (Poser / Pro) 
Exports the pose of the selected boned figure at each frame between Start and End of the Animation 
panel as a Poser animated Pose file.

Object as Poser Prop (Poser / Pro) 
Exports the selected object (boned or not) as an un-boned Poser prop. It goes to the OBJ folder and 
PP2 folder specified in the Poser Settings panel.
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Object as Poser Figure (Poser / Pro) 
Exports the selected boned object as a Poser character figure. It goes to the OBJ folder and CR2 folder 
specified in the Poser Settings panel.

Objects as Poser Figure Set (Poser / Pro) 
Exports the selected boned object, plus all other boned objects Conformed to it, plus all boned or non-
boned objects parented to any of its bones, as a Poser character figure. It goes to the OBJ folder and 
CR2 folder specified in the Poser Settings panel.

Poser Model: Spooky set by Thorne
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Torque Export
Scene Export (Game / Pro)
Entire scenes can be exported directly to Torque game level format. When buildiung your geometry, 
there are severla ToolBox features that you need to use. The first is Game level UVs. this makes textures 
appear in ToolBox the same way they will in Torque. Level geometry does NOT use standard uvs. You 
xan use the texture tools in ToolBox to adjust the size and placement of textures on a face by face basis 
with Modify/Face Texture Options. These translate to Torque.

One of the handiest features is the ability to outpur directly to Torque dif format. To do this, you need 
to put the map2dif application in the same folder as ToolBox. It needs to be named map2dif.exe. The 
old one never worked with our files very well, but the new map2dif_plus works great! Just rename it 
to map2dif. (We are staying with that name since we think that's what it will remain in future releases.) 
To activate this function, you need to activate it by checking Auto DIF Compile on the Scene Settings 
panel. Also check Textures as JPG so the default texture file output is jpg and not tif.

To export, you use File/Export/Scene as Torque Map. And then File/Export/Materials as JPGs to export 
the texture map set. If your textures aren't valid sizes for Torque, go to the Image Info panel, select the 
textures, the size yo want and hit Save at This Size to get a new square version (make a copy first if 
it is already a jpg), This is where you need the texture export to default to jpg, or you will have a nice 
square tif file!

ToolBox also supports all the special blocks for Torque. You make a single block (based on a cube 
is easiest/best) and then in the Tag field put the special block type and info. All unmarked blocks are 
exported as world geometry.

Tag values for Entity blocks:
skip (do not export)
model (do not export)
portal:ambient_light ( 0 or 1)
target
detail
collision
vehicle_collision
mirror_surface:alpha_level
door_elevator:trigger_name
force_field:trigger_name
ai_special_node
trigger
path_node:next_node next_time
path_start:next_node next_time

The special light types are also supported, use the Tag field in Light Info to set the special info. Unmarked 
lights become omni lights.

Light Intensity becomes falloff1 and Light range becomes falloff 2.
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Tag values:
light_omni:alarm_type
light_spot:alarm_type distance1 distance2 target (target is name of another block)
light_strobe:alarm_type spawnflags speed target color2  (enter color as .5/.5/.5 - no spaces)
light_pulse:alarm_type spawnflags speed color2 
light_pulse2:alarm_type spawnflags attack decay color2 sustain1 sustain2
light_flicker:alarm_type spawnflags speed color2 color3 color4 color5
light_runway:alarm_type spawnflags speed target steps pingpong

DTS Export (Pro)
ToolBox also supports Torque DTS export
Features:
 - Large Model export - 50K triangles and up available
 - Morphs that animate in Torque with out new DTS format (user selectable old or new)
 - Multiple textures per Model
 - Discontinuous UV support
 - Multiple animation sequences in DTS
 - Multiple bones controlling each point
 - Animation Flags for Blend and Cyclic
 - Collision Objects
 - BillBoards
 - Entire scene export (multi model) static or animated 
 - Animation by bone or object transform, or objects parented to a non-exporting skeleton
 - DSQ export - regular and morph animated - multiple animation sequences

To export a model as DTS, select the model and then use File/Export/Object/Object as DTS. Also use 
File/Export/Materials as JPGs to export the texture map set. And use File/Export/Animation as DSQ 
to export just a dsq animation file.
There are many settings that affect DTS output.

In Secne Settings:
DTS Morph Version - when checked exports into the new DTS version that allows animated morphs. 
The TGE 1.3 patch is available from us or Garage Games, Our first addition to the Torque system. 
Unchecked you get the standard DTS. Note - Morphed DTS will riun in the game engine, but not in 
Show Tool Pro.

Export DTS Old Morphed - will pick up the net result of static (non animated) morphs on your model 
for standard DTS output.

Animation sequences - See Animation/LOD export. Blend and cyclic flags are set for each sequence 
there also.
If no sequences are defined there either no animation will be exported (if start and end frame are the 
same) or a single animation sequence will be generated named Idle for DTS and named the name you 
give the file for DSQ.
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Collision objects - Any object whose name starts with Collision will be exported as a collision 
object.

Billboards are specified in the  object Tag field. Use Billboard and BillboardZ

You can also animate an entire scene, using normal translate, rotation aniamtion on any number of objects 
and export the whole scene as animated ot non animated DTS. To expor this way use File/Export/Scene 
as DTS. If you use the morphed dts, you can even make the currnet selection object have a morphed 
animation as part of the scene, (Throbbing objects, etc.)

Animation hints - There are three ways to animate models in ToolBox for Torque export (each can be 
with or without morphs).
1- A single deformable mesh attached to a skeleton (mat have multiple surfaces each with a different 
texture.
2- multiple static objects animated by transform
3- static objects parented to a skeleton named NULL so only the resulting moving objects get exported 
(for robots , etc) makes then easier to texture as yo have a separate texture(2) on each parented part.

Note - Body part scaling a la Poser - Torque does not support the Poser type of bone scaling, where you 
can use scaling to reshape the mesh. So we have a utility Modify/Freeze Deformed Mesh that makes 
the RESULT of all morphs and bone scaling into the new default mesh, with NO morphs applied, and 
No bone scaling (bone positions are all reset also). So you can easily use our scaling features to make 
versions of your models and then freeze and export.



126

Greenbriar Studio ToolBox
Ogre Model Export (Pro)
Scene Export
Ogre does not have a specific scene format, but can use several, including Quake compiled bsp levels. 
ToolBox exports several map formats, including Quake and HalfLife taht can be compiled to Quake 
levels. What you need for levels depends on what level type is used with the Ogre core.

Model Export
Ogre does have a specific set of files to support still and animated models. There are three files - mesh 
that holds the actual geometry of a model, skeleton that holds the bones and animations and material 
that hols the texturing info. ToolBox generates all three. Mesh and skeleton are binary, material is a 
text file. ToolBox exports mesh and skeleton as xml files, the recommended method as th binary is 
frequently updated. ToolBox will use the Ogre converter tool automatically, if you wish, so you have 
a one step export.

To export a model to Ogre format, use File/Export/Object/Object as Ogre.

Features:
 - Multi surfaces per model
 - Discontinuous UV support
 - Mutiple bones per vertex (Ogre allows up to 4 per vertex)
 - Multiple animation sequences
 - Auto Convert from xml to binary - one step export

Auto compile - if you put the OgreXMLConverter.exe into the same folder as ToolBox (and make sure 
it can run there), you can turn on auto Ogre compile by checking Auto Ogre Compile in the Scene 
Settings panel.

Animation sequences - See Animation/LOD export. 
If no sequences are defined there either no animation will be exported (if start and end frame are the 
same) or a single animation sequence will be generated named Idle.

Textures - Each surface of the model becomes a separate sub model and material entry. We take care of 
this for you. We also auto triangulate the mesh on export. This does not alter your ToolBox mesh.
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Tutorial: Creating a Building with Plan Objects (Game / 

Pro)
This is a short demonstration of how to use the Plan type objects to create buildings.

The first step is to create a new empty plan object. This is done by selecting Plan under the Create menu. 
If you open Object Info, you will now see a Plan object. Select it and then hit the Edit Plan button. You 

will see the Plan Info panel. You don’t really have to set anything 
here. It is just a shortcut. But if you don’t set some info here, you 
will have to set it for each wall segmnet you create later. Best to 
set it here.

Everything you set here is inherited by each wall section you layout, 
so it makes building the object much faster. I set the wall height 
to 100 (about 10 feet to my models) and 4 units thick. I also made 
sure Bevel corners was checked so all wall sections (segments) 
will meet in a nice finished corner and not just the butted ends of 
the two wall blocks.

I also went ahead and named the surfaces I want to use for the 
segments, so I don’t have to manually construct them later. I named 
them IntWall and ExtWall (the built in materials in the material 
editor) and assigned them to the six sides. Notice I assigned interior 
to Right. Right is the right side of each block as you are looking from 
your start point towards the end point. If you layout the building 
in a clockwise fashion, you will see that the insides of the building 
consists of all right sides. If you draw it counterclockwise, it will 
be the Left side. So texturing the inside different than the outside 
is easy. And this is just the default, whatever I’ll use the most of. 
After I create the sections I can change any of the textures or wall 
size and thickness.

Now that I’ve set my defaults, I need to draw the wall segments. 
The easiest and fastest way is with the mouse. You might want to 
turn on Snap To. I did for this demo.

To draw segments, you first need to be in Top View. The draw 
segments tool only works in this view since a Plan object is a 2D 
object. Make sure the plan object is selected and then select the Top 
view and then click on the Segment tool (the green + surounded 
by three purple lines). Now click where you want to start. After 
the first click you will see a purple line following the mouse. 
Wherever you click will make a segment. To stop, just go  up and 
click on the regular select arrow and the trailing line will go away. 
You can then click on the Segment tool again and start somewhere 
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else. The segments will all be in the same Plan object, they don’t have to connect. Here is my start of 
a structure.
Here I’ve completed my building plan and you can see how it looks in the main perspective window. 
Everything from this point on can be done in the main window, if you wish.

Note- There is a backdrop built in to let you add an image to trace over, so you can load in building plans. 
It is Create/Background Picture. It creates an image area the size of the inner grid area. It automatically 
creates and links itself to a material BackgroundPicture. So just go to the Material Info panel and assign 
an image to it. You can pick the Background Picture in the Object info panel and scale or move or rotate 
it anywhere you want. You can make it vertical to model in front of. It is by default just under the grid 
for using with the segment tool. Make sure textured display is turned on in Scene Settings or all you’ll 
see is the wireframe outline!

Now I can edit my segments, if I 
wish. I bring up the Segments panel 
from the Plan info panel, I can 
actually add segments here, but the 
mouse is much quicker. 

Here you will see the location of 
each segment, its surfaces and 
thickness and height. Any of these 
can be changed. I select a segment , 
either in the panel or with the normal 
Object select tool. The selected 
segment will turn white. 

I want to add some doors and 
windows. For this I use the Tags. 
Door or Window gives me a simple 
flat topped opening. For one door 
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I’ve added the command arch3, a three section arch, for one window arch2. Doors and windows appear as 
green and red respectively on the plan. See the Plan Info section for more door and window options

I can also edit the plan, by changing coordinates in the Segment panel, or by selecting points with the 
Point tool and moving them with the Move tool (Scale and Rotate don’t work on the 2D plan object).

Here is the final edited plan. I save it as a scene and as an object so I could import it into another scene 
later.

Now I’m ready to create it. I select Plan to Level under 
the Create menu and I get a very simple panel, only three 
buttons. Hit show and you will see your structure. Take 
a look at it before hitting apply. If you want to keep  it, 
hit apply or hit cancel to go back to your plan and do 
more editing. We will keep it. Note the clean odd corners 
- what the bevel corners switch is for.

Now we need to texture it. Select the new object in 
Object info and hit Edit Surfaces. You will see only the 
surfaces you defined in the Plan. Now you need to set 
up two materials and point them to two images. Then 
come back to surfaces and select the material you want 
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to use for each surface. The whole structure will be textured.

I used a game texture that is very large, too large for my model. So I need to adjust it. Since the plan 
automatically selects the game uv system I can control the scale of textures on a face by face basis. I 
open the Face Textures Options under modify and leave it set on all. I have to be in face mode to use this 
tool. You can select the faces one at a time, but I want to change them all. After a little experimenting 
I decide I like the size of the bricks at the 1.5 scale in both x and y. So now I have my textures at a 
scale that I like. Notice the texture not breaking at the joints and that it repeats like a game and unlike 
regular uv mapping.

If i decide I don’t like something, I can delete the object, go edit my plan and generate it again. There 
is also a move command built it so you can layout several different plan objects, one for each level, 
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and when you hit show, they will stack on top of each other by supplying the correct offset. Of course, 
these are normal objects, you can manually move them around any way you want. 

Note- The game uvs will change as you move a game mapped object. They are dependent on the location 
of each point in 3D space. This is the trick they use to be able to repeat textures across multiple objects 
without breaking the texture and is something most 3D editors can’t do.

The building level showing the doors and windows that were auto created.
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Tutorial: Creating Morphs (Poser / Pro)
Creating morphed figures in ToolBox is very easy. The process consists of making a copy  of the object 
you want to morph, altering it and then adding it as a morph to your original object. Or you can turn a 
morph into a seperate object to alter and then put back as a new morph.

Step by Step

You start with a base object that you want to morph. You can use any mesh object, regardless of source. 
It doesn’t matter whether it already has morphs or not.

You then make a copy to alter. Select the base object with the mouse or in Object Info, so the objects 
bounding box is highlighted. The you can use either the Duplicate or Copy menu command to make a 
copy of the object to alter. Do not alter the original to make a morph! Alter the copy.

Make whatever alterations that you wish to the mesh and rename it to whatever name you want the 
morph to have.

Here, I’ve made a cylinder as a base model, used point edit to select two rows of points and then used 
Move along Normal to move them out evenly in all directions. Next I run the Mesh to Morph command 
under Create and select the original object and hit add as morph. The morph is made. The Mesh to 
Morph command will show any objects in the scene that match the point count of the selected object.
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Now we can look at the morph we just made.

Open the Morph Mixer window. It will list on the left each object in the scene that has morphs. As you 
can see, I didn’t rename my column copy. Each morph will appear with it’s own slider in the scrolling 
list on the right (see Morph Mixer for more details).

Notice that the slider is set on 2. The slider moves form -1 to 2, but you can type any value you wish in 
the text box. With the slider set to two, the effect of the morph is doubled. Design your morph object 
to be your best expectation of where the morph needs to move to, you can always adjust it more or less 
(or negative!) in use.

Making morphs is simple, the work is in crafting each morph mesh. 

After creating the morph, you can throw away (Cut) the dupe mesh you made. Morphs take up very little 
space compared to objects. We use a very compressed morph style unlike many other programs to allow 
us to handle figures like the DAZ Vic 3 which has over 3,000 morph components in the figure file.

Note - After I created the copy of the cylinder, I moved it over away from the original to edit. The object 
transform (move, Rotate, Scale) is not used to create a morph, only displacing the points from their 
original position. Simple transforms will not make a morph. So you can move it anywhere to edit it.
To edit an existing morph, just select the object with the morph, run the Morph to Mesh Command and 
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pick the morph you want. It will create a full object that is the base object plus that one morph applied 
at its 1.0 setting. Texture copying is optional. The copy will become the current selection and will be 
at 0,0,0. I have moved it over to the side so I can edit it. This is a 27K poly mesh object.

There is no real limit to the number of morphs an object may have, We have run models with over 
3,000. Most morph systems choke with over 100.

Note - The number of morphs has no impact on the screen speed in our syetem. They are not extra 
geometry just hidden from the user, but compact data used internally by each object.
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Tutorial: Creating a Skeleton (Poser / Pro)
This example is how to make an animated single mesh model from scratch. Since I am primarily 
interested in the skeleton and how to connect it, the model will be very simple - the beginning stages 
of Sammy the Slug.

You can look at the tutorial on building from scratch, which shows how you can start by placing points, 
making faces and working on up, but since we want to show skeletal animation we will start with a 
generated cylinder.

The first thing I did was the start shrinking the tail, by using edge select and then scale, repeatedly 
down the tail (selecting to the end of the tail each time). And then moving those sections down with 
the Move Panel so I could move small amounts at a time.

Next I created a dome using the Create/Sphere and checking the dome box. I used 20 divisions horizontal, 
since I had used 20 sides for the cylinder.
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I then rotated the dome and moved it up to align with the end of the cylinder. Next I selected the cylinder, 
and ran Modufy/Merge Mesh, selecting the dome to add. now they are a single object. I then selected 
each pair of points at the seam and welded them together.

the antenna are a small cylinder bent by moving some sections over and a small sphere. In this picture 
the sphere has been added to the cylinder and this object put into place.

By having the complete antenna as an object at this point, I can just make the other one with the mirror 
command, reflecting on the Z axis. To complete the mesh, I select the body and use Merge Mesh to add 
the two antenna objects. They simply pass through the outside of the cylinder, they are not attached to 
the mesh.

Now I start adding the bones. When I create the first bone, it will benamed Root Bone and it will point 
up from the origin. So the first thing I have to do is position it where I want it. I rotated it to be along 
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the X axis and about the middle of the model. this is the root bone, move this and the whole model 
moves. I aligned it pointing down the tail, so I select it (so I don’t get another root) and hit New Bone. 
The new bone will point the same way as the selected bone (and be the same size). I make it a little 
longer by adjusting the end point location in the panel and rename it Tail1. Keep unique Bone names! 
Game systems require it and when I recover a skeleton from a file, I have to use the names to know who 
each bones parent is. I then add the next bone and rotate it to point downwards like the tail is sloping. 
I add two more to complete the tail. As each bone is in place, hit Zero Bone to make the position you 
moved it to the resting position of the bone.

Now I have to select the root bone again, hit new bone and then move this bone to be to the right of the 
root bone and rotate it 180 degrees so it points to the head. It doesn’t matter if the bones touch. they 
will when new bone creates one for you, but you can move it anywhere.

I then added 4 more bones Body1-4 and then one for the Head and a small one called Face that I will use 
later. Now I need the bones for the antenna. Head should be the parent of the antenna, so that moving 
the face doesn’t move the antenna, but moving the head moves all three.

Select Head and then hit new bone. Rotate and move it so that the start point is inside the antenna and 
just inside the cylinder. Then rotate the bone so it lies mostly inside the antenna (not really necessary, 
only the start point is critical).

With all the bones created we need to now attach the mesh to the bones. Any point on the mesh can 
attach to any bone and any number of bones. On a complex model, this is an art. Experiment with 
weights to see what the results are.Weights don’t have to add to one, like some systems as ToolBox will 
auto-normalize to an extent. If a point has any weight, it will be counted as on, so you don;t have the 
stray points problem, unless the point is attached to no bones at all. If the weights are more than one, 
the weight of bones after the 1.0 is reached is ignored. So if you set the weight to 1.0 for two bones, 
the first bone in your bone list will control it. This makes the weighting a little easier, it doesn’t have 
to be exact to work.

I started by selecting the Root Bone and then with Point edit, selected all the points of the cylinder 
near the root bones, three rows. I then hit the Add Selection button on the Bone Info panel, leaving the 
weight set to 1.0. Now check the Weight Display Mode and hit Apply. The points you just added will 
be bright red indicating weight 1.0. This mode shows the points that are attached to the selected bone. 
The red gets paler as the weight goes down and turns blue if it is negative.
On the second bone, Tail1, I skipped a row and selected the next three rows and added them to Tail1. 
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Then I selected the row I skipped and set the weight to .5 before adding them to Tail1. Leaving the 
points selected, I switched to the root bone, set the weight to .5 and added them to the Root Bone as 
well. This ring is now evenly controlled by both bones. Also try .75/.25, .5/.5, .25/.75 on some joints 
and you will see the difference this makes. Play with it a little and you’ll see how they work and can 
then adjust the points that are giving you trouble.

After all the tail and body bones, up throug the face, were connected this way, I had to connect the 
antenna. With only one bone, they will be able to move, but not bend. To make them bend I would just 
need to shorten the bone I have their now and add some more bones along the length of the antenna.
I selected all the points except the base, added them and then added the bottom row that was hard to 
select with the others.
The skeleton is now rigged and ready to test. Save it!
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To test it we have to activate it. Up until this point, all the moving and rotating that you ahve done has 
been to set the bones base position. This has worked because Active is off. Active is only important to 
the Root Bone, if it is active so are all of the children. It doesn;t matter whether any of the other bones 
are active. So we select the Root Bone (name not important, it is the first bone in your bone list) check 
Active and hit Apply. If you  hadn’t zeroed all you bones (setting their rest positions), you will see 
them jump at this point.

I turned on Smooth display in the Object Panel and then selected Tail1 and added a small Z rotation. With 
active on, the rotation is passed to the mesh and all the child bones of Tail1 and the mesh bends. 
Note - You can’t Move a bone that is active, only rotate and scale. By the way, what does scale do to 
an active bone? It scales only that bone and the points tied to it, so you can use it to adjust parts of the 
model. The scale is not passed down to the bone’s children. If you make a bone longer, the childern 
will move out, but not become any longer themselves.

Two joints between bones - The one on the right is just each adjacent row attached to one of the bones, 
the one on the left has a center row that is 50/50 between the two bones. Notice that center row is no 
longer in line with either bone, but at an angle in between.

As I started bending the model into a slug pose, I saw a point that was not moving.
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This is easy to fix. By looking closely, I could see that it was a point from the right antenna. I simply 
selected it with the point tool, selected the right antenna bone and added it 1.0. It then snapped into 
place. 

Sammy the slug with a pose.

I continue with Sammy in the UV tutorial on how to create and edit the uvs for a new model so you 
can apply textures to it instead of just solid colors.
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Tutorial: Creating a Spiral Stairway (Game / Pro)
One of the very first requests that I received for a special tool for ToolBox was one to automatically 
make stairs. Lots of small parts that need to be carefully aligned - a pain to do by hand, but a good 
situation for being computer generated. 

Stair Creator
Under the Create Menu, the Step Duplicator can create different types of stairs. It is labeled as a 
duplicator, rather than a generator, since it takes a base object that you have created (which means it 
can be as elaborate as you wish, unlike a true generator).We are going to make some straight and spiral 
stairs, including showing you how the auto calculate functions work.

Make a Single Step
The first step is to make a single stair step. I’m going to use a very simple one, but remember this can 
be any object that you have created.

Under Create, select cube and you will see a cube surrounding the origin. My first step is just to scale 
this to a shape I want to use for my stairs. This is done in the Object Info window (open it or just double 
click the cube).

Next I want to move the pivot point (only because I will be making a spiral stairway and need the block 
to rotate at the correct point) to a corner by translating the block.

Then I Zero Object the block - Very Important! This applies the changes I just made to each point of 
the object and sets the transform back to zero. For any object where position and rotation are all zero 
and scale is all 1, the origin is that objects pivot point, the point around which it will rotate. The original 
cube would rotate around the inside center of the cube, this block will now rotate around the corner.
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Now that we have a step, let’s make the simplest type of stair set. Open the Step Duplicator and enter 
Position X =8 and Y= 4, Steps =3 and hit Show. Show allows you to change values and keep hitting 
Show without having to go delete the objects you just created. Once you see what you want, hit Apply 
to keep them, or Cancel to throw them away. This created 3 new steps, each one 8 units further over 
and 4 units further up. This manual method lets you put them exactly where you want them, including 
leaving gaps between the steps. (I changed Display to Flat before hitting Show.)
But what if what you really need is a set of stairs that goes up a certain distance and over a certain 
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distance (like to the next level of a building)? Figuring it out could take a lot of trial and eror. 

So there is another method. Check the auto calculate box and then give the TOTAL distance you want to 
go and the program will figure out how much to move for each step. And if you set the number of steps 
to zero with Auto Calculate on, it will even calculate the minimum number of steps required. These steps 
will always touch or intersect, steps that don’t touch you have to create without Auto Calculate. The 
next picture shows where I set the distance to travel and let the program determine how many steps.

Now on to the spiral stairs, a pain to do by hand!

Spiral Stairs
The basis of creating a spiral stairway is using the rotation section. Normally a stair is rotated around Y. 
I’m going to set the Y move to be 4, no horizontal move (X or Z) and a rotation of 25 degress aroung 
Y and request 10 steps. Here is where the pivot point we set up earlier comes in. It rotates around the 
corner, not the center and creates a stairway.

The picture on the next page shows the result. But notice that the top step is at an odd angle. 
If I want it to make a particular degree of turn, there is an easier way.
Again, I can use Auto Calculate. The picture below shows I set the total Y to 40 and the total rotation 
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to 180 and steps to zero. It determined I needed 9 extra stairs to make that distance.

NOTE - The number of stairs depends on the distance (height in this example) that the stair has to 
cover, not the rotation, then the rotation is spread over them. If you give a large distance and a short 
rotation you will have many steps that barely move one to the other. 
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But maybe what I want is a set of stairs that spirals around a central column. You can either create a 
keyhole shaped piece like the old stone staircases used, or we can move our step out a little.

If we go back to the Object info window, we can move our block over a little (X = 2, Z = 2) and then 
zero it agaion, so the pivot point is a little away from the corner of the block.

Then if we apply the stair duplicator, there is a space left in the center of the stair. (Getting the idea 
of how you make a entryway double stair that curves down on both sides? The rotation center is well 
away from the block.)

The picture on the right is just to show you don’t have to create these at the origin. Once the block is 
zeroed (to get rid of scaling), you can  move the block anywhere to start the stairway.

That last switch - Auto Parent. If checked it just goes ahead and makes all steps the children of the 
your original block, so moving it moves them all if you need to position the entire stairway.
Stair Tip - Do all the texturing, etc of the base block before you start, as it wil be copied to each new 
step. Otherwise you will have to do them one by one afterwards.



146

Greenbriar Studio ToolBox

To complete this stairway, I opened the Column builder and created a 16 face column to fit the 40 
high stairway. This makes sure my central column is smooth, instead of making it from the step sec-
tions.

Stairs can move, rotate and even scale as they go and you can experiment all you like with the Show 
function until you have what you like, so play away!
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Tutorial: Creating an Object from Scratch
You can create Mesh objects starting from an empty mesh object.

To start, select Create / Empty Mesh. Open Windows / Object Info and you’ll see the new object selected. 
Nothing will be visible in the display.

This tutorial does not try to make a particular object, it just shows some of the tools available to construct 
mesh objects.

You can begin the model by just adding points, or by building faces from the points as you add them. 
Select Point Edit mode, open any of the six orthographic windows and then click on the Add Points 
tool (Green plus and yellow highlighted point). Each click in the window will create a new point. Each 
orthographic window allows you to work in two dimensions. Creating points can only be done in the 
orthographic windows, but selection and editing can be done in any window.

Points stay selected as you create them, so it is easy to make faces as you go. Create the points in a 
clockwise order (three or four) and then select Modify / Add Face and the face will appear. It is important 
that points be selected in a clockwise order to create a face as it determines the direction it faces. If it 
comes up backwards, you can select it with the Face Edit tool and use Modify / Flip Face to change 
the direction. 
NOTE - A face that is facing away from you is invisible unless you have Double Sided Display turned 
on in Windows / Scene Settings.
Display Note - Unselected points that are not connected to faces can only be seen in wireframe display 
mode.

Eight points created (in Front View, shown here in PerspectiveView), the second set of four made into 
a face with Modify / Add Face. Note that the points on the left are not visible in Smooth mode, only 
in WireFrame.
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I reselected the first fout points (by clicking on Point Select and then dragging with the mouse) and 
made them a face.

Then I selected each face (with the Point, edge or face tool) and rotated each one, using Selection 
Rotate, so they faced away from each other.

Next, I used the edge select tool I selected the two top edges (Use Shift edge tool to add another item 
to the selection).
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Then I used the Modify / Skin command to add a face between the edges.

Note that the back face does not appear, since I am not in Double Sided Display mode. I can only see 
a face from the front.

I next used the Extrude tool after selecting the near face with the face select tool. I beveled the new 
face in as it was extruded. Values for extude are world distances, the base grid is ten.
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Back in the Front View, I added four more points and then made these into a face.

And then used the Selection Move tool to move it back away from the center of my object.

Switching to wireframe, I used the edge tool to select a pair of edges and used Modify / Skin to connect 
them with a face.
I repeated this for the top and front edges, to make a hollow box.
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Selecting the bottom two points of the outer face with the point tool, I used the move tool to raise them 
to bevel this section.

Next I moved my object away from the origin, zeroed it (in the Object Info panel) so there was no 
transform, and then used mirror to create a copy (within the same mesh) flipped along the Z axis.
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I again selected two edges and used Skin to link the two parts.

I created a new object, a dome, then moved it up onto the bridge between the two sections.

Then I merged the two meshes by adding the dome to my original mesh, using Modify / Merge 
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Mesh.
The resulting single mesh.

I ran two Commands, Modify / Reset Normals and Modify / Create Game UVs and then created a 
material using a checker board image and applied it to the default single surface. I also used Modify / Face 
Texture Options to increase the repeat rate of the texture for my small model. I used the checkerboard 
texture to make sure everything was being textured correctly.

I then changed the Material texture map to a Giger map for the model and reset the texture scale.

At this point, in addition to more model creation, I could select sets of faces and create new named 
surfaces for texturing with Modify / Create New Surface.
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Tutorial: UV Mapping Complex Objects

UV mapping a sphere or a cylinder is easy. You select the object run Create UVs and select the 
appropriate method and there is your uv set in the uv editor. But what if it is an odd shape? With lots 
of parts pointing different directions? How do you deal with that? And what if I want higher resolution 
in some areas than others?

The basic answer is that you do it one section at a time, using which ever basic method works best for 
that part. You start with whatever is the best overall fit (gets the modt of the model done) and then you 
redo the parts that are not a good result. ToolBox lets yo build uv sets this way, plus you can hand edit 
them after they are generated. 

As an example, we are going to uv map Sammy the Slug, which was created in the Buiild a Skeleton 
tutorial. It is not very complicated, but it can’t be uv mapped with a simple method.

The first setp I did was to apply a cylindrical, with end caps uv method to Sammy, since he is mostly 
a cylinder.
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The body I can live with and the face is straight on, but the antenna are all over the place, psrt of them 
over the body. So I’m going to re-do the antenna.I do this by using the Face tool (remember uvs are 
related to faces, not points) selecting just one antenna. I then open the Create UVs panel. You will see 
the Selection only is checked since I have part of the model selected. I decided to just use front and 
back in the X axis and hit apply.

I now have a clean layout for one antenna. Notice the old placement of it is gone. Each generation of 
UVs will fill the uv space, so this time it is larger. What I need to do is select the pieces, one at a time 
and then shrink them and then move them to some of the blank space at the top. But how do I select 
them when they are on top of the other parts? By moving them OFF of the uv area. I can use the space 
outside of the 0 to 1.0 red box as working space, a clipboard. So I zzom out and move them over to the 
side, where I can easily select one set at a time.

Once selected I can scale and move each section to where I want them on my uv map. I can also select 
the face and make it larger on the map, if I wish.
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The adjusted uv map.

At this point it needs some manual cleanup to be finished, but as you can see on the next page, I have 
a working uv set that I can use to map a texture with. 

Under Modify, the Create UV Guide. will make a black and white output file of my uv map that I can 
use in a paint program to create my textures.

Getting More Complicated
The uv editor also supports multiple sets of uvs on a model. To work with these, you need to go ahead 
and define your surfaces on the model, link them to their appropriate materials and link the materials 
to the images you will be using to texture. Each image can use a different set of uvs. In the Image Info 
panel, you can select an image to use as the UV Editor background and turn on only display surfaces 
that map to this image. This way you can work on one uv set at a time. Thi sis one of the uses of the 
Select Faces by surface tool. You can select a single surface, do a uv projection of it and then move it 
to where you want on the uv map. You can have as many uv sets as you wish for a model.
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See the UV Editor section for more imformation about moving and scaling sections of the uvs. Plus 
moving apart overlapping uvs along seams so you can separate parts. 

Poser Model: Piper by Thorne and Sarsa
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GRRen  - Greenbriar Poly Renderer - PC, Mac and Linux

GRRen is a new product from Greenbriar Studio. It is a Renderman style renderer that is optimized for 
polygon models instead of nurb based models. It includes all of the Renderman features that Toolbox uses 
in other renderers including ray traced shadows (with version 1.1). It also has some specific additions 
that we wanted, things that are difficult, or very time consuming, to do in other renderers. It has a built 
in single pass cartoon cell shading system. It also has built in automatic transparent shadow maps. We 
have also created it so that not only can it run as a command line app directly from ToolBox, but it also 
has a GUI so a user can use it to run single items, change settings and kick off batch jobs. This allows 
for easy use as a mini render farm. It also supports a special particle system that allows texture, trans 
and bump mapping of particles, plus spherical shading of particles, which can be of any size.

GRRen supports any size of output render. It is not limited to broadcast or DV. We test at 4000x4000 
pixels at 4x4 anti aliasing (256,000,000 pixels per frame) to check for size and memory issues, but there 
is no actual limit, just memory and disk space! It is a film quality renderer. The first release supports 
the Renderman RIB file format, but has a hard coded shader that just supports the shading functions 
that Toolbox uses (you have to start somewhere!).  A renderer is a very large project, the goal for the 
first version was to be able to support everything that ToolBox uses except ray tracing (which we have 
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now added, see next section), plus some things we wanted but couldn't get anywhere else.

The need for a personal render farm for animation, and a renderer more polygon oriented, were the 
main reasons behind creating this new product. An affordable render farm was an important goal. Since 
speed is a major issue for animation vs still images, ray tracing was not in the first release, but is now 
in our 1.1 release. Since Renderman had the original goal of 3 minutes or less per frame, ray tracing 
is not really useable for film work, except in very small amounts. So we have added ray tracing as an 
integral part of GRRen that can be used on a surface by surface basis so that it is only used where you 
really need it.

Ray Tracing in GRRen - There are some things that you can only do with ray tracing - true reflection 
and refraction. And ray tracing can give you incredibly detailed and sharp shadows. We have added 
ray tracing to GRRen so that it will have the least speed impact possible, as we are aimed at animators. 
Ray Tracing is used as an addition, not a replacement, for the basic Reyes scanline renderer. Ray 
tracing can be used to calculate reflections and refraction through transparent objects which can then 
be blended with (or replace) the normally calculated surface. It is only activated for the surface area 
showing in the frame that uses reflection or refraction. It does not impact the speed of the rest of the 
frame. However, it does do a correct job of providing a view that is not the view from the camera. 
A reflected or refracted surface is viewing the scene in a new direction, looking through transparent 
surfaces in a new direction, possible seeing surfaces and even objects not seen directly by the camera. 
To the limit that you set in the ray trace recursion limit, this view will continue through these objects 
in the reflected or refracted direction to give you the correct view of the scene from the new viewpoint, 
including multiple reflections and refractions.

The impact to memory to use ray tracing is minor. Our ray trace system uses the same geometry structure 
that the main system uses, there is no duplication. The only extra memory used is for the construction 
of the octree space dividing system used to accelerate the ray tracing operation. This is automatically 
created the first time a trace call is made. It is only created once and can be created at any point in the 
scene rendering process. If there is no ray trace using surface in a particular frame, it is not created and 
no ray trace functions are utilized. The only impact of using ray tracing is the additional run time. And 
for reflecting or refracting surfaces that are not a large part of the frame, it is a rather small addition.

Ray traced shadows, however, are another situation, time wise. When you use raytraced shadows, 
every point is traced to each light to determine visibility. This means that ray tracing is used for every 
pixel in the frame. So it adds a significant amount of run time. It is not very practicle for animations. 
We added it mainly since it was fairly easy to add once the ray trace system was in place and mainly 
just for those times you really, really need some very detailed shadows, or shadows on a long raking 
surface that has bad self shadowing problems with shadow maps.

GRRen also now provides true Displacement Mapping. We can use either black and white or full 
color maps. But due to our using common geometry for both rendering systems, displacement can 
not be seen with the current version of the ray tracer. The bump mapping effect can be, but not the 
actual displacement. Not providing this at this time was a decision made to keep the ray trace impact 
to memory and runtime to a minimum. It is a very expensive feature to add in the ray trace function. 
It may be addressed again in the future.

Also the special, non full geometry types, hair and particles, are not yet in the ray tracing system. 
Adding them is under way.
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So now with Toolbox, you can do everything from creating the first point and face of a model, through 
rendering large scale movie quality output frames with sound!

Features:

GUI User Interface
As you can see on the preceding page, unlike most renderers, GRRen has an optional GUI interface 
that can be run directly by the user.

Input File
For selecting a single rib file at a time, Browse lets you locate a single file, Load transfers it to the Files 
to Render List.

Input Folder
For selecting a folder full of rib files, Browse lets you locate a folder, Load transfers all rib files in the 
folder to the Files to Render List.

Texture Folder
An optional location for texture files. This is here to make it easier to run batches on secondary machines. 
The only outside files needed with a rib file are the texture files. Rather than having to recreate the same 
folder structure on each machine, you can put all of the needed textures in one place and point this to 
it. If GRRen can not find a texture from the path in the rib file, it will look for it in this folder before 
giving you an error. This also gets around Windows vs Mac path names in rib files.

Output Folder
An optional location for the output files. This OVERRIDES (unike Texture Folder which is a secondary 
look up) the output path given in the rib file. Again, so on secondary boxes you can easily direct the 
output to any folder you wish and not have Windows vs Mac file issues.

Delete
Deletes selected text from the Files To Render window.

Clear
Removes all files from the File To Render window.

Render
Renders  all files listed in the File To Render window.

Save Settings
Saves the Input, Texture and Output folders to a settings file.

Command Line
The command line calling options are very simple.

/h - Help
Show GRRen parameters
/c - Command Line mode
Quiet Mode - no GUI, used to auto run from ToolBox and soon from the network renderer.
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Filenames 
A list of space separated files to render

Ex-  GRRen /h
 GRRen /c myrib.rib

Errors - errors will appear in dialog boxes if in GUI mode, if in quiet mode, they are written to 
GRRen_log.txt.

Cartoon rendering
GRRen has a single pass, built in cartoon cell shade renderer. This is one of the things that is difficult to 
do in most renderers, requires multiple passes and still does not have some features we needed, such as 
the ability to outline different material areas on the same mesh, even when they are flat to each other.

In addition to all the realistic ways you can shade an object, GRRen also supports single color cell 
shading and dual color cell shading, with user specified or auto generated shadow colors, outside of 
object outlines and material area outlines. We even have a special Mixed render mode, so some objects 
can be realistic and some cartoon. We support transparency and cartoon shadows (where shadowed 
areas are the specified shadow color, not black).

You can even optionally use texture and trans mapping on cartoon figures. (Bump mapping is not 
supported as that relies on realistic shading with normals. In cartoon mode it simply has no effect.)

Our ray tracing additions even support cartoon mode! The toon renderer can even draw material lines 
on the reflected and refracted images!

There are a lot of settings in ToolBox that affect cartoon rendering.
On the render options panel, that main one is the Render Mode - Cartoon and Toon/Real.

On the Scene Settings panel there is a Toon section for settings that affect the entire scene. These are the 
Outside Line thickness, in pixels before anti-aliasing, the Material Line thickness and the Min Depth. 
Min Depth sets how much depth difference is required to see a boundary as an edge, as in ear in front 
of the head, arm in front of the body. Too high and you will not see the lines internal to the object, too 
low and slanted parts of the model will turn black. Setting varies with the scale of the model. Try 20 
to 90 to start.

On Material panel  you will see Diffuse Color now also marked (Toon Main). This is the base cell shade 
color. On Specular Color you will see (Toon Shadow). This will be the shadow color for this material. 
Set it equal to Diffuse Color for single color, no shadow mode. Set it to 0,0,0 and GRRen will calculate 
the shadow color for you (50% intensity of the Diffuse Color).

There is also a new switch near the bottom marked - Toon - No Mat Line, this sets this material to not 
get a line around it. Want just a solid color with no line around it for the eyebrows? Turn the line off 
here.
Lastly, on Object Info, there is a switch just marked Toon. This only has an effect if you select Render 
mode Toon/Real. This indicates which objects are to be rendered in Toon mode. In Render mode Cartoon, 
all objects are rendered in Toon Mode. Toon/Real mode was a very early request from our testers.
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Realistic render of Poser Street Scene

Auto Shadow maps

GRRen has built in regular and transparent (Deep) shadow maps. Since time required is the same, 
ToolBox only uses the Transparent shadows. What are transparent shadows? These are shadows that 
track the light and its color that passes through semi transparent objects. So instead of a black shadow 
from a transparent object, you get a shadow the color of the object, the darkness of which is set by how 
opaque the object is. The shadow tracks through any number of transparent objects.

These are enabled by turning on Shadows on each light you want to have shadows and setting 
Shadow Map Shadows on in the Render Options panel.
There are three other shadow related switches here also.

Soften shadows - blurs shadows to make them more realistic - takes almost no time.

Shade Shadows - By default, shadows only look at the diffuse color and transparency settings of an 
object when shadow maps are generated for speed. Checking this option forces full shading of objects 
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during shadow generation. Why do this? So shadows will see shapes created by trans maps and colors 
from texture maps (like a stained glass window). Slower option (but MUCH faster than ray tracing!).

Maps only - this is a GRRen only option that does a partial shade using only the texture and trans map. 
What's the difference? By not calculating all the lights effects, you get the pure base color undimmed 
by lighting calculations. This makes for stronger colored shadows than with shaded. See examples at 
the end of this section.

On the Scene Settings panel, there are two controls for overall rendered shadows. The first is shadow 
map size, the size in pixels of the generated maps. And the shadow bias (default .6) to prevent self 
shadowing. This problem occurs especially with objects at a sharp angle to the light and is a result of 
the resolution of the shadow map. If the map resolution is low and the light is raking over an object, a 
large area can be covered by a single pixel in the shadow map. This pixel has only one depth value so it 
will think part of this area is in shadow and part not. So you will see repeating squares or triangles of lit 
and shadowed. Make this large enough to stop it. Increasing the shadow map size will also reduce it.

NOTE - All point lights, which cast shadows in all directions, require 6 shadows maps to be able to do 
this, unlike directional and spot lights which only require 1 each. So they take longer to run.

To make the sharpest shadows with maps, use spotlights. The shadow map covers only the area of the 
spotlight cone so you get the highest resolution shadow map with spotlights. So you can use a spotlight 
and a high res shadow map for close up shots to get very fast shadows instead of having to use ray 
tracing.

See the Particle system for a description of the special spherical and texture, trans and bump mapped 
particles that only GRRen supports.

Displacement Mapping - True displacement mapping is enabled by Checking Displace by the Bump 
Map section of Material Info. Then the map is used for both normal displacement and true geometry 
displacement. 

Ray Tracing Controls

Ray traced shadows are enabled for GRRen just as they are for other renderers, with the Ray Object 
and Ray Shaded shadow switches.

Reflection is set on the Material Info panel by checking Ray Reflect. Reflection strength then sets how 
much of the base surface color is replaced by relection. A setting of 1 is a full mirror.Refractions is 
enabled by checking Ray Refract and setting the surface's refraction index. 1 is air (no refraction). It 
uses real world refraction indexes, like 1.3 is water.

PC, Mac and Linux

While ToolBox is my only Windows only app (due to porting it being such a gigantic task), GRRen was 
written to be multi platform. You should be able to use any type PC in your render farm. It is currently 
available on Windows XP, Mac OSX Universal and Linux. The Linux version requires the Gnome 
Desktop. It is built and tested on Ubuntu.
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GRRen Mac Universal on Mac Intel

GRRen Output Samples

Poser Model with Texture and Trans mapping
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Shadow options with GRRen and ToolBox

Poser Fairy with ToolBox SkyBox in background

Single Point light casting shadows in all directions - Remember - takes 6 shadow maps! (slower)
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Plain Shadows - Sharp shadows, clear tranparent colors (Only Shadow Map Shadows Checked)

Smoothed Shadows - more realistic
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Shaded Soft Shadows - Note wings and dress now cast darker shadows where they are not as lit - 
more realistic, but much slower - darker transparent shadows - note transparent hair shadow

Shaded Map Only Shadows - picks up Texture and Trans map but NOT amount of light on surface 
- brighter clearer shadows, but still get trans map effects
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Ray Traced Shadows - Slower, but very sharp. No self shadowing issues.

Displacement Mapping - Text actually extrudes from the coarse sphere and is visible at the object 
edges, unlike bump mapping
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Cartoon Render Options - only available using the GRRen renderer

Basic Toon mode - 2 flat color cell shaded, materials outlined where chosen 
(no iris and eyebrow outline here), Object level Transparency.
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Toon type 3D model rendered with realistic lighting

Rendered with basic two tone Cartoon rendering - auto generation of 2nd color for shadows
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Single Tone Cartoon Render on figure, no Shadow colors

Mixed mode - Toon mode on figure and clothes, Realistic hair and background
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Ray Traced Reflections - A single polygon with Reflection set to 1 to be a perfect mirror

Ray Traced Reflection and Refraction. Mirror is showing part of the image on the back of the cube 
with an arm raised. Mirror is also vidsible at the very right of the refracting (2.4 - diamond) sphere.
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Particle Options with GRRen

Transparent particles in the normal flat mode

Particles with round shading
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Large Particles with shaded transparent shodows

Stream of small color changing particles
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Transparent Round Particles as bubbles

Large shaded snowflakes with shadows
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Small Trans mapped snowflake particles with shadows
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GRRen  - Render Farm System
To make the best use of our multi-platform renderer, we have a network based render farm system. This 
software comes with GRRen. It includes a render Client for each platform, Windows, Mac Universal 
and Linux, and the Server for Windows. (Due to a current software issue, the Server is not yet available 
on Mac or Linux. Hopefully it will be available on these platforms soon.)

The purpose of the render farm software is to take a batch of RIB files from ToolBox and then render 
them by passing them to each machine in the render farm. And as each machine finishes, pass it another. 
To keep all rendering machines busy until the entire batch is complete.

Before you can render a batch of frames, you need to make the textures available to all of the render-
ing machines. This can be done by using a network folder that all machines can see, or the server can 
move texture files out to a single, or the entire list, of rendering client machines.

The main setup decision is whether you want to use shared network folders or have all files copied for 
you to the client machines. The server can copy all the textures to each machine, then as it runs, it will 
copy the RIB file to the machine that will run it, and then copy the resulting image file back.

This file moving is optional. You can also use network folders for the textures, rib files and image output 
files. In this case the Server moves no files, but instead tells each client which RIB file to render until 
they are all done.

There is no limit to the number of client machines. The minimum requirements are enough memory to 
render your frames (allow as least 1G). Disk space can be very small. The texture set and a single RIB 
file is all that has to be on the client. A client switch telles the client to delete the RIB and output file 
after it is copied back so files don’t pile up on the client machines.

There are also utility functions to wipe out the texture, rib and output folders on all clients to clear them 
before starting a new project.
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Render Client

The Render Client defines the local paths on the local machine that will be used by GRRen. When 
GRRen is run from the Client, these paths override the paths in the RIB file or defined in the GRRen 
interface to control where GRRen will look for textures and where it will place the output files. The 
Client must be in the same folder as GRRen.

The folders define the locations for the RIB files, the Texture files and the Output Image files.

Machine Name is the network name of the client machine. This is auto populated for you on Windows. 
It must be manually entered on Mac and Linux machines. This is the name used to set up the client on 
the Server.

Host IP Address is the ip address of the Windows server machine. This must be filled in on Mac and 
Linux clients and left blank on Windows machines. (We are trying to do away with this.)

Copies to Run is how many GRRens can be run on this client at a time. (Not yet implemented.)

Delete Files when Run tells the client to delete the local RIB file after it is rendered and the Image file 
after it is copied back to the server. It will not delete the image if it is not copied off the client.

Ignore Folder Delete Commands tells the client to ignore the clear folder commands from the Server. 
This is for a Client that is also running on the Server machine.

Save Settings saves all these settings.
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Render Server

The Render Server is the control panel that runs the entire process. On the left is the section for run-
ning the RIB files. It is very similar to the render process of GRRen. You can add a single RIB file or 
an entire folder of RIB files to the Files to Render list. As with GRRen you can select part of the list 
and use Delete to remove it, and clear the entire list with Clear.

Copy RIB file out - if checked each RIB file will be copied to the Client machine that will run it prior 
to the client being given the execute command for that file.

Render all Files starts the render run.
 
Abort Run will end the run. No new frames will be passed out, but those in process on the clients will 
continue to completion.

The center section is the Status section. The top shows the current machine list and whether they are 
available to run jobs. Normally the Status will be OK, Offline (can not be reached) or Manual Offline 
(to remind you that it is off because you have turned it off).

To update the machine status list, hit Update and after it finishes (the button comes back up) hit 
Draw. 

Edit Machine brings up the Edit Machines panel described later.

The lower Status display shows each frame as it is passed to a machine for rendering. And it will show 
as each one completes, plus a notice for end of batch or batch aborted. This allows you to track the 
progress of the run.

On the right are three sections. The top is the Texture section. This is a utility to move texture files 
to the client machines for you. You can select a single texture, or a folder of textures. If File is blank, 
folder is used. Only .tif and .jpg files will be moved from the folder.

If a machine is selected and highlighted in the Machine list, you can use Current Machine to move 
the texture(s) to only that machine. All Machines always moves the texture(s) to All available client 
machines. Available machines are those with Status OK. This can take a while!

The next section is the clear client section. Clear Textures will remove all .tif and .jpg from the client 
Texture folders. Clear Run will remove all .rib files from the client RIB folder and .tif, .jpg, and .exr 
files from the client Output folders. If you run a Client on the Server machine, either disable this, or 
use different folders for the Client!

Output Folder is where the Server will put the returning image files.

Copy Output File Back determines whether image files are copied back to the server or left where the 
Client puts them. By default, Copy RIBs Out and Output Back are on.

Save Settings saves all Server and Machine settings.
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Edit Machine Info is used to set up Clients and change their run info.

New creates a New client entry. Rename lets you set the name to the client’s network name.

Status, Processes to Run and Last Error are loaded from the client during Status Update.

Update Status checks to see if the Clients are reachable. After Update Status, select a machine to see 
its status.

Manual Offline lets you mark a machine to not be used without changing the machine’s setup.

When Available - Not yet in use. It will be to allow you to specify the time of day a machine can be 
used for rendering. So you can automatically use some machines at night when they are not being 
used for their normal activities.

Save saves the info for the currently selected machine. Must be saved for each machine and then 
overall settings saved from the main panel.

NOTE - The one assumption of this system is that the output Image file names are related to the RIB 
file names. RIB frame1.rib will create frame1.tif, frame1.jpg or frame1.exr. ToolBox sets them up 
this way, but it is not a requirement of GRRen. If they do not match, the copy back process will not 
work, but everything else will.
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Index

A
Add Child  66
Add Face  113
Add Point  111
Add Prefab Mats  32
Add Selection  62
Ambient Color  49
Ambient Light  19
Angles  67
Animate Bone  61,65
Apply  29
Auto Calculate  96
Auto Parent  96,98

B
Background Color  77
Background Picture  107
BackGround Pictures  117
Back Frame  53
Bevel Corners  102
Bone Select  111
Box  40
BSPLegal  120
Building Levels  94
Bulges  67
Bump Map  33
Bump Strength  33
ByFace  120

C
Clear All Keys  54
Clear Weights  62
Color  24
Color1  92
Color2  92
Column  120
Column Designer  99
Compact Mesh/Plan  114
Cone  29
Conforming  71
Conform To  28
CR2Folder  23
Creases  51
Create All Keys  57
Create a New Morph  58
Create Empty Mesh  113
Create Empty Poser Mesh  113
Create Game UVs  114
Create New Part  114
Create New Surface  114
Create Segment  111
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Create Vertex Animation  69
Create Weights  68
Creating a Particle Emitter  89
Creating Terrain  37
Cube  29
Current Frame  53
Cylindrical  40
Cylindrical Capped  40

D
Delete  34
Delete All Keys  57
Delete Bone  63,66
Delete Current Keys  57
Delete Object  29
Diffuse Color  32
Direction Var  90
Displaying Terrain  38
Display Color  30
Display Control Points  50
Display Params  68
Display Part Colors  26
Display Resolution  34
Divisions  98
Door  105
Double Sided Display  20
Dupes in Dir 1  98
Dupes in Dir 2  98

E
Edge Info  113
Edge Select  111
Editing a Vertex frame  70
Editing Subdivision Surfaces  50
Editing Terrain  37
Edit an Existing Morph  58
Edit Bones  28
Edit Button overview  111
Edit Parts  28
Edit Segments  103
Edit Single Object Display  20
Edit Surfaces  28
Edit Vertex Animation  28,70
Emitters Per Face  90
Empty Mesh  29
Empty Poser Mesh  29
Enable Display  35
Enable Particles  91
Enable Sky Box  49
End  53
End Color  91
End Frame  91
Export  95
Extra Force  91
Extrude  112
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F
Faces  98
Face Info  44
Face Normals  99
Face Select  111
Field of View  75
Filename  77
File / Import  119
File / Open  119
File Output Type  79
File Render Style  79
Flip Face  113
Flip UVs vertical and Horizontal  48
Frames Per Second  53
Freeze Subdivision  51
Front and Back  41
Full Path  34

G
Generating Objects from a Plan  108
Gravity Factor  90
Grid Creator  98

H
Height  98,105

I
Import Skeleton  29
Initial Velocity  90
Intensity  24

J
Joint Orientation  67
Joint Params  67

K
Key Current Selection  53

L
Large Grid  21
Level Files  110
Life and Life Variance  91
Light Emitting  91
Links  61,65
Load  34
Loaded Path  34

M
Mac and Linux  163
Magnet Tool  115
Make a Single Step  141
Make Ceiling  102
Make Floor  102



184

Greenbriar Studio ToolBox
Maps  49
Maps only  163
Material  31
Material Export  120
Matrices  67
Max Particles  90
MDL7 Export Bone  121
MDL7 Export Vertex  121
Merge Mesh  114
Merge Textures  47
Model Files  110
Mouse Camera Controls  111
Mouse Editing of Params  67
Move  111
Move 1  98
Move 2  98
Move Bone  61,65
Move Normal  112
Move on Build  102
Move screen  111
Move Selection  112
Multi Frame Out  77

N
New Bone  66
New Light  25
New Per Frame  90
New Segment  106
New Var  90
Next Frame  53
No End Caps  98
Number of Steps  96

O
Objects  26
Objects as Poser Figure Set  122
Object as Poser Prop  121
Object Export  121
Object From Selection  114
Object Shadows  78
OBJ Folder  23
Ortho Display Style  19
Ouput Size  77
Output Filename  77
Output Path  77

P
Parent  28
Parent To  28
Parts  30
Perspective Move  21
Plan  120
Plane  41
Plan Info  102
Plan Segment Info Panel  104
Point Select  111
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Poser Animated Pose  121
Poser Face  121
Poser Format Export  121
Poser Import Folder  23
Poser Injection Poses  59
Poser Mesh From Weight Mesh  68
Poser Pose  121
Pose export  121
Position  24,61,65,75,105,113
Position, Rotation and Scale  96
Positional  24
PP2 Folder  23
Prefab  120
Preview  95

R
Range  24
Reflection Map  33
Reflection On  27
Reflection Strength  33
Regenerating UVs  46
Remove Child Object  66
Rename  25,30,31,33,63,66,106
Rendering Styles  79
Renumber Vertex Frames  70
Repeating  91
Reset Normals  115,117
Reset Values  57
Rotate  111
Rotate Screen  111
Rotation  75
Rotation Limits  67
Rotation Order  67
Run  53

S
Saving Terrain  39
Scale  101,111
Scale screen  111
Scene  18
Scene Export  72,74,120,123,126
Sections Per  100
Select  33,49
Selected Image UVs Only  36
Selecting UVs  45
Select Material  31
Select Object  111
Set Image  35
Shade Shadows  162
Shininess  32
Show  96
Show Camera View  75
Size  49
Size and Size Variance  90
Skin  114
Skip  120
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Snap To Grid  21
Soften shadows  162
Special Mouse keys  111
Sphere  29
Spherical  41,91
Spiral Stairs  143
Split  116
Spot Angle  24
Spot Direction  24
Spot Light  24
Stair Creator  141
Start  53
Start and End Frame  77,78
Start Color  91
Start Frame  91
Step Duplicator  141
Stretch Selection  112
Subdivide  51,115
Subdivision Active  50
Subdivision and UVs  51
Subdivision Level  50
SubDivision Surfaces  50
Sun Light  19
Sun Position  19
Surfaces  31,99,103
Surfaces and Use all Surfaces  105
Surface Name  99
Switch to White Lines  35

T
Tags  26,30,31,105
Terrain Export  121
Terrain Files  110
Textures Off  20
Texture Folder  160
Texture Map  33
Texturing Terrain  38
Thickness  103,105
ToolBox Demo  17
ToolBox I  16
ToolBox II  16
ToolBox III  17
To First  53
Transparency Map  33
Transparency On  20,21
Trans Strength  33
Triangulate  51,115
Twist  67

U
Undo  118
Use For All Surfaces  103
Use Game Level UVs  27
Use Vert%  99
UV Editor  45
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UV Generator  40
UV Template Generator  44

V
Velocity Damping  90
Velocity Var  90
Vertex Animation  27
Vert %  99

W
WAD2/WAD3 to Textures  119
Wall Height  103
Weights  62
Weight Display Mode  62
Weight Mesh From Poser Mesh  68
Weight Value  62
Weld  114

Width  98
Width %  99
Window  105
Wind Factor  91
Work Directory  23

Z
Zero Bone  63,66
Zero Object  28,141
Zero Pose  63,66
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Poser Model: PeekaBoo Pookling by Thorne and Sarsa, Hair by Kozaburo
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